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User Information 
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diagrams, we reserve the right of this manual contained information change without prior notice. 

Coping or reproducing any part of this manual, without written consent of Delta Electronics Inc. is prohibited. 
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Preface 

Thank you very much for purchasing DELTA’s DOP-A Series and DOP-AE Series Human Machine Interface 

(hereinafter “HMI” ) products.  

This manual will be helpful in the installation, wiring, and operation of Delta HMI product and HMI Screen 

Editor software program (hereinafter “ScrEdit” ). Before using the product, please read this user manual to 

ensure correct use.  

You should thoroughly understand all safety precautions (DANGERS, WARNINGS and STOPS) before 

proceeding with the installation, wiring and operation. If you do not understand please contact your local 

Delta sales representative. Place this user manual in a safe location for future reference. 

 

 Using This Manual 

 Contents of this manual 

 This manual is a user guide that provides the information on how to install and operate 

Delta HMI products and ScrEdit.  

 Who should use this manual 

This user manual is intended for the following users: 

 Those who are responsible for designing. 

 Those who are responsible for installing or wiring. 

 Those who are responsible for operating or programming. 

 Important precautions 

Before using the product, please read this user manual thoroughly to ensure correct use and store 

this manual in a safe and handy place for quick reference whenever necessary. Besides, please 

observe the following precautions:  

 Install the product in a clean and dry location free from corrosive and inflammable gases 

or liquids. 

 Ensure that HMI is correctly connected to a ground. The grounding method must comply 

with the electrical standard of the country. 

 Do not modify or remove wiring when power is applied to HMI. 

 Before starting the operation, make sure the emergency stop equipment can be energized 

and work at any time. 

 Do not touch the power supply during operation. Otherwise, it may cause electric shock. 
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Chapter 1  Introduction 

1.1 DOP-A and DOP-AE Series Human Machine Interface 

DOP-A and DOP-AE series HMI are manufactured by adopting high-speed hardware to provide you a 

powerful and programmable interface. ScrEdit software is a really user-friendly program editor of DOP-A and 

DOP-AE series HMI for Windows. Please refer to the following section for its features and function 

introduction. If there is any suggestion or comments on ScrEdit software, please do not hesitate to contact us. 

We are looking forward to serve your needs and willing to offer our best support and service to you. 

 

1.2 Features 

 PLC serial drives support 

DOP-A series HMIs support more than twenty brands of PLC, including Delta, Omron, Siemens, 

Mitsubishi, etc. All of the newly supported PLCs’ communication protocol could be found on our website 

(http://www.delta.com.tw/industrialautomation/) for upgrade to meet your requirements. (All other 

trademarks in this manual are property of their respective companies.) 

 Windows® Fonts support for ScrEdit software  

Except Simplified Chinese, traditional Chinese and English these three languages, ScrEdit software also 

provides those fonts that Windows® uses. 

 Quick execution and communication macro 

It can handle complicated calculation by executing macro. Users can also write communication protocol 

with communication macro command to connect specific system via COM port. 

 Rapid USB upload/download  

It will shorten upload/download time by using USB Ver1.1. 

 Recipes 

It provides useful recipe editor that is similar to Microsoft excel for user to edit recipe easily and input 

multiple recipes simultaneously (size limit is 64K). When downloading multiple recipes at the same time, 

it can exchange by internal memory of HMI. If data has finished editing when downloading, you can 

download recipe individually. 

 Support multiple PLCs connections 

Connect to multiple controllers in serial through COM2 of RS485 port.  
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NOTE  

1) The controller should provide RS485 interface. 

 On-line Simulation  

HMI on-line simulation feature allows users to develop and debug software on the PC connected to DOP 

series HMI before downloading it to DOP series HMI. 

 Off-line Simulation 

HMI off-line simulation feature allows users to develop and debug software on the PC alone before 

downloading it to DOP series HMI. 

 Using SMC card to backup data 

SMC card can also be used to backup data or transfer data to another HMI. After data transmission, the 

data can be saved into the FLASH memory of HMI. History list and alarm message can be also saved in 

SMC card and users can read these files by card reader for collecting data and printing. 

 Multiple security protection  

It provides passwords to protect designer’s intellectual property rights and also for users to set users 

priority for important component. Only the users, whose priority is higher than the component, can use 

the component. 

 USB host port (USB Host) equipped (DOP-AE series only) 

DOP-AE series HMI have a built-in USB Host interface for the connection to USB disk, card reader and 

printer with USB socket. The users can save data, copy program and print the screen immediately and 

increase the data storage space. 

 Multiple security protection  

It provides passwords to protect designer’s intellectual property rights and also for user to set user 

priority for important component. 

 Multi-language support 

Eight available languages can be selected and used without installing a multilingual operating system. It 

is easy for the users to switch the desired language via HMI or the external controller. Furthermore, 

Unicode editing is supported, and therefore it is convenient for the user to create and edit more quickly. 
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1.3 Model number  

DOP-A Series 

Input Power

DOP A 57 GS T D -          

D: DC
A: AC
Interface Type
T: Touch screen only
K: Touch screen and keypad
Panel Type
GS: STN Gray
CS: STN Color
TC: TFT Color

Panel Size
57: 5.7"
75: 7.5"
10: 10.4"
Series
A: A Series ~ USB, RS-232, RS-485, RS-422
Product Name
Delta Operator Panel  

DOP-AE Series 

Input Power

DOP A E 57 GS T D -            

D: DC
A: AC
Interface Type
T: Touch screen only
K: Touch screen and keypad
Panel Type
GS: STN Gray
CS: STN Color
TC: TFT Color
Panel Size
57: 5.7"
75: 7.5"
10: 10.4"

Series
A: A Series ~ USB, RS-232, RS-485, RS-422

Product Name
Delta Operator Panel

Extension Port
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1.4 Caution  

 Operation Environment (temperature and humidity) 

HMI should be operated in the following environment parameters to adjust screen brightness and 

contrast for getting the best image. If operating out of the range, LCD may be improperly displayed when 

using for long time. 

Ambient Operating Temperature: 0 ºC to 50 ºC (32 ºF to 122 ºF) 

Relative Humidity: 10% ~ 90%, no condensation allowed 

 SMC Card 

SMC card can be used to save and transmit data. Only SMC card that formatted by HMI can be used on 

both HMI and Windows® OS system. (Even it can be read/written in some format, but faults may occur 

due to different format among Win95/98/2000/XP versions) 

 DO NOT plug/unplug the cable from COM port during operation  

Please turn the power off before you plug or unplug the COM ports cable. 

 Recommend System Requirements 

 Pentium III, 500MHz or greater 

 256MB RAM 

 Windows® 2000 & Windows® XP 
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Chapter 2  Creating and Editing Screens 

2.1 ScrEdit (Screen Editor) Setup 

In this chapter, it will introduce general functions of Screen Editor with Windows. User can use it to design 

what he wants. Detail information for each function will be discussed in following chapters. 

 Minimum System Requirement 

What follows is the system requirement to comply with the operation environment of ScrEdit: 

Item System Requirement 

Operation System Windows® 2000 & Windows® XP 

CPU Pentium III, 500MHz or greater is recommended 

Memory 256MB and above is recommended 

Hard Disk Capacity: 100MB and above 

Monitor Resolution: 800×600. It is recommended to set display setting of 
Windows to 256 colors or above. 

Mouse General mouse or the device compatible with Windows 

Printer Printer with Windows driver 

 Software installation 

To start the Delta HMI ScrEdit setup, please refer to the following steps: 

1. Step 1: Please start-up your computer to Win2000/WinXP system. (Fig. 2.1.1) 

 

Fig. 2.1.1 Open Microsoft Windows 
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2. Step 2: Execute setup.exe from Windows taskbar by clicking “Start” > “Run”. (Fig. 2.1.2) 

 

Fig. 2.1.2 Execute setup.exe under Windows system 

3. Step 3: After pressing OK, system will setup automatically and you will get the following dialog box to 

choose destination location.  

 

Fig. 2.1.3 Directory for installing ScrEdit 

To select the default directory C: \Program File\Delta\Screen Editor 1.05.55 (Build 1.061)\, click Next> 

for the next step. Setup will install in the directory indicated in the Destination Directory box at the bottom 

of the dialog box. 

To select a directory other than the default directory, click Browse. A list of available directories appears. 

Highlight the desired directory for the Delta HMI ScrEdit and click OK, then Next> for the next step. 
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If necessary, click < Back button to take you back through Setup dialog boxes one by one. 

4. Step 4: In this dialog box, you can choose setup language: Traditional Chinese, Simplified Chinese or 

English. And then click Next> button to get following program folder selection dialog box. 

 

Fig. 2.1.4 Language installation 

5. Step 5: This dialog box displays the progress of copying files while the Setup program copies all 

necessary files into the designated directory. (Fig. 2.1.5, Fig. 2.1.6) 

 

Fig. 2.1.5 Starting ScrEdit installation 
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6. Step 6: At this time, you have finished setup. Please click Finish to complete setup. (Fig. 2.1.7) 

 

Fig. 2.1.6 Finish installing ScrEdit 

7. Step 7: Click OK to allow Setup to restart your computer and finish setup. Otherwise, choose “No, I will 

restart my computer later.” option and click OK. You will have to restart your computer before you can 

use the Delta HMI ScrEdit. 

 

Fig. 2.1.7 Completing installation 
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2.2 How to Start ScrEdit 

After setup, you can start ScrEdit from Windows taskbar, click Start > Programs > Delta HMI > Screen 

Editor. (Refer to Fig. 2.2.1) 

 

Fig. 2.2.1 

 

Fig. 2.2.2 Start-up display 

When you start ScrEdit at the first time, the ScrEdit will install USB drive program automatically. Therefore, 

the speed will be slower when initial setup. It is normal and please be patient and wait just a moment.  

1. It will open last file automatically if you check “auto open last file automatically” in environment setting. 

2. If you didn’t check “auto open last file automatically” in environment setting or you didn’t save last file, it 

will show basic function as Fig. 2.2.3. 

3. There are only File (F), View(V), Option(O) and Help(H) on the toolbar when executing ScrEdit without 

editing new file. 
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When ScrEdit is activated at the first time, the first window to show up is as follows. 

 

Fig. 2.2.3 Screen without editing file 

After pressing  or click File> New, it can create a new application and you will get a dialog box as shown 

in the following. (Fig. 2.2.4) 

 

Fig. 2.2.4 Creating a New application 

 

Enter the Application Name, Screen Name, Screen ID and select connected HMI, controller or printer. Then, 

click OK, it can create a new application in ScrEdit as shown in the following. (Fig. 2.2.5) 
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Fig. 2.2.5 New application screen of ScrEdit 

 

There are five parts in the following for ScrEdit application window.  

 Menu Bar 

There are nine functions for selection: File, Edit, View, Element, Screen, Tools, Options, Window, and 

Help. 

 

 Toolbar  

Toolbar (Fig. 2.2.6) is like those toolbar in Windows® program. It is easy to use for editing and the users 

can arrange its position freely. For example, the users can move the Toolbar to the left side of the screen. 

Also, the users can arrange the toolbar position by their usage. The followings are the available toolbar 

on ScrEdit. 

1. Standard Toolbar 

 

2. Zoom Toolbar 

 

3. Text Format Toolbar 
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4. Bitmap Toolbar 

 

5. Element Toolbar 

  

6. Build Toolbar 

 

7. Layout Toolbar 

 

 

 

Fig. 2.2.6 ScrEdit Toolbar 
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Fig. 2.2.7 Moves ScrEdit toolbar and property table 

 

 Property Table  

It provides element property settings for each element. Please refer to Chapter 3 for detailed description. 

 
Fig. 2.2.8 Property table  

 

All elements on current 
editing screen 

Element state selection 
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Fig. 2.2.9 Editing screen preview 

 

 Output Window 

All editing actions and output message when compile function is enabled will be shown here. When 

compiling, ScrEdit will detect the error of user program automatically. Once error occurs, the 

correspondent message will display in output window. User clicks error message to get error element 

window. 

 

Fig. 2.2.10 Output window 
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 Work Place 

Getting suitable editing work place by different HMI type of DOP series. Following is an editing example 

display (Fig. 2.2.11). 

 

Fig. 2.2.11 ScrEdit Work Place 
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2.3 Menu Bar and Toolbar (File) 

ScrEdit provides the convenient pull-down Menu and makes it easy for the users to create, edit and manage 

includes elements, pictures, graphs, macro program, recipes and displays in DOP series HMI. The pull-down 

menu options of Menu bar are described as follows: 

 

 File 

The “File” menu performs many common functions.  

1. Provide the users to create new application, open old application, close file, save current file and 

save current file to another file name, etc. options. 

2. Make and Open SMC screen data. 

3. Upload the editing display and data of DOP series HMI to PC and save in hard disk.  

4. Update the firmware of DOP series HMI. 

5. Password protect function. 

6. Screen print, print preview and print setup functions. 

7. By default, ScrEdit presents a list of the four most recent used files on the File menu for quick 

access. Just click the file name to open the file.  

8. Exit command is to close all open editing files and offer to save those which have not been save 

yet and finally exit the ScrEdit. 

 

Fig. 2.3.1 File options 

 

 

 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   2-13 

 Create a New Application 

Creates a new application by choosing File > New (Fig. 

2.3.2) or clicking the New icon  from toolbar (Fig. 2.3.3), 
or using keyboard shortcuts by pressing Ctrl + N.  

 

Fig. 2.3.2 Create new application (Choosing New command from menu bar) 

 

Fig. 2.3.3 Create new application (Choosing New icon from toolbar) 
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1. If this is the first time use and there is no old application, the following dialog box (Fig. 2.3.4) will 

show up for the users to input application name, screen name, screen ID, HMI type and 

connecting base port controller after creating a new application.  

 

Fig. 2.3.4 New application dialog box 

2. If other application files already exist and are open, the users will get the following dialog box to 

remind the users of saving application (Fig. 2.3.5) before creating new application. Press Yes 

button to save the existed file, press No button not to save the file and press Cancel button to 

cancel the save operation. After the users press the Yes or No button, the new application dialog 

box will appear again (Fig. 2.3.4).  

 

Fig. 2.3.5 Saving dialog box 

3. Input application name, screen name, select HMI model and connecting base port controller (Fig. 

2.3.6), and then press OK button.  

 

 

Fig. 2.3.6 HMI model and base port controller options 
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 Open Old Application 

Open current application by choosing File > Open (Fig. 

2.3.7) or clicking the Open icon  from toolbar, or using 
keyboard shortcuts by pressing Ctrl + O. 

 

Fig. 2.3.7 Open old application (Choosing Open command from menu bar) 

 

Fig. 2.3.8 Open old application (Choosing Open icon from toolbar) 
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1. If other application files exist before opening an old application, the users will get the Saving dialog 

box (Fig. 2.3.5) to remind the users of saving file and then get the following dialog box for opening 

existing dop file (Fig. 2.3.9).   

2. If save operation is complete or there is no old application files, the following dialog box for 

opening existing dop file will show up directly.  

 
Fig. 2.3.9 Open an old application in ScrEdit 

 Close File 

Closes application by clicking File > Close (Fig. 2.3.10). 

 

Fig. 2.3.10 Close application (Choosing Close command from menu bar) 
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1. If application didn’t get saved before issuing the command of closing application, the users will get 

saving dialog box (Fig. 2.3.11) to remind the users of saving application. 

  

Fig. 2.3.11 Saving dialog box 

 Save File 

Save current application into hard disk with extension file 
“dop” by choosing File > Save (Fig. 2.3.12) or clicking the 

Save icon  (Fig. 2.3.13), or using keyboard shortcuts by 
pressing Ctrl + S. If the application is a new file, the Save as 
dialog box will show up (Fig. 2.3.15). If the application is an 
old file, the Save function will perform immediately and the 
Save as dialog box will not show up. 

 

Fig. 2.3.12 Save file (Choosing Save command from menu bar) 
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Fig. 2.3.13 Save file (Choosing Save icon from toolbar) 

 Save As 

Save current application to another file name by clicking File 
> Save As (Fig. 2.3.14). The users will get Save as dialog 
box (Fig. 2.3.15) to input application name with extension file 
dop. This dialog also appears automatically when the first 
time any application file is saved no matter whether Save As 
or Save command is used. 

 

Fig. 2.3.14 Choosing Save As command from menu bar 
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Fig. 2.3.15 Save as dialog box (Dialog box that let user input application name to save as.) 

 Make SMC Screen Data 

Before using this command, ensure to compile the editing 
screen data. If not execute the compilation first, the ScrEdit 
cannot make screen data and an error message dialog box 
will show up (Fig. 2.3.16). Please execute the compilation 
first and then clicking File > Make SMC Screen Data to copy 
the compiled HMI program into SMC card (Fig. 2.3.17). If the 
SMC card with compiled HMI program stored inside is 
inserted into HMI, HMI will startup by reading the data of 
SMC card directly.  

 

Fig. 2.3.16 Error message dialog box when 

making SMC screen data 

 

 
Fig. 2.3.17 Make SMC Screen Data Dialog Box 
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 Open SMC Screen Data 

In HMI, the users can move the screen data saved in the 
flash memory into SMC card through folder manager. Then, 
perform Open SMC Screen Data function and the users will 
get the users will get Fig. 2.3.17 dialog box. At this time, the 
users can open the screen data and edit the HMI screen data 
directly. 

 Upload Screen Data and Recipe 

After clicking File > Upload (Fig. 2.3.18), the password 
dialog box will show up first, the users need to input 
password (the password is the highest priority saved in HMI) 
to get save as dialog box (Fig. 2.3.15). After inputting 
application file name, the uploading will start (Fig. 2.3.20). 
The users can get the progress with progress box and stop 
uploading by clicking Stop button. When progress goes to 
100%, it indicates that the uploading is complete. The users 
can press Stop button to exit the dialog box. The file that is 
uploaded from HMI can be restored to original editing file for 
user to edit. This option is to avoid losing the original editing 
file. 

 

Fig. 2.3.18 Choosing Upload command from menu bar 

 

Fig. 2.3.19 Enter password dialog box 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   2-21 

 

Fig. 2.3.20 Uploading screen 

 Upload Recipe 

This function is similar to upload function (Fig. 2.3.20) but it 
can only upload recipe (Fig. 2.3.21). It also needs password 
(the highest priority password saved in HMI) before 
uploading.  

 

Fig. 2.3.21 Choosing Upload Recipe command from menu bar 
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 Update Firmware 

This option is for upgrading HMI firmware or adding function 
for HMI (Fig. 2.3.22). 

 

Fig. 2.3.22 Choosing Update Firmware command from menu bar 

 Password Protect 

The users can enable and disable password protect function 
by clicking File > Password protect (Fig. 2.3.23). Once 
password protect function is enabled, the users will get Fig. 
2.3.24 dialog box and  symbol before “Password Protect” 
command. If the  symbol shows before “Password Protect” 
command from File menu, it indicates that this dop file is 
password protected and the users will need to input password 
before opening dop file. The password is set by clicking 
Option > Workstation Setup (Fig. 2.3.26). If the password 
protect function is disabled, the Fig. 2.3.25 dialog box will 
show up.  
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Fig. 2.3.23 Choosing Password Protect command from menu bar 

  
Fig. 2.3.24 Password protect function is enabled 

 
Fig. 2.3.25 Password protect function is disabled 
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Fig. 2.3.26 Password settings  

 Print 

Print current screen by choosing File > Print (Fig.2.3.27), or 

clicking the Print icon  from toolbar (Fig. 2.3.28), or using 
keyboard shortcuts by pressing Ctrl + P.  

 

Fig. 2.3.27 Choosing Print command from menu bar 
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Fig. 2.3.28 Choosing Print icon from toolbar  

 Print Preview 

Select this function by clicking File > Print Preview (Fig. 
2.3.29). Using this function can preview the full page after 
printing (Fig. 2.3.30).  

 

Fig. 2.3.29 Choosing Print Preview command from menu bar 
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Fig. 2.3.30 Print Preview screen 

 Print Setup 

Printer and paper settings. Select this function by clicking 
File > Print Setup (Fig. 2.3.31). Using this function can set 
the property of printer, print paper and print direction, etc. 
several functions (Fig. 2.3.32).  

 

Fig. 2.3.31 Choosing Print Setup command from menu bar 
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Fig. 2.3.32 Print Setup dialog box 

 File Quick Access 

By default, ScrEdit presents a list of the four most recent used files on the File menu for quick 

access (Fig. 2.3.33). Just click the file name to open the file. This function is similar to the Open 

command and the users can refer to the description of Open command on the page 2-15. If the 

saving path is too long, the too long path will display as “….”. The users still can see the complete 

dop file name. 

 

Fig. 2.3.33 Most recent used files 

 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

2-28   Revision 05/30/2006, EH00 

 Exit 

Exit function is to close all open editing files and offer to save 
those that have not been save yet and finally exit the 
ScrEdit. Select this function by clicking File > Exit (Fig. 
2.3.34). If the file has been changed or not saved yet, the 
saving dialog box (Fig. 2.3.11) will show up to remind the 
users of saving application. If the users press Cancel button 
at this time, the exit command is cancelled. Either pressing 
Yes button to save the file, or pressing No button not to save 
the file can exit the ScrEdit. After the users press the Yes 
button, the Save As dialog box will appear (Fig. 2.3.15) for 
saving the file. 

 

Fig. 2.3.34 Choosing Exit command from menu bar 
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2.4 Menu Bar and Toolbar (Edit) 

 Edit 

Adopt Microsoft Office style pull-down menu and provide user-friendly Edit pull-down menu (Fig. 2.4.1). 

 
Fig. 2.4.1 Edit options 

 Undo 

 Undo the last action. Select this function by choosing Edit > Undo 

(Fig.2.4.2) or clicking the Undo icon  from toolbar (Fig.2.4.3), or use 
keyboard shortcuts by pressing Ctrl + Z. All actions are recorded in 
output window.  

 

Fig. 2.4.2 Choosing Undo command from menu bar 
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Fig. 2.4.3 Choosing Undo icon from toolbar 

 Redo 

 Redo the undo action. Select this function by choosing Edit > Redo 

(Fig.2.4.4 or clicking the Redo icon  from toolbar (Fig.2.4.5), or use 
keyboard shortcuts by pressing Ctrl + Y. All actions are recorded in 
output window.  

 

Fig. 2.4.4 Choosing Redo command from menu bar 
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Fig. 2.4.5 Choosing Redo icon from toolbar 

 Cut 

 Deletes the selected element and save it in clipboard to paste to other 
place. Select this function by choosing Edit > Cut (Fig. 2.4.6) from 

menu bar or clicking the Cut icon  from toolbar (Fig.2.4.7), or use 
keyboard shortcuts by pressing Ctrl + X.  

 

Fig. 2.4.6 Choosing Cut command from menu bar 
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Fig. 2.4.7 Choosing Cut icon from toolbar 

 Copy 

 Copy the selected element to the clipboard. Select this function by 
choosing Edit > Copy (Fig. 2.4.8) from menu bar or clicking the Copy 

icon  from toolbar (Fig.2.4.9), or use keyboard shortcuts by pressing 
Ctrl + C. 

 

Fig. 2.4.8 Choosing Copy command from menu bar 
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Fig. 2.4.9 Choosing Copy icon from toolbar 

 Paste 

 Paste element from clipboard. Select this function by choosing Edit > 

Paste (Fig. 2.4.10) from menu bar or clicking the Paste icon  from 
toolbar (Fig.2.4.11), or use keyboard shortcuts by pressing Ctrl + V.  

 

Fig. 2.4.10 Choosing Paste command from menu bar 
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Fig. 2.4.11 Choosing Paste icon from toolbar 

 Delete 

 Delete selected element. Select this function by choosing Edit > Delete 
(Fig. 2.4.12) from menu bar or use keyboard shortcuts by pressing Del. 

 

Fig. 2.4.12 Choosing Delete command from menu bar 
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 Select All 

 It is used to select all elements. Select this function by choosing Edit > 
Select All (Fig. 2.4.13) from menu bar or use keyboard shortcuts by 
pressing Ctrl + A. When selecting all, the element at the left upper 
corner will be selected with square filled with blue and white border as a 
base element. Others will be selected with square filled with white and 
black border. The base element is used to align or resize.  

 

Fig. 2.4.13 Choosing Select All command from menu bar 

 Find content 

 It is used to find the content matches the find criteria. Select this function 
by choosing Edit > Find content (Fig. 2.4.14) from menu bar or use 
keyboard shortcuts by pressing Ctrl + F. The users can find element 
text, read address, write address or memory address in current screen, 
or all screens (Fig. 2-4-15). Once it finds, the result of find content will be 
shown in the output window. Click some of the result of find content, it 
will jump to its location in ScrEdit.  
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Fig. 2.4.14 Choosing Find content command from menu bar 

 

Find content Options 

 

Find What This field is where the users enter the word or phase that the users are looking for 
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Find content Options 

 

Current Screen This cause ScrEdit to navigate the current screen only and find the 
matching word or phase that the users are looking for. The output 
window will display all matching words or phases. When the users 
double click the word or phase, ScrEdit will jump to that location of the 
matching word or phase. Please refer to the example screen below. 

Fig. 2.4.15 

Options 

All Screen This cause ScrEdit to navigate all screens and find the word or phase 
that the users are looking for. The output window will display all 
matching words or phases. When the users double click the word or 
phase, ScrEdit will also jump to that location of the matching word or 
phase.  

Text This cause ScrEdit to find the text that the users type only. 

Read Address This cause ScrEdit to find the read address that the users type only. 

Write Address This cause ScrEdit to find the write address that the users type only. 

Type 

All Address This cause ScrEdit to find the read and write address that the users 
type only. 

Check Box If “Match whole word only” this box is checked, only the exact word or phase that the users 
type will be found. If “Match whole word only” this box is not checked, all words that 
contain the word or phase that the users type will be found. 
If “Support Multi-Language Finding” this box is checked, all multi language words that 
contain the word or phase that the users type will be found. However, “Support Multi-
Language Finding” option can only be enabled when the find content type is text. 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

2-38   Revision 05/30/2006, EH00 

 Replace 

 It is used to replace the content matches the replace criteria. Using this 
command can replace text, read address and write address in current 
screen or all screens. Its function is very similar to Find command 
expect that it not only can find the word or phase that the users are 
looking for but also can replace it with a new entry. The replace content 
type could be text, read and write address and the replace content data 
type could be Bit, Word or Double Word. The function of replace content 
data type is enabled only when the replace content type is either read or 
write address. Select this function by choosing Edit > Replace (Fig. 
2.4.16) from menu bar or use keyboard shortcuts by pressing Ctrl + R. 

 
Fig. 2.4.16 Choosing Replace command from menu bar 

 

Replace Options 

 
Find What This field is where the users enter the word or phase that the users are looking for 

Replace With This field is where the users enter the word or phase that the users want to replace with 

Options Current Screen This cause ScrEdit to navigate the current screen only, find the matching 
word or phase that the users are looking for and replace it.  
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Replace Options 

 
All Screen This cause ScrEdit to navigate all screens and find the matching word or 

phase that the users are looking for and replace it. 

Text This cause ScrEdit to find and replace the text that the users type only. 

Read Address This cause ScrEdit to find and replace the read address that the users 
type only. 

Type 

Write Address This cause ScrEdit to find and replace the write address that the users 
type only. 

Bit 

WORD 

Data Type 

DWORD 

The function of replace content data type is enabled only when the 
replace content type is either read or write address. The replace content 
data type could be Bit, Word or Double Word. 

Replace 
Replace All 

Replace button is used to replace the word or phase that the users type and find and 
select the next one. For example, the users want to replace the write address from $157 to 
$158, enter $157 in Find What field, enter $158 in Replace With field and press Replace 
button. ScrEdit will find the matching word and press Yes button to replace the word. 
Replace All button is used to replace all found matching words automatically.  
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 Group 

 It is used to group elements in ScrEdit. Select this function by choosing 
Edit > Group (Fig. 2.4.17) from menu bar or clicking the Group icon 

 from toolbar (Fig.2.4.18). When two or more elements are grouped, 
it will be regarded as a single unit and move together but the element 
size cannot be changed. 

 
Fig. 2.4.17 Choosing Group command from menu bar 

 

Fig. 2.4.18 Choosing Group icon from toolbar 
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 Ungroup 

 It is used to ungroup elements in ScrEdit. Select this function by 
choosing Edit > Ungroup (Fig. 2.4.19) from menu bar or clicking the 

Group icon  from toolbar (Fig.2.4.20).  

 

Fig. 2.4.19 Choosing Ungroup command from menu bar 

 

Fig. 2.4.20 Choosing Ungroup icon from toolbar 
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 Order 

 It is used to set and change the stacking order of the selected 
element. Select this function by choosing Edit > Order (Fig. 2.4.21) 

from menu bar or clicking the Order icons  from 
toolbar (Fig.2.4.22). 

  Bring to Top. Move the selected element to the front of all other 
elements. 

  Send to Bottom. Move the selected element behind all other 
elements. 

 Bring Forward. Move the selected element forward one position.

 Send Backward. Move the selected element behind one position.

 

Fig. 2.4.21 Choosing Order commands from menu bar 
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Fig. 2.4.22 Choosing Order icons from toolbar 

 Align 

 It is used to align the element. The users can select this function by 
choosing Edit > Align (Fig. 2.4.23) from menu bar or clicking the Align 
icons from toolbar (Fig.2.4.24). 

The Align icons includes: 

  : Align Left;  : Align Right;  : Align Top;  : Align Bottom;  

  : Center Vertically;  : Center Horizontally; 

  : Space Evenly For Across;  : Space Evenly For Down.  

Align Left, Align Right, Align Top and Align Bottom commands are 
available when two or more elements are selected. That is because the 
element only can be left, right, top and bottom aligned relative to another 
element. Align Vertical Center and Align Horizontal Center commands 
are available when one or more elements are selected. Across Space 
Evenly and Down Space Evenly are available when three or more 
elements are selected. 

After Align commands are used, the coordinates of the elements will 
changed to the coordinates of the new position. 

Center Vertically: Set the element to be the vertical position of the work 
place. 

Center Horizontally: Set the element to be the horizontal position of the 
work place. 

Space Evenly For Across: Make all the elements align in a consistent 
width. 

Space Evenly For Down: Make all the elements align in a consistent 
height. 
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Fig. 2.4.23 Choosing Align commands from menu bar 

 

Fig. 2.4.24 Choosing Align icons from toolbar 
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 Make Same Size 

 It is used to make the element to be the same size. The users can 
select this function by choosing Edit > Make Same Size (Fig. 2.4.25) 
from menu bar or clicking the Make Same Size icons from toolbar 
(Fig.2.4.26). 

This function is available only when two or more elements are selected. 
The users have to select one element first and treat it as standard, and 
use this command to make other two or more elements to be the same 
size.  

 
Fig. 2.4.25 Choosing Make Same Size commands from menu bar 

 
Fig. 2.4.26 Choosing Make Same Size icons from toolbar 
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 Text Process 

 It is used to set and change text direction and import text in ScrEdit. The 
users can select this function by choosing Edit > Text Process (Fig. 
2.4.27) from menu bar or clicking the Text Process icons from toolbar. 

 next to the Text Process command represents that this function is 
enabled. In the Import Text dialog box, the users can decide if use Text 
Bank Edit Font or not. If the users check the box next to Text Bank Edit 
Font, the imported text will be display by adopting the fonts of Text Bank. 
For the settings of Text Bank, please refer to Option > Text Bank. 

 
Fig. 2.4.27 Choosing Text Process commands from menu bar 

 
Fig. 2.4.28 Import Text dialog box 
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 Duplicate 

 It allows the users to copy one or more elements at the same time. After 
selecting this function by choosing Edit > Duplicate from menu bar, the 
Fig. 2.4.29 dialog box will show up. The users can enter the number of 
columns and rows to get the total copy numbers. The minimum entry 
number should be more than 2 as the original element is also one of the 
total copy numbers. If the users only want to copy the number of Rows, 
please uncheck the box next to Columns and vice versa.  

Spacing (pixels): This option is used to set the spacing between every 
element. After this option is set, the duplicated elements will be placed in 
this spacing. 

Increase / Decrease Address: This option is used to place the element 
that the users copy by ascending or descending address. The unit of the 
address can be Word or Bit.  

X-direction / Y-direction: This option is used to place the element that the 
users copy by horizontal (X-direction) or vertical (Y-direction) direction. 

Please refer to Fig 2-4-30 and Fig. 2-4-31 for example. 

 
Fig. 2.4.29 Duplicate dialog box 

 
Fig. 2.4.30 Duplicate Example 1 
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Fig. 2.4.31 Duplicate Example 2 
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2.5 Menu Bar and Toolbar (View) 

 View 

 
Fig. 2.5.1 View options  

In View options, the users can decide how toolbars and docking windows display. Once the users click it, it 

will have icon  in front of it and display on screen. By default, the Property table and Output window 

should display on the right side of the screen. The users can also arrange these toolbars and docking 

windows by themselves (Fig. 2.5.2).  

 
Fig. 2.5.2 Docking Windows  

Docking windows 

Toolbars 
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 Standard Toolbar 

 
Table. 2.5.1 Standard toolbar 

Icon Function Description 

 New Create a new application 

 Open Open an old application 

 Save Save current edited application 

 Export Export an application to BMP format 

 Undo Undo an action (some can’t be undo) 

 Redo Redo an action 

 Cut Cut selected elements 

 Copy Copy selected elements 

 Paste Paste the element you copy or cut 

 Find Content Find specific text, write address or read address 

 New Screen Create a new screen 

 Open Screen Open an old screen 

 Print Print current application 

 Help Screen editor version 

 Status Bar 

Display current editing states. 

Caps LockStatus Selected download method Current mouse posit ion HMI model type

Num Lock Scroll Loc k  
Fig. 2.5.3 Status bar  

 Text Format Toolbar 

 
Table. 2.5.2 Text toolbar 

Icon Function Description 

 Font Size Display and change text size 
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Icon Function Description 

 Font Font 

 Aligns Left Align text to left 

 Center Horizontal The space at the right/left sides of text will be the 
same 

 Aligns Right Align text to right 

 Aligns Top Align text to top 

 Center Vertical The space at the top/bottom sides of text will be the 
same 

 Aligns Bottom Align text to bottom 

 Text Color Change text color 

 Bold Text bold 

 Italic Text Italic 

 Underline Add line under text 

 Bitmap Toolbar 

 
Table. 2.5.3 Bitmap toolbar 

Icon Function Description 

 
Select Transparent 

Color 
Use sucker tool to suck the color of the picture and determine the 
transparent color of the picture  

 
Chang Mode for 
Process All State 

Picture 

If this function is enabled (this icon is pressed), not only the current 
picture with current state but also all pictures with all states will be 
stretched, resized or aligned  

 Picture Stretch All Stretch the selected picture to the whole range of the element. 

 
Picture Stretch 

Ration 1: 1 Scale the picture relative to original picture size  

 Picture Actual  Resize the selected picture to the actual picture size 

 
Picture Align Left Align the selected picture to left 

 
Picture Align 

Horizontal Center  
The space at the right/left sides of the selected picture will be the 
same 

 Picture Align Right Align the selected element to right 

 Picture Align Top Align the selected element to top 

 
Picture Align Vertical 

Center  
The space at the top/bottom sides of the selected element will be 
the same 

 Picture Align Bottom Align the selected element to bottom 
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 Element Toolbar 

 
Table. 2.5.4 Element toolbar 

Icon Function Drop-down Menu 

 
Button 

 

 
Meter 

 

 
Bar 

 

 
Pipe 

 

 
Pie 

 

 
Indicator 
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Icon Function Drop-down Menu 

 
Display 

 

 
Movement 

 

 
Input 

 

 
Curve 

 

 
History 

 

 
Alarm 

 

 
Graphic 

 

 
Keypad 

 

 Build / Layout Toolbar 

Build Toolbar 
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Table. 2.5.5 Build toolbar 

Icon Function Description 

 Current Element State Text on selected element 

 View State OFF/1 Switch and view current state OFF/1 

 View State ON/1 Switch and view current state ON/1 

 
Display All Read/Write 

Address 
Display all read/write addresses of all 
elements 

 Previous windows Select previous windows 

 Next windows Select the next windows 

 Compile Compile current element 

 Download Screen Recipe Download screen data and recipe 

 Download Screen Data Download screen data 

 On-line Simulation Test editing file at PC side and it needs to 
connect to PLC 

 Off-line Simulation Test editing file at PC side and it doesn’t 
need to connect to PLC 

Layout Toolbar 

 
Table. 2.5.6 Layout toolbar 

Icon Function Description 

 Group Group the selected elements 

 Ungroup Ungroup the selected elements 

 Bring to Top Move the selected element to the front of all 
other elements 

 Send to Bottom Move the selected element behind all other 
elements 

 Bring Forward Move the selected element forward one 
position 

 Send Backward Move the selected element behind one position

 Align Left Align the selected elements to left 

 Align Right Align the selected elements to right 

 Align Top Align the selected elements to top 

 Align Bottom Align the selected elements to bottom 
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Icon Function Description 

 Center Vertically Set the element to be the vertical position of 
the work place 

 Center Horizontally Set the element to be the horizontal position of 
the work place 

 Space Evenly For Across Make all the elements align in a consistent 
width 

 Space Evenly For Down Make all the elements align in a consistent 
height 

 Make Same Width Make the selected elements to be the same 
width 

 Make Same Height Make the selected elements to be the same 
height 

 Make Same Size Make the selected elements to be the same 
size 

 Zoom Toolbar 

 
Table. 2.5.7 Zoom toolbar 

Icon Function Description 

 Zoom level Let you set a zoom level, including 25%, 50%, 75%, 100%, 150%, 
200% and 300% 

 Zoom in Let you change the magnification level, including 150%, 200% and 
300%. 

 Zoom out Let you reduce the magnification level, including 25%, 50% and 75%. 

 1:1 Let you change element size to actual size (100%). 
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 Property Table 

Element property table. Please refer to Chapter 3 for detailed description.  

 
Fig. 2.5.4 Property table 

 Output Window 

All editing actions and output message when compile function is enable will be shown here for users’ 

reference. It is convenient for tracing error address when creating and editing screen (See Fig. 2.5.5, 

Fig. 2.5.6, Fig. 2.5.7 and Fig. 2.5.8). 

 
Fig. 2.5.5 Output window 

 
Fig. 2.5.6 Output window during editing 

 
Fig. 2.5.7 Output result 

 
Fig. 2.5.8 Error output 
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 Zoom In 

 Zoom in to get a close look at the elements on ScrEdit work place. (Refer 
to Fig. 2.5.9, Fig. 2.5.10, Fig. 2.5.11 and Fig. 2.5.12) 

 
Fig. 2.5.9 Choosing Zoom In command from menu bar 

 
Fig. 2.5.10 Choosing Zoom In icon from toolbar 
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Fig. 2.5.11 Zoom level = 100% (Before Choosing Zoom In command) 

 
Fig. 2.5.12 Zoom level = 150% (After Choosing Zoom In command) 
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 Zoom Out 

 Zoom out to see more look of the elements on ScrEdit work place. (Refer 
to Fig. 2.5.13, Fig. 2.5.14 and Fig. 2.5.15) 

 
Fig. 2.5.13 Choosing Zoom Out command from menu bar 

 
Fig. 2.5.14 Choosing Zoom Out icon from toolbar 
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Fig. 2.5.15 Zoom level = 75% (After Choosing Zoom Out command) 

 Actual Size 

 Return to actual size (100%). This size is relative to the screen size of HMI. 

No matter zoom in or zoom out command, the zoom level could be 20%, 50%, 75%, 100%, 150%, 

200% and 300%. The users can also zoom in or out by clicking icon  or  or selecting the Zoom 
level directly (Fig. 2.5.16).  

 

Fig. 2.5.16 Zoom level  

 

 Full Screen 

 As Fig. 2.5.17. Full screen provides maximum view to edit in ScrEdit. Full 
screen view will hide all toolbars and docking windows other than the 
ScrEdit work place itself. Fig. 2.5.17 full screen also shows the reference 
macro command.  
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Fig. 2.5.17 Full Screen (Pressing Esc key or left-click the mouse can exit Full screen) 

 I/O Screen 

 As Fig. 2.5.18. I/O screen also provides maximum view to edit in ScrEdit 
just like Full screen. But the difference is that I/O Screen will show the 
read and write addresses of the element and also shows the reference 
macro command. 

 
Fig. 2.5.18 I/O Screen (Pressing Esc key or left-click the mouse can exit Full screen) 
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 Grid Setup 

 Grid Setup is a function that can help the users to align and position the 
element more easily and precisely. The distance (spacing) between the 
grid dots can be set by the users freely (Fig. 2.5.19 and Fig. 2.5.20). 

Show Grid: Show the grid dots on the screen. 

Snap to Grid: Make the elements snap to grid so that the elements can 
jump between grid lines when the users move them. 

 

Fig. 2.5.19 Gird Settings dialog box 

 

Fig. 2.5.20 Show Gird screen 
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2.6 Menu Bar and Toolbar (Element) 

 Element 

 

Fig. 2.6.1 Element options  

Screen editor provides 14 types of elements and there are lots of styles for each type. These 14 types 

include button, meter, bar, pipe, pie, indicator, data display, graph display, input, curve, sampling, alarm, 

graphic and, keypad, etc. The users can select desired element from the pull-down menu and drag the size 

needed on ScrEdit work place (as Fig. 2.6.2 and Fig. 2.6.3).  

 
Fig. 2.6.2 Drag mouse to determine the element size  
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Fig. 2.6.3 Element display (Create an element) 

The users can also right-click the mouse to select the desired element. For the property of each element, 

please refer to Chapter 3 for detailed description. 

 Create an Element 

The users can select an element by right-clicking the mouse in work place. Place your mouse pointer in 

work place and right-click the mouse to get pull-down menu. Then, the users can select the desired 

element and determine the element size by left-clicking the mouse. Later set the property of the 

element (Fig. 2.6.4, Fig. 2.6.5, Fig. 2.6.6 and Fig. 2.6.7).  

 
Fig. 2.6.4 Right-click the mouse to select the element 
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Fig. 2.6.5 Select an element by choosing Element command from menu bar 

 

Fig. 2.6.6 Drag with left mouse button 

Left-click the mouse 
and hold it to drag 
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Fig. 2.6.7 Release left mouse button to create an element 

 Move an Element 

The users can use the mouse to move an element. Mouse operation is the same as working in 

Windows® operating system. When the mouse cursor becomes a four-arrow icon , the users can 

hold down it by left-clicking the mouse and move the element freely (Fig. 2.6.8, Fig. 2.6.9 and Fig. 

2.6.10).  

 

Fig. 2.6.8 Mouse cursor becomes a four-arrow icon  
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Fig. 2.6.9 Hold down  by left-clicking the mouse and move the element freely 

 

Fig. 2.6.10 Release the mouse left button to finish the movement 

 Modify Element Width 

The users can also use the mouse to modify the width of an element. When the mouse cursor becomes 

a two-arrow icon , the users can hold down it by left-clicking the mouse and modify the element 

width (Fig. 2.6.11, Fig. 2.6.12 and Fig. 2.6.13). 
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Fig. 2.6.11 Mouse cursor becomes a two-arrow icon  

 

Fig. 2.6.12 Hold down  by left-clicking the mouse and modify the element width 
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Fig. 2.6.13 Release the mouse left button to finish the modification 

 Modify Element Height 

The users can also use the mouse to modify the height of an element. When the mouse cursor 

becomes a two-arrow icon , the users can hold down it by left-clicking the mouse and modify the 

element height (Fig. 2.6.14, Fig. 2.6.15 and Fig. 2.6.16). 

 

Fig. 2.6.14 Mouse cursor becomes a two-arrow icon  
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Fig. 2.6.15 Hold down  by left-clicking the mouse and modify the element height 

 

Fig. 2.6.16 Release the mouse left button to finish the modification 

 Modify Element Width and Height Simultaneously (Method 1)  

The users can also use the mouse to modify the width and height of an element simultaneously. When 

the mouse cursor becomes a two-arrow icon , the users can hold down it by left-clicking the mouse 

and modify the element width and height at the same time (Fig. 2.6.17, Fig. 2.6.18 and Fig. 2.6.19). 
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Fig. 2.6.17 Mouse cursor becomes a two-arrow icon  

 

Fig. 2.6.18 Hold down  by left-clicking the mouse and modify the element width and height 
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Fig. 2.6.19 Release the mouse left button to finish the modification 

 Modify Element Width and Height Simultaneously (Method 2)  

The users can also use the mouse to modify the width and height of an element simultaneously. When 

the mouse cursor becomes a two-arrow icon , the users can hold down it by left-clicking the mouse 

and modify the element width and height at the same time (Fig. 2.6.20, Fig. 2.6.21 and Fig. 2.6.22). 

 

Fig. 2.6.20 Mouse cursor becomes a two-arrow icon  
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Fig. 2.6.21 Hold down  by left-clicking the mouse and modify the element width and height 

 

Fig. 2.6.22 Release the mouse left button to finish the modification 

 Input characters 

The users can input a string of characters that Windows® operating system accepts in the property 

table. When the mouse cursor becomes an icon , the users can start to input any characters that 

Windows® operating system accepts at where the cursor  blinks (Fig. 2.6.23 and Fig. 2.6.24). 
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Fig. 2.6.23 Mouse cursor becomes an icon  (Ready to input characters display) 

 

Fig. 2.6.24 Input characters for the element 

 Right-click the mouse 

The users can find that different menu will pop up when right-clicking the mouse (Fig. 2.6.25, Fig. 

2.6.26 and Fig. 2.6.27).  
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Fig. 2.6.25 Right-click the mouse on Toolbar – Toolbars display setup menu 

 

Fig. 2.6.26 Right-click the mouse in Work Place – Element Selection Menu 
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Fig. 2.6.27 Right-click the mouse on the element – Element Editing Menu 

 Cross Reference Table 

 When creating and editing various kinds of elements, what usually 
happens is that the repeat use of the same address. In order to avoid this 
situation, ScrEdit provides the cross reference table function for the 
users’ convenience and quick reference. The users can view the read 
and write addresses of the selected element and see their relationship or 
connection with the addresses of other elements, macro commands or 
system control area. The users can see how to choose Cross Reference 
Table command from menu bar in Fig. 2.6.28. Fig. 2.6.29 is one simple 
example to introduce the usage of this function. The first row of the cross 
reference table displays the referred element the users selected and the 
other rows below the first row displays the elements which have the 
same write address. The users can double-click the row and ScrEdit will 
switch to the corresponding screen of the referred address automatically. 
In Fig.2.6.29, ScrEdit switches to the corresponding screen of the 
referred address automatically and select the reference element. 
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Fig. 2.6.28 Choosing Cross Reference Table command from menu bar 

 

Fig. 2.6.29 Cross Reference Table dialog box 
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 Element Part List 

 When Element Part List function is enabled (Fig. 2.6.30), ScrEdit will 
sort out and classify all the elements on the current screen. The users 
can click the tab to switch to the classification that the users want to 
view. The related addresses and corresponding properties will be listed 
in each classification (Name, Describe, Write / Read address, Trigger 
address, Trigger type, Interlock and Level) in each tab (Fig. 2.6.31). The 
users can double-click the column to let ScrEdit select the element 
automatically and allow the users to edit the detailed property of the 
selected element in property table. 

 
Fig. 2.6.30 Choosing Element Part List command from menu bar 

 
Fig. 2.6.31 Element Part List dialog box 
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2.7 Menu Bar and Toolbar (Screen) 

 Screen 

In Screen options, ScrEdit provides some screen editing functions (Fig. 2.7.1). Please refer to the following 

sections for more detailed introduction. 

 
Fig. 2.7.1 Screen options  

If the users press close box as in Fig. 2.7.2, it will hide the current screen without exiting. In Windows, it will 

exit the current screen by clicking close box and remind the users to save before exiting. However, in ScrEdit 

environment, the current screen will not be deleted and it will not remind the users to save also. The function 

of clicking close box only hides current screen. 

 
Fig. 2.7.2 Close Screen 
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 New Screen 

 Create a new screen. The users can choose Screen > New 

Screen (Fig. 2.7.3) or click the New Screen icon  (Fig. 2.7.4), 
or use keyboard shortcuts by pressing Shift + N to open a new 
editing screen. The new screen can be named and numbered by 
the users. The setting dialog box is shown as Fig. 2.7.5. 

 
Fig. 2.7.3 Choosing New Screen command from menu bar 

 
Fig. 2.7.4 Choosing New Screen icon from toolbar 
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Fig. 2.7.5 New Screen dialog box 

 Open Screen 

 Open an old screen. The users can choose Screen > Open 

Screen (Fig. 2.7.6) or click the Open Screen icon  (Fig. 
2.7.7), or use keyboard shortcuts by pressing Shift + O. When 
choosing open screen, the users can preview each screen in 
Open Screen dialog box (Fig. 2.7.8).  

 
Fig. 2.7.6 Choosing Open Screen command from menu bar 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

2-82   Revision 05/30/2006, EH00 

 
Fig. 2.7.7 Choosing Open Screen icon from toolbar 

 
Fig. 2.7.8 Open Screen dialog box 
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 Screen Management 

 When Screen Management function is enabled (Fig. 2.7.9, Fig. 
2.7.10), the users can duplicate, paste and cut the screen by the 
mouse, just like the function of Windows Explorer in Windows® 
operating system. In Screen Management dialog box, the users 
can right click the mouse to manage all of the screens (Fig. 
2.7.11). Right-clicking the mouse to select the Edit Save Screen 
function, and then the users can drag the mouse to determine 
the screen saver display (Fig. 2.7.12). For the setting of screen 
saver, please click Options > Configuration > Other.  

 
Fig. 2.7.9 Choosing Screen Management command from menu bar 

 
Fig. 2.7.10 Screen Management dialog box 
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Fig. 2.7.11 Right-click the mouse to select Edit Save Screen function 

 
Fig. 2.7.12 Drag the mouse to determine the screen saver display 
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 Cut Screen 

 Cut whole screen to clipboard, just like the Microsoft Office 
Clipboard function. The difference is that Microsoft Office 
Clipboard allows the users to cut text and graphic items and the 
Cut Screen function only allows the users to cut whole screen. 
The users can execute this function by choosing Screen > Cut 
Screen (Fig. 2.7.13), or use keyboard shortcuts by pressing 
Shift + T (Fig. 2.7.14). 

Note: The users cannot undo the action of cut screen. It is 
the same as delete screen that screen will be lost but it can 
be pasted to get the same screen. 

 
Fig. 2.7.13 Choosing Cut Screen command from menu bar 

 
Fig. 2.7.14 Cut Screen message 

 Copy Screen 

 Copy whole screen. The users can execute this function by 
clicking Screen > Copy Screen (Fig. 2.7.15) or use keyboard 
shortcuts by pressing Shift + C.  
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Fig. 2.7.15 Choosing Copy Screen command from menu bar 

 Paste Screen 

 The users can paste screen by clicking Screen > Paste Screen 
(Fig. 2.7.16) or use keyboard shortcuts by pressing Shift + P. All 
screen setting will be the same as original screen after pasting 
but screen name will be given automatically.  

 
Fig. 2.7.16 Choosing Paste Screen command from menu bar 
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 Delete Screen 

 Delete the current editing screen or element. The users can 
delete screen by clicking Screen > Delete Screen (Fig. 2.7.13) 
or use keyboard shortcuts by pressing Shift + D.  

Note: After executing Delete Screen, the users cannot undo 
the action of delete screen. Please consider it carefully 
before taking action. 

 
Fig. 2.7.17 Choosing Delete Screen command from menu bar 

 
Fig. 2.7.18 Delete Screen Message 
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 Export 

 Export an application to BMP format. The users can execute this 
function by clicking Screen > Export (Fig. 2.7.19) or clicking the 

Export icon  (Fig. 2.7.20), or use keyboard shortcuts by 
pressing Shift + E.  

 
Fig. 2.7.19 Choosing Export command from menu bar 

 
Fig. 2.7.20 Choosing Export icon from toolbar 
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 Import 

 Import a picture to be the ground of the editing screen. Please 
notice that this ground of the editing screen is different than the 
base screen. The nature of imported picture differs greatly from 
that of base screen. The imported picture cannot exist in ScrEdit 
as an element. However, the base screen can be regarded as an 
element and then exist in the editing screen after compile 
operation is completed. The file types of available imported 
picture can be BMP, JPG and GIF, etc. The users can execute 
this function by clicking Screen > Import (Fig. 2.7.21) or use 
keyboard shortcuts by pressing Shift + I. 

 
Fig. 2.7.21 Choosing Import command from menu bar 

 Clear Import Data 

 The users can free more disk space by clearing the imported 
data that the users do not want to use. Execute this function by 
clicking Screen > Clear Import Data (Fig. 2.7.22). 
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Fig. 2.7.22 Choosing Clear Import Data command from menu bar 

 Screen Open Macro 

 When Screen Open Macro function is selected, the Macro will 
be executed automatically once opening screen. (Please refer to 
Chapter 4 for the usage and editing method of Macro.) 

 
Fig. 2.7.23 Choosing Screen Open Marco command from menu bar 
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Fig. 2.7.24 Choosing Screen Open Macro from docking windows 

 
Fig. 2.7.25 Screen Open Marco editing environment 

 Screen Close Macro 

 When Screen Close Macro function is selected, the Macro will 
be executed automatically once screen get closed. (Please refer 
to Chapter 4 for the usage and editing method of Macro.) 
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Fig. 2.7.26 Choosing Screen Close Marco command from menu bar 

 
Fig. 2.7.27 Choosing Screen Close Macro from docking windows 

 Screen Cycle Macro 

 When Screen Cycle Macro function is selected, the Macro will 
be executed periodically once screen get displayed. (Macro will 
be executed periodically by cycle time setting) (Please refer to 
Chapter 4 for the usage and editing method of Macro.) 
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Fig. 2.7.28 Choosing Screen Cycle Marco command from menu bar 

 
Fig. 2.7.29 Choosing Screen Cycle Macro from docking windows 

 Auxiliary Key 

 DOP series HMI allows the users can determine the function of 
auxiliary keys in each screen. The users can execute this function 
by clicking Screen > Auxiliary Key (Fig. 2.7.30). Auxiliary key 
set up for each screen can be completed by pressing the auxiliary 
keys on HMI panel (Fig. 2.7.31) or on the screen (Fig. 2.7.32). 
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Fig. 2.7.30 Choosing Auxiliary Key command from menu bar 

 
Fig. 2.7.31 Auxiliary Keys on HMI panel 
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Fig. 2.7.32 Auxiliary Key setting on the screen 

In Table 2.7.1, the users can know how many user-defined auxiliary keys are available for each model. 

Table. 2.7.1 Available user-defined auxiliary keys 

DOP-A Series Model Name Available User-defined Auxiliary Keys 

DOP-A57BSTD 4 
DOP-A57GSTD 4 
DOP-A57CSTD 4 
DOP-A75CSTD 6 
DOP-A10TCTD 7 

DOP-AE Series Model Name Available User-defined Auxiliary Keys 

DOP-AE57BSTD 4 
DOP-AE57GSTD 4 
DOP-AE57CSTD 4 
DOP-AE80THTD 6 
DOP-AE10THTD 7 

 Screen Properties 

 The users can decide the properties of the current editing screen 
by clicking Screen > Screen Properties (Fig. 2.7.33) or choosing 
Screen Properties from docking windows to set the current 
screen (Fig. 2.7.34). For the setting of Screen Properties, please 
refer to Table 2.7.2. 
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Fig. 2.7.33 Choosing Screen Properties command from menu bar 

 
Fig. 2.7.34 Choosing Screen Properties from docking windows 
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Table. 2.7.2 Screen Properties setting 

Function Description 

Screen Number The screen number range is within 1~65535 and the number cannot be 
repeated. 

General View 
Screen 

Regarded as general view screen. The element created by the users can 
be downloaded to HMI after compile operation and display on HMI LCD 
display. The input type element, such as Button, Input and Keypad can be 
pressed on HMI display and used to execute print function.  

Screen 
Application 

Apply Print 
Screen 

1. Regarded as print screen. The printer can print the element created by 
the users after compile operation. This option is only available in DOP-
AE series HMI and only can be enabled after the printer is set. For the 
setting of the printer, please click Option > Configuration > Print (Fig. 
2.7.35). 

2. When Apply Print Screen function is selected, the editing range will be 
scaled to the actual paper size of the printer. The users can only print 
the elements within the range of the paper size. When the users select 
this option, all history data or sampling records of the editing elements 
can be printed out. This option is usually used for print typesetting.  

The users can find printer setting by clicking Option > Configuration > Print 
shown as Fig. 2.7.35 below. 

 
Fig. 2.7.35 Print tab in Configuration option 
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Function Description 

Check the check 
box next to “This 
screen is a sub-
screen” 

The check box next to “This screen is a sub-screen” can be checked only 
when General View Screen option is selected. Therefore, before setting 
sub-screen function, please ensure General View Screen option is 
selected. 

 
Fig. 2.7.36 Sub-screen setting 

Screen Width It is used to set the width of sub-screen and the unit is Pixel. 

Screen Height It is used to set the height of sub-screen and the unit is Pixel. 

Sub-screen 
Position  

The users can decide the sub-screen is shown on the center position of 
HMI display or specify the display position freely. Only input the coordinate 

value directly (X and Y axis) or press the mouse button  to drag the 
sub-screen to the position the users decided (Fig. 2.7.37). 

 
Fig. 2.7.37 Sub-screen position 

Sub-screen 
Setting 

Title Bar When the check box next to “Use Title Bar” is checked, the title bar will be 
shown when opening sub-screen.  

Cycle Macro Delay Time It is used to set Cycle Macro Delay Time when this screen is executed 
every time. The range of the cycle macro delay time is within 100ms ~ 5s.

Fast Refresh Rate There are three levels of the Fast Refresh Rate and they are High, Medium 
and Low. The purpose of this function is used to make some elements can 
be displayed immediately when switching screen. Please notice that it only 
allows four elements can be renewed immediately in each screen.  
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Function Description 

Setting The users can find this function in DOP-AE series HMI only. If the users 
want to enable this function, setting the printer in advance is necessary. 
Please go to Option > Configuration > Print (Fig. 2.7.35) and select the 
printer first. When this function is enabled, if one report list button is 
created and its assigned output device is a printer, HMI will check for the 
screen that print typesetting has been executed and check if it is necessary 
to output the screen to the printer for printing out. If the screen without print 
typesetting needs to be output to HMI, HMI will refer to the setting in Hard 
Copy Region option and execute the screen-printing.   

Top-Left 

Hard Copy 
Region 

Right-Bottom 

It is used to set the region of HMI printing area (also called Hard Copy 
Region) and the unit is Pixel.  

Base Screen Check the check 
box next to 
“Need a base 
screen” 

Every screen can specify any one of editing screen as base screen. When 
the check box next to “Need a base screen” is checked, the base screen 
will be moved to the back (behind all other elements) as a ground picture. 
After compile operation is completed and the screen data is downloaded to 
HMI, HMI will execute all of the elements on the base screen correctly.  
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2.8 Menu Bar and Toolbar (Tools) 

 Tools 

 
Fig. 2.8.1 Tools options  

 Compile 

 It is used to compile editing screen to the format for HMI. If this 
application is a new application, it will remind the users of saving 
before compiling. If this application has been saved or it is an old 
application, it will compile directly. During compiling, all of the 
compiling messages, including any errors, will be written to 
output field. An object file would be produced if there were no 
error during compiling process. The users can execute this 
function by clicking Tools > Compile (Fig. 2.8.2) or clicking icon 

 directly (Fig. 2.8.3) or using keyboard shortcuts by pressing 
Ctrl + F7. 

 

Fig. 2.8.2 Choosing Compile command from menu bar 
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Fig. 2.8.3 Choosing Compile icon from toolbar 

 

Table 2.8.1 Debug Compiling Error  

Debug Compiling Error during Compiling Process 

1. Create a new application. 
2. Create two editing screens. 
3. Create a button element on these two screens respectively and do not change the element default 

property as the Fig. 2.8.4 below. 

Fig. 2.8.4 
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Debug Compiling Error during Compiling Process 

4. When pressing  icon to execute compile operation, error message dialog box will pop up to warn 
the users of compiling error and show how many errors there are. In Fig. 2.8.5, we can see that 
there are two errors occurred and they are all displayed in the output window. 

  
Fig. 2.8.5 Compiling errors during compiling process 

 
5. Once error occurs, the correspondent message will display in output window. The users can click 

the error message and ScrEdit will switch to error element window automatically. 

 Download Screen & Recipe 

 The users can download screen data and recipe to HMI by 
clicking Tools > Download Screen & Recipe (Fig. 2.8.6) or 

clicking  icon directly (Fig. 2.8.7) or using keyboard shortcuts 
by pressing Ctrl + F8. If PC cannot connect to HMI, the error 
messages will display and warn the users (Fig. 2.8.9 and Fig. 
2.8.10). The users can set download interface by clicking 
Options > Configuration or by clicking Options > Environment. 
The download interface can be USB or RS-232. 
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Fig. 2.8.6 Choosing Download Screen & Recipe command from menu bar 

 

Fig. 2.8.7 Choosing Download Screen & Recipe icon from toolbar 
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Fig. 2.8.8 Start to download (the progress will be from 0 to 100%) 

 
Fig. 2.8.9 USB open error message 

 
Fig. 2.8.10 USB disconnect error message 

 Download Screen 

 It is only used to download screen data to HMI. The users can 
execute it by clicking Tools > Download Screen (Fig. 2.8.11) or 

clicking icon  directly (Fig. 2.8.12) or using keyboard 
shortcuts by pressing Ctrl + F9. For the download screen, please 
refer to Fig. 2.8.8 above. 
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Fig. 2.8.11 Choosing Download Screen command from menu bar 

 

Fig. 2.8.12 Choosing Download Screen icon from toolbar 
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 On Line Simulation 

 It is used to simulate DOP series HMI by computer but HMI 
should also connect to PLC first to drive PLC by PC simulation 
through PC communication port (COM1 and 2). Therefore, the 
users cannot execute online simulation without connecting PLC. 
But the users can execute offline simulation without connecting 
PLC. On Line Simulation function can execute by clicking Tools 

> On Line Simulation (Fig. 2.8.13) or clicking icon  directly 
(Fig. 2.8.14) or using keyboard shortcuts by pressing Ctrl + F4. 
For On Line Simulation Screen, the users can refer to Fig. 2.8.15 
below. 

 

Fig. 2.8.13 Choosing On Line Simulation command from menu bar 
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Fig. 2.8.14 Choosing On Line Simulation icon from toolbar 

 
Fig. 2.8.15 On Line Simulation Screen 
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 Off Line Simulation 

 It is used to test if the editing screen, read/write addresses and 
Macro on is correct on developed program without connecting to 
PLC. The users can execute this function by clicking Tools > Off 

Line Simulation (Fig. 2.8.16) or clicking icon  (Fig. 2.8.17) 
or using keyboard shortcuts by pressing Ctrl + F5.  

 
Fig. 2.8.16 Choosing Off Line Simulation command from menu bar 

 
Fig. 2.8.17 Choosing Off Line Simulation icon from toolbar 
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 Recipe 

 Recipe function provides the controller a convenient parameter 
input method. The users can transmit the designated parameter 
to the controller by using HMI recipe after finishing editing recipe. 
Recipe can be set and modified by recipe dialog box and can be 
saved and used independently without application. Therefore, 
recipes can be used for all brands of models. Before using 
recipe, the users should enable recipe function first by clicking 
Tools > Recipe (Refer to Fig. 2.8.18). After the recipe function is 
enabled, the Recipe Setup dialog box will pop up (Fig. 2.8.19) 
and then the users can start to edit the recipe. For the setting of 
Recipe Setup dialog box, please refer to Table 2.8.2 below. 

 
Fig. 2.8.18 Choosing Recipe command from menu bar 

 
Fig. 2.8.19 Recipe Setup dialog box 
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In Fig. 2.8.19, there are 10 groups of parameter inputs and the length for each group is 10 WORDs. 

The users can determine which group is transmitted to PLC designated address (circled in red color in 

Fig. 2.8.19) by HMI recipe parameter. 

 Download Recipe 

 Downloads recipe to HMI. It can save time when the users want 
to download recipe date only. What the users need to do is to 
click Tools > Download Recipe and then the recipe data can be 
downloaded to HMI. The general extension name of recipe file is 
rcp (Fig. 2.8.20). 

 

Fig. 2.8.20 Download Recipe 
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Table 2.8.2 Recipe Editing 

Recipe Setup 

 
Enable Recipe  When the check box next to “Enable Recipe” is checked, the recipe function is 

enabled. If the users do not enable this function, the users can not do this function 
even the users have downloaded recipe data. 

Address The users can input the starting address of recipe data here. It can accept the 
address in PLC input format and internal memory format. The users also can click 

 button to get the address input dialog box shown as (Fig. 2.8.21) to input 
starting address.  

  

Fig. 2.8.21 Input starting address dialog box 
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Recipe Setup 

Length It is used to set the recipe length. The unit is word and it should be set to more 
than 0. Otherwise, the following dialog box shown as Fig. 2.8.22 will display on 
the screen. 

 
Fig. 2.8.22 Length input error message 

Group It is used to set group number of recipe. It is convenient for the users to use 
recipe by switching. The group number should be set to more than 0. Otherwise, 
the following dialog box shown as Fig. 2.8.23 will display on the screen. 

 
Fig. 2.8.23 Group input error message 

Input 
After setting length and group number of recipe, the users can click  
button to edit the recipe data. The memory size for recipe is limited. When the 
Hold Data Place is selected as SRAM, the memory size for recipe is 64K. It 
indicates that the total recipe size should be less than 64K. (Length x groups 
should be less than 64 X 1024) If one of them is 0 or exceeds the limit, the users 
will see a warning message shown as Fig. 2.8.24 displayed on the screen. 

 
Fig. 2.8.24 Input error message 

Some HMI, such as DOP-AE80THTD、DOP-AE10THTD support USB host 
function. It indicates that these models have a built-in USB host interface and the 
users can input more recipe data via this interface. However, there is still a limit 
for the input value of recipe length and groups. When Hold Data Place is selected 
as USB disk, the length x groups should be less than 4×1024×1024 (4Mbytes). 
The users can change the selection of Hold Data Place by clicking Options > 
Configuration > Standard. Please refer to Fig. 2.8.25 on next page. 
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Recipe Setup 

Input 

 
Fig. 2.8.25 

Open 
The users can load recipe data by clicking  button. The loaded 
recipe data do not contain the starting address of recipe data. Therefore, 
regardless of which PLC brand connecting to HMI, they all can use the same 
recipe file. It also can open Windows® Excel CSV file. 

Save It is used to save the editing recipe data to be a file. When saving recipe file, the 
starting address will not be saved. This lets the users can use the same recipe file 
in the different PLC brand. The users also can save the recipe file as Windows® 
Excel CSV file.  

Reset 
When the users click  button, all related recipe setting and input 
recipe data will be deleted. 
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Recipe Setup 

Clear All input recipe will be cleared to 0 (zero) when clear function is selected. Please 
refer to Fig. 2.8.26 below. 

 
Fig. 2.8.26 

Print It will print all recipe data on current screen. 

OK 
After inputting the recipe data, the users can click  button to save the 
recipe data for transmitting or modifying. At the same time, ScrEdit will check the 
validity of all input recipe data. If there is invalid input recipe data value, the OK 
function will not be executed successfully. For example, in Fig. 2.8.27, ScrEdit find 
an error and a warning message dialog box display on the screen as the users do 
not input the address.  

 
Fig. 2.8.27 

Cancel It will force to exit the Recipe Setup dialog box without saving anything after 

clicking  button. Therefore, please consider carefully before clicking 
this button.  
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2.9 Menu Bar and Toolbar (Options) 

 Options 

 

Fig. 2.9.1 Options options  

 Configuration 

 The users can execute this function by clicking Options > 
Configuration (Fig. 2.9.2). This dialog box is divided into five tabs: 
Standard, Communication, Print, Default and Other. These tabs are 
covered in detail in the following sections. 

 

Fig. 2.9.2 Choosing Configuration command from menu bar 
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Table 2.9.1 Standard Tab 

Standard tab in Configuration option 

 
Application Name 
(Standard) 

It is also File Name. 

HMI Type (Standard) It is used to select DOP series HMI type for different functions and 
requirements.  

 
Base Port Controller 
(Standard) 

It is used to set connecting external controller: Screen Editor provide various  
controllers sorted by manufacturers for the users to select. 

 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   2-117 

Standard tab in Configuration option 

Hold Data Place 
(Standard) 

The backup memory data can be saved in SRAM, SMC and USB Disk these 
three places. The users can select one of them from the Hold Data Place drop-
down list. However, USB Disk selection is available in some HMI types only. If 
DOP-A57BSTD is chosen, the backup memory data only can be saved in 
SRAM and SMC. 

Password (Security) It is used to set the highest priority password. There are 8 levels for the 
password. Meanwhile, this password is also the protection password for the file 
(application).  

Starting Level (Security) It is used to set start-up priority. The highest level is 7 and the lowest level is 0.

Address (Control Block) It is used to set the starting address of system control block. 

Size (Control Block) The length of control block will be different depending on different function. (For 
example, the length should be at least 8 Words when using multi-language 
function). For more detailed information of system control block, please refer to 
Chapter 5.  
Note: Please notice that the when the control block size is set to 0, the 
control block function is disabled. 

Clear flag after done If this check box is checked, the register in the control block will be cleared to 0 
when any operation has been finished in the control block. 

Address (Status Block) It is used to set the starting address of system status block. The length is 
constant 6 words. Each word indicates the different status value of HMI system. 
Refer to chapter 4 for important parameters of system status area. For more 
detailed information of system status block, please refer to Chapter 5. 

Optimize - 
Dynamic 

When switching the screen, optimize all elements that read 
addresses on the screen. 
Please notice that when this function is selected, all elements 
that read addresses on the screen will display incorrect value 
in a short time. The display value will become normal after 
optimization is completed. 

Optimize Type 

Optimize - Static Optimize all elements that read addresses on the screen 
during compile operation. 

Upload / Download The users can select USB or PC communication port (i.e. RS-232) to upload 
and download. 

Startup Delay Time It is used to set delay time for waiting the startup of external controller (i.e. 
PLC). PLC. The range is 0 ~ 255 seconds.  

Clock Macro Delay It is used to set interval time when executing clock macro every time. The range 
is 100 ~ 65535ms.  
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Table 2.9.2 Communication Tab 

Communication tab in Configuration option 

 
Add Press Add button to determine the connecting device name and 

the controller: 

 
It is used to set the connecting PLC. Available connecting PLC will 
be different depending on HMI type. (DOP series can support 
three max. different controllers simultaneously.) 

Delete It is used to delete the existed connecting controller (One 
application needs to connect at least one controller). 

Add / Delete 
Controller 
Connection 

Modify Modify the connecting controller or change the controller name. 

COM Port It is used to set COM port that used to communicate with HMI 
(COM1 or COM2). COM3 port only provided in some types of 
HMI, e.g. DOP AE series. 

Password Entering password is necessary for some connecting controllers 
before communication. 

Controller Settings 

Comm. Delay 
Time 

It is used to set delay time for waiting the startup of external 
controller (i.e. PLC). The range is within 0 ~ 255 ms. 
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Communication tab in Configuration option 

Timeout It is used to set communication time out time when communicating 
with the external controller. The range is within 100 ~ 65535ms.  

Retry Count HMI will try to send communication command to the external 
controller repeatedly if the external controller does not respond 
during communication. This option is used to set the number of 
retry count times. A communication error dialog box will not 
appear unless the number of retry count times is reached. The 
range is within 0 ~ 255 times.  

Optimize Use this option to enable optimization function. If optimization 
function is enabled, all read addresses of all related elements will 
be optimized.  

Size Limit This function is available only when “Optimize – Static” on 
Standard tab is selected. It is used to avoid that the screen 
updating speed may slow down when reading too long continuous 
address.  

When the check box next to “Communication Interrupt times then cancel connected” 
is checked, HMI will stop communicating with the external controllers after the 
communication interrupt times is reached. The purpose of this function is to avoid 
the communication error dialog box will always show on the HMI screen when the 
communication error occurs after HMI has retried. The range is within 1 ~ 255 times.

HMI Station It is used to set HMI station number. The range is within 0 ~ 255.

PLC Station It is used to set PLC station number. If PLC does not set station 
number, it will use this default setting. The range is within 0 ~ 255. 

Interface It is used to set communication interface. The default setting is 
RS232. There are RS232, RS422 and RS485 three options. 

Data Bits There are 7 Bits and 8 Bits two options. 

Stop Bits There are 1 Bits and 2 Bits two options. 

Baud Rate Communication baud rate. There are 4800, 9600, 19200, 38400, 
57600 and 115200 these options. The users can enter the setting 
value directly also but the max. setting value can not exceed 
187500.  

Parity There are None, Odd and Even three options.  
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Table 2.9.3 Print Tab 

Print tab in Configuration option 

 
Printer Use this option to set the connecting printer. The users can use the 

drop-down list to specify the printer. The printers in the list are sorted 
by the manufacturers and the users can find the printer easily. 

 
Paper The users can use Paper drop-down list to select the paper size. The 

predefined paper sizes in the list are A4 and Letter only. 

Standard 

Quality Only 72DPI option is provided. 

Margin The users can determine the blank space (margins) that will not be printed by using 
this option. Use this option can specify the top, bottom, left and right margins and the 
unit is mm.  

Interface It is used to set printer interface. The users can specify the communication port of 
the printer. There are Parallel Port and USB two options.  

Auto Next Page When the “Auto Next Page” option is selected, the printer will print the next page 
automatically. If the checkbox next to “Auto Next Page” is not checked, the printer 
will print continuously without breaking for different pages. 

Direction It is used to set printing direction (orientation). There are Vertical (Portrait) and 
Horizontal (Landscape) two options. 
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Table 2.9.4 Default Tab 

Default tab in Configuration option 

 
Start up Screen Use this option to set the first display screen when HMI is 

powered on and started up.  

Default Format When creating elements, it is used to set the default value 
format. 

Default Screen 
Background 

When a new editing screen is created, the users can use this 
option to set the default screen background color. 

System Error Display 
Time 

Use this option to set the display time of system error 
message dialog box. The range is within 0 ~ 5 seconds.  
Please notice that if the setting value is set to 0, it 
indicates that the system error message dialog box will 
not display on HMI screen. 

System Default 
Value 

System Key Use 
Mode 

It is used to set the system key action when the users press 
the key. There are Disable, Check Password and 
Unchecked Password these three options. 

Element Font Size It is used to specify the default element font size when 
creating an element.  

Element Font Name It is used to specify the default element font name when 
creating an element.  

Element Default 
Value 
 

Element Font Color It is used to specify the default element font color when 
creating an element.  
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Default tab in Configuration option 

Twinkle Time  It is used to specify the default element twinkle time when 
creating an element. 
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Table 2.9.5 Other Tab 

Other tab in Configuration option 

 
In Screen Management option on page 2-66, there is more detailed description for 
introducing how to drag the mouse to determine the screen saver display. 

Enable Save Screen This option should be selected when the users want to 
use Edit Save Screen function in Screen Management 
option. If this option is not selected, even though the users 
have chosen the Edit Save Screen function, the screen 
saver will not be started up. 

Save Screen  

Read Controller Address 1. The users can use this option to enable the screen 
saver. When the setting value is 0, it indicates that the 
screen saver function is disabled. If the setting value 
is a non-zero value, it indicates that the screen saver 
function is enabled. When the users touch the HMI 
screen, the screen saver function is ineffective.  
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Other tab in Configuration option 

Read Controller Address 2. If this option is not selected, the screen saver will be 
enabled automatically when the Screen Saver Time 
set in HMI is reached. If the screen saver function is 
enabled, the users can touch the HMI screen to 
disable it.  

 
Interval Time At Two 
Save Screen 

User this option can set the interval time between two 
screen savers. The range is within 1 ~ 255 second.  

Ending of Save Screen 
Mode 

1. Return Original: Return to the original screen at that 
time when the screen saver is enabled. 

2. Indicate Screen: Specify the screen that will show 
after the screen saver program ends.  

New Pressing New button can add a language option. 

 
As shown as the figure above, the users have to enter the 
language name and setting value. The setting value will 
be referred by the system when setting multi-language. 
The range of the setting value is within 0 ~ 255. Setting 
language name is easy for text editing. The users can 

press  button to change the flag color on the language 
name tab.  

Enable/Disable Delta HMI allows the users to edit multi-language screen, 
however the users can use this option to determine which 
languages are supported (enabled) or not supported 
(disabled) as the users wish when downloading data to 
HMI.  

Remove Remove the existing language. Ensure to keep at least 
one language for an application. 

Multi-Language 

Modify Modify the existing language name and setting value. 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   2-125 

Other tab in Configuration option 

Enable Edit Multi-
Language User Interface

Use this option can enable multi-language user interface. 
The users can view multi-language display in property 
table if this option is selected. The editing interface will be 
shown as the figure below:  

 
 

How to Use Multi Language Function  

Example:  

Create a Screen that has “English”, “Traditional Chinese” and “Simplified Chinese” three languages selection 

for the users to switch. Also, teach the users how to set an “Increment” button to switch the language 

selection within the screen. 

1. Create a new application.  

Select HMI model “DOP-A57CSTD 256 Colors”. 

 

2. Create two button elements on the screen. “Set” and “Increment” these two button elements. 
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3. Control Block (Options > Configuration) Settings 

Set the address as $200 and set the size is 8. 

 

4. Multi-Language Settings 

Add “English”, “Traditional Chinese” and “Simplified Chinese” three languages. The setting value are 0,1 

and 2 for each language respectively.  
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5. Set the display text of “Set” button element in different languages. 

 

 Double click the English tab and enter “Alarm” in English. 

 Double click the Traditional Chinese tab and enter “警示燈” in Traditional Chinese. 

 Double click the “Simplified Chinese” and enter “警示燈” in Simplified Chinese” 

6. In property setting of “Increment” button element, please set the write address as the internal memory 

$207.  
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7. Then, set the setting value of “Before Execute Macro”. The users can enter the Macro command as 

$207=$207%3. 

 

8. Select Compile command and execute Off Line Simulation. Then, the users can see the text of the 

“Set” button is changed in different language by pressing the “Increment” button element. 
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 Alarm Setup 

 The users can set alarm by clicking Options > Alarm Setup (Fig. 
2.9.3). The alarm setup should set with the alarm function in element 
settings. HMI will execute alarm function automatically if both settings 
are all set. When the specified conditions are matched (If condition 
occurs in specific address, ON enabled or OFF enabled) after setting, 
HMI will display a Alarm Setup warning dialog box automatically. In this 
dialog box (Fig. 2.9.4), there are Delete, Modify, Import, Export and 
Close for the users to use. For more information for the settings of 
Alarm Setup, please refer to the Table 2.9.6 on the following page and 
Chapter 3 for more description. 

 

Fig. 2.9.3 Choosing Alarm Setup command from menu bar 

 

Fig. 2.9.4 Alarm Setup Dialog Box 
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Table 2.9.6 Alarm Setup Settings 

Alarm Setup Dialog Box 

Address of 
Alarm Block 

Use this option to set the alarm starting address. It provides 512 alarms, 
32 Words. 

Scan Time 
(second) 

It is used to set the how long the HMI scan one time. The unit is second.

Number of 
Records in 
History 

Use this option to save data in order. When the number of records 
exceeds this setting value, it will delete the first record and insert the 
new record into the last address. For example, if the setting value is set 
to 100 and the number of records in history exceeds 100, the first record 
will be deleted and the second record will become to the third record, 
the third record will become to the forth record…and the 100th record 
will become to 99th record. Therefore, the new record (101st record) will 
become to 100th record. 

Non-volatile  Using this option can enable to save data in SRAM when the power is 
turned off. The capacity for saving alarm data of DOP-A series is 
8MBytes and DOP-AE series is 16MBytes. (The power of SRAM is 
battery when the power is turned off.) (In some HMI models, the users 
can save data in USB Disk or SMC card when the power is turned off 
and the capacity for saving alarm data depends on the capacity of USB 
Disk or SMC card.) 

The users can double click a row of the alarm message contents table to 
edit the alarm property.  
(Please notice that there are three languages tabs in Alarm Setup 
dialog box as multi-language function is also supported here. The 
users can click the tab to edit the alarm message contents 
according to the users’ requirement.) 

 
The following Alarm Property Setup dialog box will display after double 
clicking the row. 

 

Message Display message when an alarm occurs. 

Alarm Setting 

Alarm Property 
Setup  

Color Display message color when an alarm occurs. 
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Alarm Setup Dialog Box 

Trigger 
Mode 

Use this option to determine the Bit is On or Off when an 
alarm occurs. 

Screen Display screen when an alarm occurs.  

Delete Delete the alarm message contents. 

Modify Modify the alarm message contents. The users also can double click the 
mouse to perform this function. 

Import Import the Alarm Describe File into the alarm message contents table. 

Export Export the alarm message contents from HMI and convert them to be 
Alarm Describe . 

 

Close Exit the Alarm Setup dialog box. 

Enable It is used to enable the alarm moving sign. 

Position It is used to determine the display position of alarm moving sign. It can 
be Top or Bottom. 

Left Alarm message will move from right to left (Move to left). 

Right Alarm message will move from left to right (Move to right). 

Up Alarm message will move from bottom to top (Move to Up). 

Direction 

Down Alarm message will move from top to bottom (Move to Down). 

Moving points It is used to set the moving points every time for the alarm moving sign. 
The unit is Pixel and the range is within 1 ~ 50 points. 

Interval (ms) It is used to set the interval time every time for the alarm moving sign. 
The unit is ms and the range is within 50 ~ 3000 ms. 

Alarm Moving 
Sign 

Background 
Color 

It is used to set the background color of the alarm moving sign. 
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 History Setup 

 History Setup should be used with sampling elements. Please refer to 
Chapter 3 for more detailed information. 

 

Fig. 2.9.5 Choosing History Setup command from menu bar 
 

Table 2.9.7 History Setup Settings 

History Setup Dialog Box 
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History Setup Dialog Box 

Pressing Append button can add a history data. Max. 12 history data can be added. After the 
Append button is pressed, the following Buffer Properties dialog box will display. 

 

Read Address It is used to set the starting address for sampling the history data. 

Data Length 
(Word) 

It is used to set how much Word the users want to sample? The range is 
within 1 ~ 13 continuous Words. It indicates that max. 13 continuous words 
can be sampled. 

Cycle (ms) It is used to set the sampling cycle time for reading address (how long is it to 
read address one time). If the Trigger option is PLC, this option will be 
ineffective. The range of the sampling cycle time is within 0 ~ 86400000 ms.

Sample Number This option is used with the Auto Stop option. If the Auto Stop option is 
selected, HMI will stop recording the data after the numbers of records have 
reached the setting value of Sample Number option. If the Auto Stop option 
is not selected, when record number of data exceeds the setting value of 
Sample Number option, it will delete the first record and insert the new 
record into the last address. For example, if the setting value is set to 100 
and the number of records in history exceeds 100, the first record will be 
deleted and the second record will become to the third record, the third 
record will become to the forth record…and the 100th record will become to 
99th record. Therefore, the new record (101st record) will become to 100th 
record. 

Stamp Time and 
Date 

Use this option to determine if the time and date are also recorded during 
sampling operation. 

Auto Stop Use this option to determine if HMI stop recording when the max. number of 
record data is reached. 

Non-Volatile Using this option can enable to save sampling data in SRAM when the 
power is turned off. The capacity for saving history data of DOP-A series is 
240MBytes and DOP-AE series is 360MBytes. (The power of SRAM is 
battery when the power is turned off.) (In some HMI models, the users can 
save data in USB Disk or SMC card when the power is turned off and the 
capacity for saving history data depends on the capacity of USB Disk or 
SMC card.)  

Trigger There are Timer and PLC two options. 

Append 

OK / Cancel Press OK button to save the data and exit. Press Cancel to exit without 
saving data.  

Delete Pressing Delete button can delete a history data.  

Modify Pressing Modify button can modify a history data.  
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 Tag Table 

 It is used to replace the specific address with the user-defined words or 
characters. For example, if the users want to replace PLC address 
1@Y0 with the word “OS”, just define it in Tag Table option in advance. 

  

Fig. 2.9.6 Choosing Tag Table command from menu bar 

 

Table 2.9.8 Tag Table Settings 

Tag Table Dialog Box 

 
Open Open a Tag File and import it into HMI. 

Save Save the settings or changes made in Tag Table dialog box as a Tag File. 
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Tag Table Dialog Box 

Add Please select the Tag type first, Internal Memory and Base Port (If the users has three or 
above communication ports, the users will see Link2, Link3 …and vise versa). Then, press 
Add button to add and define Tag data. 

 

Delete The users can use the mouse to select one row of the Tag table, and then press Delete button 
to delete it. 

OK Press OK button to save the settings and exit.  

Cancel Press Cancel to exit without saving.  

 Print Typesetting 

 Provide more efficient print layout management function. Please refer 
to the example below on next page. 

 

Fig. 2.9.7 Choosing Print Typesetting command from menu bar 
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How to Use Print Typesetting Function  

Example:  

Printer and Page Setup 

1. Print Typesetting function only provided in DOP-AE series. 

 

2. Select Printer 

The users can click File > New to get into the New Application tab and select the printer using the 

“Printer” drop-down list in New Application tab. Or click Options > Configuration > Print to select a 

printer.  

 

3. Configuring Print Setup 

The users can click Options > Configuration > Print to enter into “Print” tab. Then, use the Print tab to 

configure the settings of printer, paper, quality and margin, etc. options. 



Chapter 2  Creating and Editing Screens|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   2-137 

 

Create Printing Report  

Step 1:   

Creating a new screen first (Click Screen > New Screen) and set it as Apply Print Screen in Screen 

Properties tab (Click Screen > Screen Properties). For the description of Apply Print Screen function, 

please refer to Table. 2.7.2 Screen Properties setting on page 2-80. 
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Step 2: 

Create the element that the users want to print out. For example, if the users want to print a Historical Trend 

Graph and a X-Y Chart, the users can create a Historical Trend Graph (Click Element > Sampling > 

Historical Trend Graph) and a X-Y Chart (Click Element > Curve > X-Y Chart) first and then set their 

properties in the Property table. The Property table provides element property setting for each element. For 

the information for element property settings for each element, please refer to Chapter 3 for more detailed 

description. 

 

Step 3: 

The users can choose “Yes” or “No” using the “Print Successive Data” drop-down list to determine whether 

Print Successive Data function is selected or not. When “Yes” is selected, it indicates that Print Successive 

Data function is enabled, and all the sampling records and data for the element will be printed out completely.  

Historical Trend 
Graph 

X-Y Chart 
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Print Screen Layout and Output  

Step 1:  

Click Options > Print Typesetting. Then drag the mouse to decide which screen needed to be typeset and 

printed out. The screens on the left side are all created screens and the screens on the right side are the 

selected screens. If a “General View Screen” is dragged to the right side, it will become “Apply Print Screen” 

(Screen Properties) automatically. 
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Step2: 

Right clicking the mouse or use function key to create a “Report List” button on a “General View Screen”. 

Then, use this “Report List” button to enable the print function. 

 

Step 3: 

Set the properties of the “Report List” option. The Report Device can be SMC, USB Disk, and Printer. Please 

notice that if the users select SMC or USB Disk, the data will be outputted to SMC or USB Disk only and it 

will not be printed out.  
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How to Use Hard Copy Function 

The Hard Copy function is available only when the screen is a “General View Screen”. If HMI detects the 

“Print Typesetting” function is already set for the editing screen, the “Hard Copy” function will be ineffective.  

Step1: Set the Hard Copy Region in Screen Properties tab. 

 

Step2: Enable the Print function.  

Right clicking the mouse or use function key to create a “Report List” button on a “General View Screen”. 

Then, use this “Report List” button to enable the print function, just like “Print Typesetting” function. 
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 Picture Bank 

 The users can use this option to import various pictures to rich the 
screens selection and make the Picture Bank to be more plentiful. 
Please Click Options > Picture Bank to execute this function. 

 

Fig. 2.9.8 Choosing Picture Bank command from menu bar 

 

Fig. 2.9.9 Picture Bank 
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Table 2.9.9 Picture Bank Settings 

Picture Bank Browse Dialog Box 

 
Click Picture Bank option to browse all pictures saved in Picture Bank. When one picture is selected, the 
users can see the picture in the preview window. Double left-clicking the mouse on the selected picture 
can display the picture in an actual size view. 

 New Picture Bank  Create a new picture bank. After clicking the icon , the following New 
Picture Bank dialog box will display on the screen. 

 

 Open Picture Bank Open a picture bank file (*.pib file). 

 Uninstall Picture Bank 
Uninstall the selected picture bank. The uninstall picture bank will be 
moved to Recycle Bin.  

 Save Save the modified picture into the picture bank. 
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Picture Bank Browse Dialog Box 

Import Picture Import pictures into the designated picture bank. 

 
The formats of the pictures in the picture bank can be BMP, JPG, 
GIF(static) and ICON pictures. When selecting this function, the dialog box 
shown above will display. Then, the users can convert the picture color in 
advance to speed the compile time or choose “No changed” option to 
remain the original color. 

 Export Export pictures in BMP format from the picture bank.  

 Delete Delete pictures in the picture bank.  

 Inverse Inverse the picture color. Negative 
effect. 

 

 Grayscale Convert the colorful picture to 256 
grayscale color. 

 

 Horizontal Mirror  Horizontal mirror effect.  
 

 Vertical Mirror Vertical mirror effect. Vertical mirror effect 

Inverse effect 

Horizontal mirror effect 

Grayscale effect 
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Picture Bank Browse Dialog Box 

Shortcut Menu 
 

The users can right-click the mouse to display a shortcut menu shown on 
the figure below. This shortcut menu is a menu that shows a list of 
commands relevant to picture bank option for the users to manage the 
pictures in the picture bank more quickly and efficiently. 

 

 Text Bank 

 Input common or frequently used text and terms into Text Bank. The 
users can select the text from the Text Bank and enter them on the 
element more easily and quickly if necessary. 

 

Fig. 2.9.10 Choosing Text Bank command from menu bar 
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Table 2.9.10 Text Bank Settings 

Text Bank Dialog Box 

 
Append Press Append button to add the text into Text Bank. The multi-language editing is supported in 

Text Bank option. The users can input the text or terms in different language and saved them 
in Text Bank. The multi-language font can also be set simultaneously.  

Delete Press Delete button to remove the input text or terms in Text Bank.  

Open Press Open button to open and import the text or terms into Text Bank. 

Save Press Save button to save and export the text file. 

Close Close and exit the text bank dialog box. 
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 Submarro 

 Use this option to edit sub-macro and be called by other Macro. For the 
Macro function, please refer to Chapter 4 for more details.  

 

Fig. 2.9.11 Choosing Submacro command from menu bar 

 

Fig. 2.9.12 Submarco dialog box 
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 Initial Macro 

 Use this option to edit initial macro. The initial macro will be executed 
automatically after the power is applied to HMI (power on). For the 
Macro function, please refer to Chapter 4 for more details. 

 

Fig. 2.9.13 Choosing Initial Macro command from menu bar 
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 Background Macro 

 Use this option to edit background macro. For the Macro function, 
please refer to Chapter 4 for more details. 

 

Fig. 2.9.14 Choosing Background Macro command from menu bar 
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 Clock Macro 

 Use this option to edit clock macro. After HMI is turned power on and 
starting initial setup, the clock macro will be executed automatically by 
clock setting time. For the Macro function, please refer to Chapter 4 for 
more details. 

 

Fig. 2.9.15 Choosing Clock Macro command from menu bar 
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 Environment 

 Use this option to complete the environment settings of Screen Editor.

 

Fig. 2.9.16 Choosing Environment command from menu bar 
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Table 2.9.11 Environment Settings 

Environment Dialog Box 

 
System Path This is used to set the location where ScrEdit save the system files, including some 

system reference data and dynamic link library (*.dll) files. In order to avoid the system 
error and failure to find the file, we recommend the users not to change this setting if not 
necessary. (This option by system default is disabled.) 

Output Path This is used to set the location where ScrEdit save the output file after compile 
operation. Some functions, such as on-line simulation, off-line simulation, file download 
and upload all refer to the files in this location.  

ToolBars/Windows It is used to set if toolbars or ducking windows display or not 
display on the screen. 

Language The users choose English, Traditional Chinese and Simplified 
Chinese from the “Language” drop-down list.  

Upload/Download It is used to determine the communication interface for upload and 
download. It can be USB or PC COM Port. 

Auto Saving… Time 
Interval 

It is used to have ScrEdit automatically save the file every 
specified number of minutes. The unit is M(minute) and the setting 
range is within 0M ~ 120M.  

Options 

Auto Open for Next 
Execute Application 

It is used to have ScrEdit automatically open the specified file 
every time the users execute ScrEdit. 
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Environment Dialog Box 

Center Drawing Area When this option is selected, the editing screen will be placed in 
the center position. 

 
Include Picture Data 
For Uploading 

If this option is selected, all pictures will be also uploaded when 
ScrEdit upload function is enabled.  All uploaded pictures will be 
saved in a file named as “_LOCALTEMP01.PIB”. The “Picture Bank 
Name” and the “Picture Name” (set in Property ducking window) 
of the editing elements will refer to and link to this file too. If 
ScrEdit ends the editing abnormally, the file name will be named 
as “_LOCALTEMP02.PIB, _LOCALTEMP03.PIB …”, and vise versa 
when execute uploading next time. The last two numbers at the 
end of the file name will increase progressively. 

Auto Convert Input 
Address To Tag 
Name 

For example, if the users want to replace PLC address 1@Y0 with 
the word “OS”, just define it in Tag Table option in advance. When 
this option is selected, ScrEdit will automatically convert input 
address 1@Y0 to the word “OS”. 

Driver Reinstall HMI USB Drive: Press it to reinstall the HMI USB driver 
Uninstall HMI USB Drive: Press it to uninstall the HMI USB driver 

OK Press OK button to save the modified settings and exit the Environment dialog box. 

Cancel Press Cancel button exit the Environment dialog box without saving. 
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2.10 Menu Bar and Toolbar (Window) 

 Window 

 
Fig. 2.10.1 Window options  

 Close Window 

 It is used to hide the current window, NOT exit the current window. The 
users can execute this function by clicking Window > Close Window 
(Fig. 2.10.2). If the users want to display the hidden window, please 
click Screen > Open Screen (Fig. 2.7.6) to open an old screen. 

 
Fig. 2.10.2 Choosing Close Window command from menu bar 
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 Close All Windows 

 It is used to hide all windows, NOT exit all windows. The users can 
execute this function by clicking Window > Close All Windows (Fig. 
2.10.3). If the users want to display the hidden window, please click 
Screen > Open Screen (Fig. 2.7.6) to open old screens. 

 
Fig. 2.10.3 Choosing Close All Windows command from menu bar 

 
Fig. 2.10.4 Screen status after all windows are closed 
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 Next Window 

 It is used to switch the current window to the next window. If the 
current window is the last window, the current window will not be 
changed even if this function is executed.  

 
Fig. 2.10.5 Choosing Next Window command from menu bar 

 
Fig. 2.10.6 Choosing Next Window icon from toolbar 
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Fig. 2.10.7 Example screen1 for choosing next window (Before switching to next window) 

 
Fig. 2.10.8 Example screen 2 for choosing next window (After clicking “Next Window”) 
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 Previous Window 

 It is used to switch the current window to the previous window. If 
the current window is the first window, the current window will not 
be changed even if this function is executed.  

 
Fig. 2.10.9 Choosing Previous Window command from menu bar 

 
Fig. 2.10.10 Choosing Previous Window icon from toolbar 
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Fig. 2.10.11 Example screen1 for choosing previous window (Before switching to previous window) 

 
Fig. 2.10.12 Example screen 2 for choosing previous window (After clicking “Previous Window”) 
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 Cascade 

 Cascade display. Display all editing windows so that they overlap. 
The title bar of each window is visible but only the top window is fully 
visible. The users can execute this function by clicking Window > 
Cascade (Fig. 2.10.13). The opened windows are displayed in an 
overlapped pattern as shown as Fig. 2.10.14. 

 
Fig. 2.10.13 Choosing Cascade command from menu bar 

 
Fig. 2.10.14 Screen display after choosing Cascade command 
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 Title Horizontal 

 Display all editing windows from top to bottom. The users can 
execute this function by clicking Window > Title Horizontal (Fig. 
2.10.15). The opened windows are displayed horizontally as shown 
as Fig. 2.10.16. 

 
Fig. 2.10.15 Choosing Title Horizontal command from menu bar 

 
Fig. 2.10.16 Screen display after choosing Title Horizontal command 
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 Title Vertical 

 Display all editing windows from left to right. The users can execute 
this function by clicking Window > Title Vertical (Fig. 2.10.17). The 
opened windows are displayed vertically as shown as Fig. 2.10.18. 

 
Fig. 2.10.17 Choosing Title Vertical command from menu bar 

 
Fig. 2.10.18 Screen display after choosing Title Vertical command 
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 Window Summary 

ScrEdit shows a list of all opened screens at the bottom of “Window” pull-down menu for quick access. 
Just click the file name to open the file and view the screen directly. 

 
Fig. 2.10.19 Window Summary 

 
Fig. 2.10.20 Choosing Screen 2 from Window menu bar 
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Fig. 2.10.21 Switching to Screen 2 

2.11 Menu Bar and Toolbar (Help) 

 Help 

 
Fig. 2.11.1 Help option 

 About ScrEdit 

 Display the version information of Screen Editor. 

 
Fig. 2.11.2 Screen Editor Version 
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Chapter 3  Element Function 

In order to meet different applications and requirements, ScrEdit provides various elements for the users to 

use and design. Before using and designing these elements, please read this chapter first to understand how 

to choose an element and the special function of each element in ScrEdit. 

3.1 How to Choose Element 

There are three methods for choosing elements when editing the screens: 

1. Right-click the mouse in the work place and a shortcut menu will display as Fig. 3.1.1.  The users can 

choose the desired elements by the mouse. 

2. Choose Element command from menu bar as Fig. 3.1.2.  

3. Choose Element icon from toolbar as Fig. 3.1.3. 

 
Fig. 3.1.1 Shortcut menu display 
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Fig. 3.1.2 Choosing Element command from menu bar 

 
Fig. 3.1.3 Choosing Element icon from toolbar 

After selecting an element, left-click and drag the mouse on work place to create an new element as shown 

in the following Fig. 3.1.4.  
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Fig. 3.1.4 Creating an element by the mouse 



Chapter 3  Element Function|ScrEdit Software User Manual 

3-4   Revision 05/30/2006, EH00 

3.2 Button Element 

 
Fig. 3.2.1 Button element options 

 

Table 3.2.1 Button elements 

Button Type Macro Read Write Function 

Set ON Yes Yes After pressing this button, the state of the setting address 
(Bit) will be set to ON. The state of the setting address will be 
always ON even if the users release the button or press it 
again. If there is an ON Macro, it will be executed 
simultaneously.  

Reset OFF Yes Yes After pressing this button, the state of the setting address 
(Bit) will be set to OFF. The state of the setting address will 
be always OFF even if the users release the button or press 
it again. If there is an OFF Macro, it will be executed 
simultaneously.  

Momentary ON 
OFF 

Yes Yes After pressing this button, the state of the setting address 
(Bit) will be set to ON and execute ON Macro at the same 
time. The state of the setting address will be ON when 
releasing the button and be OFF when pressing it again. If 
the users execute OFF Macro simultaneously, it will still be 
OFF when releasing the button.  

Maintained ON 
OFF 

Yes Yes After pressing this button, the state of the setting address 
(Bit) will be set to ON. The state of the setting address will be 
OFF when releasing the button. If there is ON / OFF Macro, it 
will be executed simultaneously. 

Multistate  No Yes Yes There are 1~256 user-defined multi-states for setting. The 
users can set the execution sequence to the next state or the 
previous state. If the users set to the next state, the state will 
become state 2. If the users set to the previous state, the 
state 2 will become state 1. 

Set Value No No Yes After pressing this button, the “Numeric keypad” dialog box 
will pop up on HMI screen for the users to input the setting 
value directly. After inputting the setting value and pressing 
ENTER key, HMI will transmit the input value to the setting 
address. 

Set Constant  No No Yes After pressing this button, HMI will write the specific value 
into the setting address.  
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Button Type Macro Read Write Function 

Increment  No Yes Yes After pressing this button, HMI will add up the value 
contained within the setting address and the setting constant 
value, and store the addition result back into the setting 
address.  

Decrement  No Yes Yes After pressing this button, HMI will subtract the setting 
constant value from the value contained within the setting 
address, and store the subtraction result back to the setting 
address.  

Goto Screen No No No After pressing this button, it will switch to the screen that the 
users designated. 

Previous Page No No No After pressing this button, it will go back to the previous main 
screen. 

 General Buttons 

After pressing these buttons, HMI will transmit ON/OFF signal to PLC. There are four types of these buttons: 

Set button, Reset button, Momentary and Maintained buttons. Please refer to the following Table 3.2.2 for 

the property description of general buttons.  

Table 3.2.2 Property description of general buttons 

Property Description of General Buttons  

Pressing  button next to the “Write Address” or “Read Address” can enter into 
the following “Input” dialog box and select the write address or the read address. 

 
The link type can be Base Port or Internal Memory. If the users connecting to multi 
connections, the new connections will be also added into the “Link” drop-down list. 
After selecting the Link option and Device Type, and input correct address, then 
press Enter key, the corresponding numeric value will be recorded on the element 
that the users selected. Device types are described as follows: 

$ Internal Register 
(SDRAM) 

RCP Receipt register 

$M Non-volatile Internal 
Register (SRAM) 

RCPNO Receipt Number Register 

Write Address 
Read Address 

*$ Indirect Address 
Register (SDRAM) 

Other Other device name supported by other 
brands PLC. Please refer to the user 
manual of the PLC. 
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Property Description of General Buttons  

Edit On/Off Macro Edit On and Off Macro. For the Macro function, please refer to Chapter 4 for more 
details. 

Text 
Text Size 
Font 
Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. When the users press 

 button next to “Font”, the following “Font Detail Setting” dialog box will display.

 
In “Font Detail Setting” dialog box, the users can select Font Name, Font Size and 
Ratio of the text and view the text format from the Preview window in advance. If 
the multi-language function is used, the users can see different language tabs and 
edit different language font setting in “Font Detail Setting” dialog box. Please refer 
to the example figure above.  

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users. 

The users can determine the picture of the element by clicking “Picture Bank 
Name”. (If “Picture Bank Name” has been selected, the users can click “Picture 
Name” to determine the picture of the element). The following dialog box will 
display when the users select the existed Picture Bank Name from the drop-down 
list.  

 
In this dialog box, the users can double click the mouse to select an element. The 
users can also press Shift and left key of the mouse to import several pictures into 
the designated element at the same time. The selected several pictures will be 
stored in each state of the element in order. If the number of the selected pictures 
is more than the number of the element state, only the pictures to the number of 
the element state will be imported and the remainder will be ignored and not be 
imported into the element.  

Picture Bank Name 
Picture Name 

Import From File Press this button to import the pictures directly. The users do 
not need to exit the dialog box and click “Option” > “Picture 
Bank” command again.  
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Property Description of General Buttons  

Use sucker tool  to suck the color of the picture and determine the transparent 
color of the picture. The effect on the element before and after this action happens 
is shown as the figures below. 
Please check whether the color of the selected element is 16M bits (65536) colors 
or not. This function is invalid and a warning message dialog box may display if the 
users apply this function on the 16M bits (65536) colors element (created on the 
screen of DOP-AE series HMI) in 256 colors editing environment (on the screen of 
DOP-A series HMI). If the element is converted in 256 colors after import action, 
we recommend the users to choose the transparent color by clicking the mouse, 
not using drop-down list. There are only 144 colors available in the drop-down list. 
The users can select the colors from the drop-down list to specify the transparent 
color but there may be chromatic aberration from our visual experience.  
For example, RGB(0,0,0) is black color, but RGB(1,1,1) is also black color. 
However, the element color is RGB(0,1,0) and it is also black color visually. 

The effect before this action happens The effect after this action happens 

Transparent Effect 
Transparent Color 

  
Standard Raised Round Invisible 

   

Foreground Color 
Style 

The users can specify the button style and foreground color as the figures above 
by using this option.  

Function The users can modify the element characteristic directly without re-create a new 
element. The elements that their characteristics can be modified directly by using 
this option are: Set button, Reset button, Momentary button and Maintained 
button these four kinds of buttons.  

Push Time (second) Use this option to set the active time of the button. When this option is set, the 
button will be active after pressing the button longer than the setting time. Using 
this option can avoid malfunction. The range is within 0 ~ 10 seconds.  

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

Set Low Security Use this option to force the current priority to be the lowest after the button is 
pressed. This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled.   

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed.  

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed.  
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Example of Button Elements:  

   
Fig. 3.2.2 Example of Button elements 

 Multistate Buttons 

Table 3.2.3 Property description of Multistate buttons 

Property Description of Multistate Buttons 

The state number will be different by the unit. There are 1-256 states if its unit is WORD, 16 states if its unit 
is LSB and 2 states if its unit is Bit. The unit of read/write address will be different by the value unit. If the 
value unit is WORD or LSB, the unit of read/write address will be WORD. If the value unit is Bit, the unit of 
read/write address will be Bit. After obtaining the data from the read address, it will increase or decrease 
gradually according to the next state or previous state and write the new value to the write address. The 
state change of this button depends on the read address. If it is needed to add or delete the total state 
numbers, only add or delete the state numbers in element property table. 

Write Address 
Read Address 

It is used to set the read and write address. The link type can be Base Port or 
Internal Memory. (Please refer to Table 3.2.2 Property Description of General 
Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users.

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Push Time (second) Use this option to set the active time of the button. When this option is set, the 
button will be active after pressing the button longer than the setting time. Using 
this option can avoid malfunction. The range is within 0 ~ 10 seconds.  

Bit Multistate button can have two states. 

Word Multistate button can have 256 states. 

Data Length 

LSB Multistate button can have 16 states.  

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 



Chapter 3  Element Function|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   3-9 

Property Description of Multistate Buttons 

Add/Remove State It is used to set the state number of multistate button. There are 1-256 states can 
be set if its unit is WORD, 16 states can be set if its unit is LSB and 2 states can be 
set if its unit is Bit.  

Sequence It is used to switch the sequence of multistate state (previous state/next state). 

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

Set Low Security Use this option to force the current priority to be the lowest after the button is 
pressed. This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled.   

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed.  

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed.  

Example of Multistate Buttons:  

When the data length is LSB (D100.0-D100.1～D100.3-D100.4): 

                     

S0=D100.0 ON   S1=D100.1 ON   S2=D100.2 ON   S3=D100.3 ON   S4=D100.4 ON 

 

Y1         Y2        Y3         Y4        Y5        Y6         Y7          MULTI-VALVE 

Fig. 3.2.3 Multistate buttons display 

 Set Value Button 

Table 3.2.4 Property description of Set Value buttons 

Property Description of Set Value Buttons 

After pressing this button on the screen, a system built-in numeric keypad (TEN-KEY) will show up and the 
users can use it to input the setting value directly. When pressing ENTER key, HMI will send the input 
setting value to PLC corresponding register. The maximum and minimum input setting values are all user-
defined. The users can also specify the trigger mode to trigger the designated PLC address before or after 
writing the setting value.  

Write Address It is used to set the write address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 
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Property Description of Set Value Buttons 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON 
before or after writing the setting value. Note: this function can only trigger PLC 
address to be ON. If the PLC address needs to be triggered again, the users 
should set the address to be OFF by themselves. 

 
Data Length There are 16bits Word and 32bits Double Word two options. 

It provides different kinds of data format for different data length: 

Word Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 

Minimum 

Maximum 

The users can set the minimum and maximum of input setting value 
to determine the range of input setting value. 

Integral Digits 

Fractional 

Use this option to determine the digit number of integer and decimal 
fraction. The digit number is not a real digit number value. It is only 
the display format. The digit number will be a real decimal number 
only when the data format is selected as “Floating”.  

Detail Range Setup 

When the users have input the minimum and maximum value, after pressing OK 
button, HMI will examine the value by referring to the selected data length, data 
format, integral and fractional digits. 

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

Set Low Security Use this option to force the current priority to be the lowest after the button is 
pressed. This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled.   
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Property Description of Set Value Buttons 

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed.  

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed.  

Example of Set Value Button:  

Press Set Value button and the Numeric keypad (TEN-KEY) dialog box will display on the screen. The 

users can input a value and write it into the PLC corresponding register M100.  

 

 
Fig. 3.2.4 Numeric keypad (TEN-KEY) dialog box 

 Set Constant Button 

Table 3.2.5 Property description of Set Constant buttons 

Property Description of Set Constant Buttons 

After pressing this button on the screen, HMI will send the specified constant value to PLC corresponding 
register. It has the same function as Set Value button. The users can also specify the trigger mode to trigger 
the designated PLC address before or after writing the setting value.  

Write Address It is used to set the write address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 
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Property Description of Set Constant Buttons 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON 
before or after writing the setting value. Note: this function can only trigger PLC 
address to be ON. If the PLC address needs to be triggered again, the users 
should set the address to be OFF by themselves. 

 
Data Length There are 16bits Word and 32bits Double Word two options. 

There are following data format provided: 

Word/Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Detail Range Setup 

Value It is used to enter the constant value that the users want to write. 
After pressing OK button, HMI will examine the value by referring to 
the selected data length and data format. 

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

Set Low Security Use this option to force the current priority to be the lowest after the button is 
pressed. This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled.   

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed.  

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed.  

Example of Set Constant buttons:  

After pressing the Set Constant button, HMI will transmit the constant value to PLC corresponding 

register D1000. 
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Fig. 3.2.5 Example of Set Constant buttons 

 

 Increment / Decrement 

Table 3.2.6 Property description of Increment / Decrement buttons 

Property Description of Increment / Decrement Buttons 

After pressing this button on the screen, HMI will read the value from PLC and add or subtract the set 
constant value. Then, write the result into PLC corresponding register. If the addition or subtraction result 
exceeds the limit (minimum and maximum) set in HMI, HMI will save the limit value (minimum and 
maximum) into the PLC corresponding address. 

Write Address 
Read Address 

It is used to set the read and write address. The link type can be Base Port or 
Internal Memory. (Please refer to Table 3.2.2 Property Description of General 
Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Function The users can modify the element characteristic directly without re-create a new 
element. The elements that their characteristics can be modified directly by using 
this option are: Increment button and Decrement button. 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON 
before or after writing the setting value. Note: this function can only trigger PLC 
address to be ON. If the PLC address needs to be triggered again, the users 
should set the address to be OFF by themselves. 
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Property Description of Increment / Decrement Buttons 

 
Data Length There are 16bits Word and 32bits Double Word two options. 

There are following data format provided: 

Word/Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Jog Step It is used to set the increasing and decreasing value when pressing 
the Increment and Decrement button every time. 

Detail Range Setup 

Limit It is used to set the limit of the increment and decrement value. 
After pressing OK button, HMI will examine the input increment & 
decrement value and limit value also by referring to the selected 
data length and data format.  

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

Set Low Security Use this option to force the current priority to be the lowest after the button is 
pressed. This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled. 

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed. 

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed. 

Example of Increment / Decrement Buttons: 

Adjust D1000 value by pressing buttons +/-. 

 
Fig. 3.2.6 Example of Increment / Decrement buttons 



Chapter 3  Element Function|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   3-15 

 Goto Screen / Previous Page (Previous View) Buttons 

Table 3.2.7 Property description of Goto Screen / Previous Page (Previous View) buttons 

Property Description of Goto Screen / Previous Page (Previous View) Buttons  

There are three kinds of selection for switching screens: 
1. Goto screen: press this button on the screen and HMI can go to a specific screen. 
2. Previous page: press this button on the screen and HMI can switch to the previous screen. 
3. Previous view: press this button on the screen and HMI can switch to previous view, just like Back 

command in Windows® Explorer Browse. 

   
The above example screens describe the operation of previous page button. In screen 1, if press “Goto 2” 
button, HMI will switch to the screen 2. If press “Goto 3” button on screen 2, HMI will switch to screen 3. 
Then, if press previous page button on screen 3, HMI will return to screen 2. If press previous page button 
on screen 2, HMI will switch to screen. (Note: however, if the function of the button created on screen 2 is 
“previous view”, not “previous page”, when press “previous view” button on screen 2, HMI will switch to 
screen 3, not screen 1 and this is just the difference between “Previous page” and “Previous view”.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Function The users can modify the element characteristic directly without re-create a new 
element. The elements that their characteristics can be modified directly by using 
this option are: Goto button, Previous page and Previous view buttons. 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON 
before or after writing the setting value. Note: this function can only trigger PLC 
address to be ON. If the PLC address needs to be triggered again, the users 
should set the address to be OFF by themselves. 

This dialog box will pop up only when the button function is “Goto screen”. 

 

Detail 

Close Sub-
Screen 

When this option is selected, it indicates that this Goto screen 
button is only valid in Sub-Screen. When pressing this button, the 
current (active) sub screen will be closed.  
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Property Description of Goto Screen / Previous Page (Previous View) Buttons  

User’s security 
level will be set 
to Low Security 
after changing 
screen. 

When this option is selected, it will force the current user’s priority 
to be the lowest after the button is pressed. This can prevent the 
misoperation made by the users (operators). 

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

Goto Screen When clicking this option, the following dialog box will pop up: 

 
In this “Open Screen” dialog box, the users can select the desired screen from left 
side and the preview screen will display on the right side. After selecting the screen 
and pressing OK button, HMI will record the designated screen to this Goto button 
element.  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled. 

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed. 

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed. 

Example of Goto Screen buttons:  

Use different screen buttons to switch to the designated screen 
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Fig. 3.2.7 Example of Goto Screen buttons 

 

 System Function Button 

 
Fig. 3.2.5 System function button options 

Table 3.2.8 System function buttons 

Button Type Macro Read Write Function 

System Date Time No No No It is used to set HMI system time and date (year-month-day, 
hours:minutes:seconds) 

Password Table 
Setup No No No It is used to set all password priority. 

Enter Password No No No HMI provides passwords function. 

Contrast 
Brightness No No No It is used to adjust HMI contrast and brightness. 

Low Security No No No After pressing this button, HMI will set the password to the 
lowest level (Level is 0). 

System Menu No No No After pressing this button, HMI will change screen to system 
menu.  

Report List No No No After pressing this button, HMI will output the screen data to 
the specific device. It is usually used with print function.  
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For the property description of system function buttons, please refer to the following Table 3.2.9: 

Table 3.2.9 System function buttons 

Property Description of System Function Buttons 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

The users can modify the element characteristic directly without re-create a new 
element. The elements that their characteristics can be modified directly by using 
this option are the following items: 

System Date & 
Time 

Use this option to set the system date and time of HMI. The 
users only need to press SYS button on HMI panel to enter HMI
system setting screen and edit the date & time as the figure 
below. 

 

Function 

Password Table 
Setup 

After selecting this option, determine the open level according 
to the User Security Level in property table. After downloading 
screen data to HMI, if the user security level is lower than the 
setting level, this “Password Table” will not be opened and only 
the “Password Keypad” dialog box will display. Password Table 
can be opened or not depends on whether the user security is 
higher than the setting level or not. Even though the users can 
open Password Table, it only indicates that the users can 
change the password that level is lower than the users’. The 
users still cannot change or view those passwords that are 
higher than the users’. 

         
Maximum Priority                       Password 5 Levels 
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Property Description of System Function Buttons 

Enter Password This button provides HMI a password input interface. It will 
open the corresponding priority by the inpuy password. The 
higher level the users input, the higher priority the users have. 

 
Contrast 
Brightness 

This button provides the users to adjust HMI LCD contrast and 
brightness settings. After pressing this button, the users will get 
the following pop-up window to adjust HMI LCD contrast and 
brightness settings. If the users press “Set for default Contrast” 
button, it will set HMI LCD to the default settings. 

 
Low Security Using this button can set the user priority to the lowest (Level 

0). This option makes the user priority level become the lowest 
to protect control system parameter not to be modified when 
the users exit the different screens. It can also avoid the 
misoperation that may cause system error. (This function is 
also provided for Goto screen button.)  

System Menu After pressing this button, HMI will be back to system menu 
screen. The users can return to operation screen just by 
activating “Run” function or startup HMI again. 

Report List This button has many functions. It can be used flexibly 
depending on the properties of the “Report List” option (Please 
refer to page 2-124 in Chapter 2 and the following description of 
Report Device). 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON 
before or after writing the setting value. Note: this function can only trigger PLC 
address to be ON. If the PLC address needs to be triggered again, the users 
should set the address to be OFF by themselves. 

This option is provided in Report List button only. When the users select a Report 
List button, the users can set this option in the property table. 

 
The Report Device window is shown as the figure above. The Report Device can 
be SMC, USB Disk, and Printer. Please note that USB Disk and Printer are 
provided in DOP-AE series HMI only.  
SMC Output the history records and alarm data to SMC card. 

Report Device 

USB Disk Output the history records and alarm data to USB Disk. 
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Property Description of System Function Buttons 

Printer HMI will check if Print Typesetting function is set or not first. If Print 
Typesetting function is set already, the screen data will be output to 
the printer directly. If HMI detects the Print Typesetting function is not 
set yet, the Hard Copy function will be enabled.  

User Security Level Use this option to set the user priority for pressing this element. Only the priority 
that is higher than the current setting can use this element.  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled. 

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed. 

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed. 

Example of System Function Buttons: 

 

 
Fig. 3.2.8 HMI System Menu Screens 
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3.3 Meter Element 

 
Fig. 3.3.1 Meter element options 

 

Table 3.3.1 Property Description of Meter Element 

Property Description of Meter Element 

The users can set meter appearance in the property table, such as the style, the color (including border 
color, background color, stitch color, scale color) and the scale region number, etc. Also, the max. & min. 
value and high & low limit can be defined in Detail Setup dialog box. It can be used to calculate the specified 
address and measure if it exceeds the limit or not. The users can also use various colors to show clearly and 
this is convenience for the users to recognize. 

Read Address It is used to set the read address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color It is used to set the border color of meter element.  

Background Color It is used to set the background color of meter element. 

Standard Raised Sunken Style 

   
Data 
Length 

There are 16bits Word and 32bits 
Double Word two options. 

Data 
Format 

There are following data format 
provided: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
 

Minimum Value 

Detail Setup 

Maximum Value 

It is used to set the display minimum and maximum value. 
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Property Description of Meter Element 

Target 
Value 
Color 

The users can decide if the target value display or not by using 
this option. If this option is set, the target value and its color set 
by the users will display just like the figure shown below: (Here 
we set the target value is 60 and its color is in blue.) 

 
Ranges (Enable 
range setting)  

Please refer to the description of Low & High Region Color. 

Variable 
target/range limits 

When the target value and low & high limit is a variable value, 
the low limit address is Read Address+1, the high limit address 
is Read Address+2 and the address of target value is Read 
Address+3.  

Integral Digits 

Fractional Digits 

Use this option to determine the digit number of integer and 
decimal fraction. The digit number is not a real digit number 
value. It is only the display format. 

When the users have input the target value, minimum and maximum value, after 
pressing OK button, HMI will examine the value by referring to the selected data 
length, data format, integral and fractional digits.  

Low Region Color 
High Region Color 

This option is available and displayed in the property table only when the “Ranges” 
option in the Detail Setup dialog box is selected. If the users set the low limit value is 
30 and the color of low limit region is in green, and then set the high limit value is 70 
and the color of high limit region is in red, the meter element will be shown as the 
figure below:  

 
Stitch Color It is used to set the stitch color of the meter element. 

Scale Color It is used to set the scale color of the meter element. 

Scale Region Number 
It is used to set the scale region number of the meter element. The users can use 
the up or down buttons to increase or decrease the scale region number. The setting 
rang is within 1 ~ 10.  

Example of Meter Element: 

 
Fig. 3.2.9 Example of Meter element 
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3.4 Bar Element 

 
Fig. 3.4.1 Bar element options 

 

Table 3.4.1 Property Description of Bar Element 

Property Description of Normal Bar Element 
HMI reads the value of the corresponding PLC specific address  (register) and converts the value to normal 
bar element and then displays it on the screen.  
Read Address It is used to set the read address. The link type can be Base Port or Internal 

Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color It is used to set the border color of the normal bar element.  

Foreground Color 
Background Color 

It is used to set the foreground and background color of the normal bar element. For 
example, the foreground color of the following example bar element is green and its 
background color is yellow. 

 
Standard Raised Sunken Style 

   

Left The display progressing direction is from right to the left. 

Right The display progressing direction is from left to the right. 

Top The display progressing direction is from bottom to the top. 

Display Format 

Botom The display progressing direction is from top to the bottom. 
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Property Description of Normal Bar Element 

Data 
Length 

There are 16bits Word and 32bits 
Double Word two options. 

Data 
Format 

There are following data format 
provided: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
 

Minimum Value 

Maximum Value 

It is used to set the display minimum and maximum value. 

Target 
Value 
Color 

The users can decide if the target value display or not by using 
this option. If this option is set, the target value and its color set 
by the users will display on the screen. HMI will refer to the 
minimum and maximum value and draw the proper reference 
line on the bar element just like the figure shown below: (Here 
we set the target value is 50 and its color is in red. The 
maximum and minimum value is 100 and 0 respectively.) 

 
Ranges (Enable 
range setting)  

Please refer to the description of Low & High Region Color. 

Variable 
target/range limits 

When the target value and low & high limit is a variable value, 
the low limit address is Read Address+1, the high limit address 
is Read Address+2 and the address of target value is Read 
Address+3.  

Detail 

When the users have input the target value, low & high limit, and minimum & 
maximum value, after pressing OK button, HMI will examine the value by referring to 
the selected data length and data format. 

Low Region Color 
High Region Color 

This option is available and displayed in the property table only when the “Ranges” 
option in the Detail dialog box is selected. If the users set the low limit value is 30 
and the color of low limit region is in green, and then set the high limit value is 70 
and the color of high limit region is in red, the bar element will be shown as the 
figures below (The min. & max. input value is 0 and 100 respectively.):  

           
When the value is 20      When the value is 50      When the value is 80 
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Table 3.4.1 Property Description of Bar Element 

Property Description of Deviation Bar Element 
HMI reads the value of the corresponding PLC specific address (register). Subtract the setting standard 
value from this read value and the users have a deviation value. Then, the users can convert the deviation 
value to deviation bar element and then display it on the screen. 
Read Address It is used to set the read address. The link type can be Base Port or Internal 

Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color It is used to set the border color of the deviation bar element.  

Foreground Color 
Background Color 

It is used to set the foreground and background color of the deviation bar element. 
For example, the foreground color of the following example bar element is green and 
its background color is yellow. 

 
Standard Raised Sunken Style 

   

Horizontal The deviation value display horizontally.  Display Format 

Vertical The deviation value display vertically.  

Data 
Length 

There are 16bits Word and 32bits 
Double Word two options. 

Data 
Format 

There are following data format 
provided: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
 

Standard Value It is used to set the standard value for calculating deviation 
value. 

Minimum Value 

Maximum Value 

The minimum and maximum value in the deviation bar element.

Display Deviation 
Limit 

The deviation limit and color can be set only when this option is 
selected. Also, the deviation value will display in the designated 
color set by the users. If this option is not selected, the 
deviation value will be displayed in the foreground color directly 
on the screen.  

Detail 

Variable Standard 
Value/Deviation 
Limit 

When standard value and high limit of deviation value is 
variable. The address of standard value is Read Address+1 
and the address of deviation limit value is Read Address+2.  
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Property Description of Deviation Bar Element 

When the users have input the standard value, minimum & maximum value and 
deviation limit, after pressing OK button, HMI will examine the value by referring to 
the selected data length and data format. 

For example, if the data length is set to Word, the data format is set to Unsigned 
Decimal, standard value is set to 50, minimum value is set to 0, maximum value is 
set to 100 and deviation limit is set to 20, the deviation bar element will be shown as 
the figures below: 

          
When the value is 10      When the value is 20   

         
When the value is 70      When the value is 90 

Example of Deviation Bar Element: 

 
Fig. 3.4.2 Example of Deviation bar element 

 

Read: D1000, use the deviation bar element to display the value of PLC corresponding register=Dn 

 



Chapter 3  Element Function|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   3-27 

3.5 Pipe Element 

 
Fig. 3.5.1 Pipe element options 

 

Table 3.5.1 Property Description of Pipe Element 

Property Description of Pipe (1) / Pipe (2) Element 
HMI reads the value of the corresponding PLC specific address (register). Then, convert the value to Pipe 
(1) / Pipe (2) element and then display it on the screen.  
Read Address It is used to set the read address. The link type can be Base Port or Internal 

Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

WaterMark Color 
Inside Tube Color 

It is used to set the watermark color and inside tube color  of Pipe (1) and Pipe (2) 
element. 

Pipe (1) Element                                       Pipe (2) Element 

                                                  
The watermark color is in blue.                      The watermark color is in red. 
The inside tube color is in black.                   The inside tube color is in white. 

Standard Rotation 180 Style 

     
Data 
Length 

There are 16bits Word and 32bits 
Double Word two options. 

Data 
Format 

There are following data format 
provided: 

Word/Double Word 

Detail Setup 

 

 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
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Property Description of Pipe (1) / Pipe (2) Element 

Minimum Value 

Maximum Value 

It is used to set the minimum and maximum capacity of the pipe 
element. 

Target 
Value 
Color 

The users can decide if the target value display or not by using 
this option. 

Ranges (Enable 
range setting)  

Please refer to the description of Low & High Region Color. 

Variable 
target/range limits 

When the target value and low & high limit is a variable value, 
the low limit address is Read Address+1, the high limit address 
is Read Address+2 and the address of target value is Read 
Address+3.  

 

When the users have input the target value, low & high limit, and minimum & 
maximum value, after pressing OK button, HMI will examine the value by referring to 
the selected data length and data format.  

Low Region Color 
High Region Color 

This option is available and displayed in the property table only when the “Ranges” 
option in the Detail Setup dialog box is selected. If the users set the low limit value is 
30 and the color of low limit region is in green, and then set the high limit value is 70 
and the color of high limit region is in red, the pipe element will be shown as the 
figures below (The min. & max. input value is 0 and 100 respectively.): 

                     
  When the value is 20       When the value is 50      When the value is 80 

 

Property Description of Pipe (3) Element 
It is used to connect to several pipes. Pipe (3) element is shown as the figure below: 
 

 
Pipe Gauge Use this option to set the pipe gauge. The selectable range is from 1 ~ 5. The setting 

value 1 represents at least 13 pixels and the setting value 2 represents at least 26 
pixels and vise versa.  
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Property Description of Pipe (4) Element 
It is used to connect to several pipes. Pipe (4) element is shown as the figure below: 
 

 
Standard Rotation 90 Rotation 180 Rotation 270 Style 

 
 

 
 

Pipe Gauge Use this option to set the pipe gauge. The selectable range is from 1 ~ 5. The setting 
value 1 represents at least 13 pixels and the setting value 2 represents at least 26 
pixels and vise versa.  

 

Property Description of Pipe (5) Element 
It is used to connect to several pipes. Pipe (5) element is shown as the figure below: 
 

 
Standard Rotation 90 Rotation 180 Rotation 270 Style 

    
Pipe Gauge Use this option to set the pipe gauge. The selectable range is from 1 ~ 5. The setting 

value 1 represents at least 13 pixels and the setting value 2 represents at least 26 
pixels and vise versa.  

 

Property Description of Pipe (6) / Pipe (7) Element 
Horizontal and vertical pipes. It is used to display the direction of water flow.  

Read Address It is used to set the read address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Mobile Cursor Color When there is any data occurred in the read address, the mobile cursor will display. 
The users can use this option to set the mobile cursor color.  

Pipe Gauge Use this option to set the pipe gauge. The selectable range is from 1 ~ 5. The setting 
value 1 represents at least 13 pixels and the setting value 2 represents at least 26 
pixels and vise versa.  
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3.6 Pie Element 

 
Fig. 3.6.1 Pie element options 

 

Table 3.6.1 Property Description of Pie Element 

Property Description of Pie Element 
There are four kinds of Pie elements for the users to select. The users can use the element property table to 
set the minimum & maximum value, low & high limit and element color, etc. It can be used to display the size 
of the specific address and quickly judge its quantity by the increment and decrement measure of area. If the 
value of the address is less than the lower limit or higher than the high limit, it can change its color to show 
clearly for the users to recognize and give a warning to the users.  
Read Address It is used to set the read address. The link type can be Base Port or Internal Memory. 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® to 
determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color 
Foreground Color 
Background Color 

It is used to set the border color, foreground and background color of the pie element. 
For example, the border color of the following example pie element is in blue, and the 
foreground color is set to green and its background color is in yellow. 

 
Standard Raised Sunken Transparent Style 

   
 

Data Length There are 16bits Word and 32bits 
Double Word two options. 

Data Format There are following data format 
provided: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
 

Minimum Value 

Detail Setup 

Maximum Value 

It is used to set the minimum and maximum value of the pie 
element. 
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Property Description of Pie Element 

Target 
Value 
Color 

The users can decide if the target value display or not by 
using this option. If this option is set, the target value and its 
color set by the users will display on the screen. HMI will refer 
to the minimum and maximum value and draw the proper 
reference line on the bar element just like the figure shown 
below: (Here we set the target value is 80 and its color is in 
yellow.) 

 
Ranges (Enable range 
setting)  

Please refer to the description of Low & High Region Color. 

Variable target/range 
limits 

When the target value and low & high limit is a variable value, 
the low limit address is Read Address+1, the high limit 
address is Read Address+2 and the address of target value is 
Read Address+3.  

When the users have input the target value, low & high limit, and minimum & maximum 
value, after pressing OK button, HMI will examine the value by referring to the selected 
data length and data format. 

Low Region Color 
High Region Color 

This option is available and displayed in the property table only when the “Ranges” 
option in the Detail Setup dialog box is selected. If the users set the low limit value is 
30 and the color of low limit region is in green, and then set the high limit value is 70 
and the color of high limit region is in red, the pie element will be shown as the figures 
below (The min. & max. input value is 0 and 100 respectively.): 

       
    When the value is 20      When the value is 50      When the value is 80  

Example of Pie Element: 

 
Fig. 3.6.2 Example of Pie element 
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3.7 Indicator 

 
Fig. 3.7.1 Indicator element options 

 

Table 3.7.1 Property Description of Multistate Indicator Element 

Property Description of Multistate Indicator Element 

Multistate indicator provides a method to indicate the state of some specific address. It will send state 
changes message to user no matter it is Bit, LSB or WORD. If this address is an significant indicator or 
important message or important alarm, it can be used to inform the users immediately by changing state 
display method or different text setting. Or let the users know more information according to the changes of 
different states to make the users can also handle the corresponding situation at the first time. 

Read Address It is used to set the read address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 
When the read address is set to the contact of the controller, i.e. PLC, the 
multistate indicator will change depending on the state (ON or OFF) of PLC 
corresponding contact. For example, the users can set that when the value is 1, the 
indicator will display the text “Start” and when the value is 0, the indicator will 
display the text “Stop”. The users also can add picture into each state of the 
multistate indicator and then the corresponding picture will show when each state is 
activated.  

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users.

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Bit Indicator element can have two states. 

Word Indicator element can have 256 states. 

Data Length 

LSB Indicator element can have 16 states.  

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 

Add/Remove State It is used to set the state numbers of multistate indicator. If the data length of the 
value is in Word, 1~256 states can be set. If the data length of the value is in LSB, 
16 states can be set. If the data length of the value is in Bit, only 2 states can be 
set.  

Example of Indicator Elements: 
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Table 3.7.2 Property Description of Range Indicator Element 

Property Description of Range Indicator Element 

Range indicator provides a method to indicate the state of some specific address. It will send state changes 
message to user no matter it is Bit, LSB or WORD. HMI reads the value of the corresponding PLC specific 
address  (register) and compare this read value with the lower limit value and then, display the 
corresponding state of comparison result on HMI screen. 

Read Address  It is used to set the read address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows®
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users.

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Add/Remove State It is used to set the state numbers of range indicator. If the data length of the value 
is in Word, 1~256 states can be set. If the data length of the value is in LSB, 16 
states can be set. If the data length of the value is in Bit, only 2 states can be set.  

Data 
Length 

There are 16bits Word and 32bits 
Double Word two options. 

Data 
Format 

There are following data format 
provided: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
 

Selecting this option can use default 5 states to set the range. If 
there is n numbers of states, it indicates that there is Range n-1 
for the users to use. The users can specify the foreground color 
of state 0, 1, 2, 3, and 4 as red, green, blue, yellow and purple 
respectively. 

Range 0 Range 1 Range 2 Range 3 

100 50 33 1 

Constant
Limits 

When the value of read address is higher than 100, the range 
indicator will display in red. When the value of the read address 
is higher than 50, the range indicator will display in green, and 
vise versa.  

Detail 

Range 

Variable 
Limits 

When this option is selected, there is Range n-1 for the users to 
use. n represents the total state numbers and n-1 represents the 
total range numbers. For example, if the read address is $0, and 
the total state number of the element is 5, it indicates that there 
is Range 0~4 for the users to use. Then, the lower limit value of 
Range 0 is $1, the lower limit value of Range 1 is $2 and vise 
versa.  
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Table 3.7.3 Property Description of Simple Indicator Element 

Property Description of Simple Indicator Element 

For the users’ convenience, simple indicator provides two states (ON/OFF) to let the users change the base 
picture quickly. The users can also import the completed CAD drawing into a simple indicator element 
directly by clicking Screen > Import command. In the following left example figure, there are simple indicator 
elements on the top of the pipe element. The simple indicator elements will change as shown as the right 
figure below. 

   
Read Address  It is used to set the read address. The link type can be Base Port or Internal 

Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows®
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

XOR Color It is used to set XOR color of base picture. 
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3.8 Data Display 

 
Fig. 3.8.1 Data Display element options 

 

Table 3.8.1 Function of Data Display elements 

Element Type Function 

Numeric Display Display the value of the specific address.  

Character Display Display the text or character of the specific address.  

Date Display Display date of HMI. 

Time Display Display time of HMI. 

Day-of-week Display Display day-of-week of HMI. 

Prestored Message Display message according to the state of HMI. 

Moving Sign Display message by moving sign according to the state of HMI. 

 Numeric Display 

Table 3.8.2 Property Description of Numeric Display Element 

Property Description of Numeric Display Element 
This element will read the value of the setting address and display the read value immediately in the format 
set by the users. 
Read Address It is used to set the read address. The link type can be Base Port or Internal Memory. 

(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~64 kinds of default text font for the users 
to use. 

Border Color 
Background Color 

Border Color option can be set only when the style of the numeric display element is 
selected as Raised and Sunken. The style of the element below is selected as 
“Sunken”. Its background color is set to green and its border color is set to red. 

 (If the style of the element is set to Transparent, the Border Color and 
Background Color these two options are disabled.) 

Standard Raised Sunken Transparent Style 
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Property Description of Numeric Display Element 

Leading Zero The following figures show the difference if the users select the Leading Zero option. 
(Please note that the integral digits is set to 4.) 

    (If YES is selected, the numeric value will show as this one.) 

    (If NO is selected, the numeric value will show as this one.) 

 
Date Length There are 16bits Word and 32bits Double Word two options. 

There are following data format provided: 

Word Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 

Integral Digits 

Fractional Digits 

Use this option to determine the digit number of integer and 
decimal fraction. The digit number is not a real digit number 
value. It is only the display format. The digit number will be a real 
decimal number only when the data format is selected as 
“Floating”.  

Gain (a) 

Offset (b) 

The users can use y = (a) x (read address value) + (b) this 
equation to determine the display numeric value (y). For example, 
if Gain value (a) is 2 and Offset value (b) is 3, when the read 
address value is 3, then the display numeric value will be equal to
(2) x 3 + (3) = 9. 

Detail 

Round off If this option is selected, after the operation of the equation 
above, all numeric values can be rounded off and display on the 
screen.  

Fast Refresh If this option is selected, the element can be displayed immediately when switching 
the screen.  Please note that only 4 elements (including display element and input 
element) can be fast refreshed on one screen. The users can set the Fast Refresh 
Rate by clicking Screen > Screen Properties command. There are three levels of the 
Fast Refresh Rate and they are High, Medium and Low.  
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 Character Display 

Table 3.8.3 Property Description of Character Display Element 

Property Description of Character Display Element 
The users can use this element to read the value of the specific address, convert them to text or character 
and display on the screen. The read value must be in ASCII format or the users cannot see the display text 
or character. (The max. string length is 28words.) 
Read Address It is used to set the read address. The link type can be Base Port or Internal Memory. 

(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~64 kinds of default text font for the users 
to use. 

Border Color 
Background Color 

(Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Style (Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

String Length The range is with 1 ~ 28 words. 

 
If we set the read address as Internal Memory 0, i.e. $0, the string length is 5 and set 
Screen Open Macro as follows:  
$0 = 65 
$1 = 66 
$2 = 67 
$3 = 68 
$4 = 69 
Then, the above screen will display.  
Please note that character display element reads the Byte value, and the data length 
of the internal memory $ address is Word, therefore, when reading the Internal 
Memory $0, the display character will be A(65)  (0) B(66)  (0) C(67)  (0)… and vise 
versa. 

Fast Refresh If this option is selected, the element can be displayed immediately when switching 
the screen.  Please note that only 4 elements (including display element and input 
element) can be fast refreshed on one screen. The users can set the Fast Refresh 
Rate by clicking Screen > Screen Properties command. There are three levels of the 
Fast Refresh Rate and they are High, Medium and Low.  
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 Date Display 

Table 3.8.4 Property Description of Data Display Element 

Property Description of Date Display Element 

Display HMI system date. There are several date formats selectable for the users to use.  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~64 kinds of default text font for the users 
to use. 

Border Color 
Background Color 

(Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Style (Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Date Format Provide MM/DD/YY, DD/MM/YY, DD.MM.YY three kinds of formats. 

 Time Display 

Table 3.8.5 Property Description of Time Display Element 

Property Description of Time Display Element 

Display HMI system time. There are several time formats selectable for the users to use.  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~64 kinds of default text font for the users 
to use. 

Border Color 
Background Color 

(Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Style (Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

 Day-of-week Display 

Table 3.8.6 Property Description of Day-of-week Display Element 

Property Description of Day-of-week Display Element 
Display the day (Sunday ~ Monday) of the week. The state default setting of the Day-of-week display 
element is set to 7. It indicates that there are 7 states for this element. Each state has its predefined day 
description, such as SUN, MON  … SAT. The users can change it directly in the property table.  
Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color 
Background Color 

(Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Style (Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 
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 Prestored Message 

Table 3.8.7 Property Description of Prestored Message Element 

Property Description of Prestored Message Element 
Display the state content of PLC corresponding contact or register directly. The users can set state number 
and text for each state.  
Read Address It is used to set the read address. The link type can be Base Port or Internal Memory. 

(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color 
Background Color 

(Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Style (Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Bit It can have two states. 

Word It can have 256 states. 

Data Type 

LSB It can have 16 states.  

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 

Add/Remove State It is used to set the state numbers of prestored message element. If the data length of 
the value is in Word, 1~256 states can be set. If the data length of the value is in LSB, 
16 states can be set. If the data length of the value is in Bit, only 2 states can be set. 

 Moving Sign 

Table 3.8.8 Property Description of Moving Sign Element 

Property Description of Moving Sign Element 

Moving sign is a sign that uses movement, lighting, or special display to depict and display the state content 
of PLC corresponding contact or register. The users can determine the display of the moving sign by the 
settings of the direction, moving points, and interval(ms) in the property table. 

Read Address It is used to set the read address. The link type can be Base Port or Internal Memory. 
(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by Windows® 
to determine the text display on the element. (Please refer to Table 3.2.2 Property 
Description of General Buttons.) 

Border Color 
Background Color 

(Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Style (Please refer to Table 3.8.2 Property Description of Numeric Display Element.) 

Bit It can have two states. 

Word It can have 256 states. 

Data Type 

LSB It can have 16 states.  

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 
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Property Description of Moving Sign Element 

Add/Remove State It is used to set the state numbers of moving sign element. If the data length of the 
value is in Word, 1~256 states can be set. If the data length of the value is in LSB, 16 
states can be set. If the data length of the value is in Bit, only 2 states can be set.  

Left The display progressing direction is from right to the left. 

Right The display progressing direction is from left to the right. 

Top The display progressing direction is from bottom to the top. 

Direction 

Botom The display progressing direction is from top to the bottom. 

Moving Points It is used to set the movement of the moving sign. The unit is Pixel and the range is 
within 1 ~ 50 Pixels. 

Interval(ms) It is used to set the interval time between two movements. The unit is ms and the 
range is within 50 ~ 3000 ms. 
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3.9 Graph Display 

 
Fig. 3.9.1 Graph Display element options 

 

Table 3.9.1 Function of Graph Display elements 

Element Type Icon Function 

State Graphic  
It is used to create and display one or more state pictures on the certain 
positions of the HMI screen. Different pictures can be shown on the screen 
according to the different states. 

Animated Graphic  

It is used to create and display an animated picture on any position of the HMI 
screen. The users can control the X and Y direction to move and show the 
animated pictures freely. Different pictures can be shown on the screen 
according to the different states. 

Dynamic Line  
It is used to draw and display a dynamic line on the HMI screen. The users can 
control the X and Y direction to move the dynamic line element and change its 
size freely.  

Dynamic Rectangle  
It is used to draw and display a dynamic rectangle on the HMI screen. The 
users can control the X and Y direction to move the dynamic rectangle element 
and change its size freely.  

Dynamic Ellipse  
It is used to draw and display a dynamic ellipse on the HMI screen. The users 
can control the X and Y direction to move the dynamic ellipse element and 
change its size freely. 

 Static Graphic 

Table 3.9.2 Property Description of Static Graphic Element 

Property Description of Static Graphic Element 
When HMI is connected to PLC, the users can create static graphic elements to read the value of several 
read addresses controlled by PLC. The read value of each state can be converted and transmitted to the 
static graphic elements and display on the HMI screen.  
Read Address It is used to set the read address. The link type can be Base Port or Internal Memory. 

(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color (Please refer to Table 3.2.2 Property Description of General Buttons.) 

Bit It can have two states. 

Word It can have 256 states. 

Data Length 

LSB It can have 16 states.  

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 
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Property Description of Static Graphic Element 

Add/Remove State It is used to set the state numbers of static graphic element. If the data length of the 
value is in Word, 1~256 states can be set. If the data length of the value is in LSB, 16 
states can be set. If the data length of the value is in Bit, only 2 states can be set.  
No When this option is selected, the value of the read address will be 

regarded as the state number. It means that the state number is 
determined by the value of the read address. For example, if the value of 
the read address $0 is 0, it will switch to 0th state; if the value of the read 
address $0 is 5, it will switch to 5th state.  

Yes When this option is selected and the value of the read address is a non-
zero value, the static graphic element will change automatically. 

Auto Change 

Variation When this option is selected, the property of the Read Address will be the 
condition of changing element. The element will change automatically 
according to Read Address+1.  If the value of the Read Address+1 is a 
non-zero value, the static graphic element will change automatically. 
Otherwise, it will not change.  

Transparent If Yes is selected, it indicates that this element will be displayed in transparent color. It 
is usually used with the transparent color setting of the element. Please refer to the 
following example elements: 

 The transparent color has not been set yet.  

   The element transparent color has been set. 

  The transparent color of the whole drawing has been set. 
 
Note: If Yes is selected (set to Transparent), the foreground color option is disabled. 

Example of Static Graphic element: 

The designated read address = D100.  The internal memory value and each state should be as follows: 

  

D100=0 D100=1 D100=2 D100=3 D100=4 
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 Animated Graphic 

Table 3.9.3 Property Description of Animated Graphic Element 

Property Description of Animated Graphic Element 
When HMI is connected to PLC, the users can create animated graphic elements to read the value of 
several read addresses controlled by PLC. The read value of each state can be converted and transmitted to 
the animated graphic elements and display on the HMI screen. The movement and moving position can also 
be controlled and show on the HMI screen. 

It is used to set the read address. The link type can be Base Port or Internal Memory. 
(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Read Address Use the value of Read Address to switch the state of 
animated graphic element.  

Read Address+1 Use the value of Read Address+1 to be the horizontal axis 
position of the animated graphic element. 

Read Address 

Read Address+2 Use the value of Read Address+2 to be the vertical axis 
position of the animated graphic element. 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Clear Picture Use this option to clear previous animated graphic element when moving the element 
or changing the state of the element. 

Word It can have 256 states. Data Length 

LSB It can have 16 states.  

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 

Add/Remove State It is used to set the state numbers of animated graphic. If the data length of the value 
is in Word, 1~256 states can be set. If the data length of the value is in LSB, 16 states 
can be set. If the data length of the value is in Bit, only 2 states can be set.  

Example of Animated Graphic element:  

The designated read address = D100.  The internal memory value and each state should be as follows: 

State control register Dn+1 

    

                

 

 

 

 

X-axis control register Dn+2

Y-axis control register Dn+3
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 Dynamic Line 

Table 3.9.4 Property Description of Dynamic Line Element 

Property Description of Dynamic Line Element 
The dynamic line element can be changed and moved depending on the value of the PLC corresponding 
contact or register.  

     
It is used to set the read address. The link type can be Base Port or Internal Memory. 
(Please refer to Table 3.2.2 Property Description of General Buttons.)  

The value of the Read Address can be used only when 
Variable Position option is set to Yes. It is used to represent 
the left-top horizontal position (Left) of the element.  

Read Address 

When Variable Position option is set to No and Variable Color
option is set to Yes, the value of the Read Address is used to 
represent the line color and the range is within 0 ~ 255.  

Read Address +1 The value of the Read Address+1 can be used only when 
Variable Position option is set to Yes. It is used to represent 
the left-top vertical position (Top) of the element. 

Read Address +2 The value of the Read Address+2 can be used only when 
Variable Position option is set to Yes. It is used to represent 
the right-bottom horizontal position (Right) of the element. 

Read Address +3 The value of the Read Address+3 can be used only when 
Variable Position option is set to Yes. It is used to represent 
the right-bottom vertical position (Bottom) of the element. 

Read Address 

Read Address +4 The value of the Read Address+4 can be used only when 
Variable Color option is set to Yes. It is used to represent the 
line color and the range is within 0 ~ 255. 

Line Color It is used to set the display color of the dynamic line element. 

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users.  

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 

Line Style There are following line styles can be selected. 

 
Variable Position (Please refer to the description of Read Address above) 
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Property Description of Dynamic Line Element 

Variable Color (Please refer to the description of Read Address above) 

 Dynamic Rectangle 

Table 3.9.5 Property Description of Dynamic Rectangle Element 

Property Description of Dynamic Rectangle Element 
The dynamic rectangle element, including element size and color can be changed and moved depending on 
the value of the PLC corresponding contact or register.  

     
It is used to set the read address. The link type can be Base Port or Internal Memory. 
(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Read Address The value of the Read Address can be used only when 
Variable Position option is set to Yes. It is used to represent 
the left-top horizontal position (Left) of the element.  

Read Address +1 The value of the Read Address+1 can be used only when 
Variable Position option is set to Yes. It is used to represent 
the left-top vertical position (Top) of the element.  

Read Address +2 The value of the Read Address+2 can be used only when 
Variable Size option is set to Yes. It is used to represent the 
right-bottom horizontal position (Right) of the element.  

Read Address +3 The value of the Read Address+3 can be used only when 
Variable Size option is set to Yes. It is used to represent the 
right-bottom vertical position (Bottom) of the element.  

Read Address +4 The value of the Read Address+4 can be used only when 
Variable Color option is set to Yes. It is used to represent the 
rectangle foreground color and the range is within 0 ~ 255.  

Read Address 

Please note that when Variable Position option is set to No, the internal memory 
address of Variable Size option will increase one (one increment). (Read Address will 
represent the right-bottom horizontal position (Right) of the element. Read Address+1 
will represent the right-bottom vertical position (Bottom) of the element. Read 
Address+2 will represent the foreground color of the element.)  

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users.  

Foreground Color It is used to set the foreground color of the dynamic rectangle element. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 

Transparent When this option is selected, the element will display only with the border and there is 
no color in the element. The Foreground Color option will be disabled also.  
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Property Description of Dynamic Rectangle Element 

Round Radius 0~38 pixels round radius are provided for selection.  

 
Variable Position (Please refer to the description of Read Address above) 

Variable Size (Please refer to the description of Read Address above) 

Variable Color (Please refer to the description of Read Address above) 

 Dynamic Ellipse 

Table 3.9.6 Property Description of Dynamic Ellipse Element 

Property Description of Dynamic Ellipse Element 
The dynamic ellipse element, including element size and color can be changed and moved depending on 
the value of the PLC corresponding contact or register. 

     

It is used to set the read address. The link type can be Base Port or Internal Memory. 
(Please refer to Table 3.2.2 Property Description of General Buttons.)  

Read Address The value of the Read Address can be used only when 
Variable Central Point option is set to Yes. It is used to 
represent the horizontal position of the element center point. 

Read Address +1 The value of the Read Address+1 can be used only when 
Variable Central Point option is set to Yes. It is used to 
represent the vertical position of the element center point.  

Read Address +2 The value of the Read Address+2 can be used only when 
Variable Radius option is set to Yes. It is used to represent 
the horizontal radius of the element.  

Read Address +3 The value of the Read Address+3 can be used only when 
Variable Radius option is set to Yes. It is used to represent 
the vertical radius of the element. 

Read Address +4 The value of the Read Address+4 can be used only when 
Variable Color option is set to Yes. It is used to represent the 
ellipse foreground color and the range is within 0 ~ 255. 

Read Address 

Please note that when Variable Central Point option is set to No, the internal memory 
address of Variable Radius option will increase one (one increment). (Read Address 
will represent the horizontal radius of the element. Read Address+1 will represent the 
vertical radius of the element. Read Address+2 will represent the foreground color of 
the element.) 

Line Color It is used to set the display color of the dynamic ellipse element. 
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Property Description of Dynamic Ellipse Element 

Twinkle When Yes is selected, it indicates that the element will twinkle to remind the users.  

Foreground Color It is used to set the foreground color of the dynamic ellipse element. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Data Format It provides BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data 
format to define the read memory content. 

Transparent When this option is selected, the element will display only with the border and there is 
no color in the element. The Foreground Color option will be disabled also.  

Variable Central 
Point 

(Please refer to the description of Read Address above) 

Variable Radius (Please refer to the description of Read Address above) 

Variable Color (Please refer to the description of Read Address above) 
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3.10 Input Element 

 
Fig. 3.10.1 Input element options 

 

Set write and read address for the users to input and display address value. Write and read address can be 

the same or different. 

Table 3.10.1 Function of Input elements 

Element Type Icon Function 

Numeric Entry 
 

It is used to input and display the numeric value of specific PLC address. 

Character Entry  It is used to input and display the characters of specific PLC address. 

 Numeric Entry 

Table 3.10.2 Property Description of Numeric Entry Element 

Property Description of Numeric Entry Element  

After pressing this numeric entry element on the screen, a system built-in numeric keypad (TEN-KEY) will 
show up and the users can use it to input the setting value directly. When pressing ENTER key, HMI will 
send the input setting value to PLC corresponding register. The maximum and minimum input setting values 
are all user-defined. The users can also specify the trigger mode to trigger the designated PLC address 
before or after writing the setting value.  

Write Address 
Read Address 

It is used to set the read and write address. The link type can be Base Port or Internal 
Memory. (Please refer to Table 3.2.2 Property Description of General Buttons.) 
Please note that if the users set the write address only, after press “Compile” key, HMI 
will copy the write address data into the read address automatically.  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~64 kinds of default text font for the users 
to use. 

Border Color 
Background Color 

Border Color option can be set only when the style of the numeric entry element is 
selected as Raised and Sunken. The style of the element below is selected as 
“Rasied”. Its background color is set to blue and its border color is set to red. 

 (If the style of the element is set to Transparent, the Border Color and 
Background Color these two options are disabled.) 

Standard Raised Sunken Transparent Style 

 



Chapter 3  Element Function|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   3-49 

Property Description of Numeric Entry Element  

Leading Zero The following figures show the difference if the users select the Leading Zero option. 
(Please note that the integral digits is set to 4.) 

    (If YES is selected, the numeric value will show as this one.) 

   (If NO is selected, the numeric value will show as this one.) 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON before 
or after writing the setting value. Note: this function can only trigger PLC address to be 
ON. If the PLC address needs to be triggered again, the users should set the address 
to be OFF by themselves. 

 
Date Length There are 16bits Word and 32bits Double Word two options. 

There are following data format provided: 

Word Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 

Minimum 

Maximum 

The users can set the minimum and maximum of input setting 
value to determine the range of input setting value.  

Integral Digits 

Fractional Digits 

Use this option to determine the digit number of integer and 
decimal fraction. The digit number is not a real digit number 
value. It is only the display format. The digit number will be a real 
decimal number only when the data format is selected as 
“Floating”.  

Detail 

When Variable Minimum/Maximum Value option is selected, it indicates that the 
minimum value is determined by Read Address+1 and the maximum value is 
determined by Read Address+2. 
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Property Description of Numeric Entry Element  

Gain (a) 

Offset (b) 

The users can use y = (a) x (read address value) + (b) this 
equation to determine the display numeric value (y). For example, 
if Gain value (a) is 2 and Offset value (b) is 3, when the read 
address value is 3, then the display numeric value will be equal to
(2) x 3 + (3) = 9. 

Round off If this option is selected, after the operation of the equation 
above, all numeric values can be rounded off and display on the 
screen.  

When the users have input the minimum and maximum value, after pressing OK 
button, HMI will examine the value by referring to the selected data length, data 
format, integral and fractional digits. 

Input Mode There are Touch Popup, Active Non-Popup and Touch Non-Popup three options. The 
default setting is Touch Popup. For the description of Active input mode, please refer 
to section 3.15 Keypad Element.  

User Security Level Use this option to set the user priority for pressing this element. Only the priority that 
is higher than the current setting can use this element.  

Display Asterisk (*) If YES is selected, the screen will show as the following figure when inputting the 
setting value. 

 
Fast Refresh If this option is selected, the element can be displayed immediately when switching 

the screen.  Please note that only 4 elements (including display element and input 
element) can be fast refreshed on one screen. The users can set the Fast Refresh 
Rate by clicking Screen > Screen Properties command. There are three levels of the 
Fast Refresh Rate and they are High, Medium and Low.  

Set Low Security Use this option to force the current priority to be the lowest after the button is pressed. 
This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High (or 
from High to Low, this is determined by the property of “InterLock Level”), this button 
can be enabled.   

Before Execute 
Macro 

When this option is set, the input macro will be enabled and executed before this 
button is pressed.  

After Execute Macro When this option is set, the input macro will be enabled and executed after this button 
is pressed.  

Example of Numeric Entry element:  

After pressing the numeric entry element, a system built-in numeric keypad (TEN-KEY) will display on 

the screen as shown as the figure below. The example here is to input numeric value 99 into PLC 

corresponding register, D100. 
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Fig. 3.10.2 TEN-KEY input dialog box 

 Character Entry 

Table 3.10.3 Property Description of Character Entry Element 

Property Description of Character Entry Element  

The users can set write and read address to input the data of the specific address by text or character and 
display them on the screen. The input and display text or character must be in ASCII format. Write and read 
address can be the same or different. (The max. string length is 28words.)  

Write Address 
Read Address 

It is used to set the read and write address. The link type can be Base Port or 
Internal Memory. (Please refer to Table 3.2.2 Property Description of General 
Buttons.) 
Please note that if the users set the write address only, after press “Compile” key, 
HMI will copy the write address data into the read address automatically.  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~64 kinds of default text font for the 
users to use. 

Border Color 
Background Color 

Border Color option can be set only when the style of the character entry element is 
selected as Raised and Sunken. The style of the element below is selected as 
“Raised”. Its background color is set to blue and its border color is set to gray.  

 (If the style of the element is set to Transparent, the Border Color 
and Background Color these two options are disabled.) 

Standard Raised Sunken Transparent Style 

   

Character Length The range is with 1 ~ 28 words. The default setting is 4words. 

Trigger 
Trigger Mode 

The users can use this setting to trigger the designated PLC address to be ON 
before or after writing the setting value. Note: this function can only trigger PLC 
address to be ON. If the PLC address needs to be triggered again, the users should 
set the address to be OFF by themselves. 
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Property Description of Character Entry Element  

Input Mode There are Touch Popup, Active Non-Popup and Touch Non-Popup three options. 
The default setting is Touch Popup. For the description of Active input mode, please 
refer to section 3.15 Keypad Element.  

User Security Level Use this option to set the user priority for pressing this element. Only the priority that 
is higher than the current setting can use this element.  

Display Asterisk (*) If YES is selected, the screen will show as the following figure when inputting the 
text or character. 

 
Fast Refresh If this option is selected, the element can be displayed immediately when switching 

the screen.  Please note that only 4 elements (including display element and input 
element) can be fast refreshed on one screen. The users can set the Fast Refresh 
Rate by clicking Screen > Screen Properties command. There are three levels of 
the Fast Refresh Rate and they are High, Medium and Low.  

Set Low Security Use this option to force the current priority to be the lowest after the button is 
pressed. This can prevent the misoperation made by the users (operators).  

InterLock Address 
InterLock Level 

It is similar to the Latch function. When read address is changed from Low to High 
(or from High to Low, this is determined by the property of “InterLock Level”), this 
button can be enabled.   

Before Execute Macro When this option is set, the input macro will be enabled and executed before this 
button is pressed.  

After Execute Macro When this option is set, the input macro will be enabled and executed after this 
button is pressed.  

Example of Character Entry element:  

After pressing the character entry element, a system built-in character keypad (ASCII-KEY) will display 

on the screen as shown as the figure below. The users can input the text or character in ASCII format 

into PLC corresponding register, (D1000~Dn). n represents the character length. 
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Fig. 3.10.3 ASCII-KEY input dialog box 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Chapter 3  Element Function|ScrEdit Software User Manual 

3-54   Revision 05/30/2006, EH00 

3.11 Curve Element 

 
Fig. 3.11.1 Curve element options 

 

Table 3.11.1 Function of Curve elements 

Element Type Icon Function 

Trend Graph 
 

It is used to display the value change of the read address by trend graph. The trend 
graph can only display and set the change of Y-axis.  

X-Y Chart 
 

It is used to display the value change of the read address by trend graph. The trend 
graph can display and set the change of X-axis and Y-axis.  

 Trend Graph 

Table 3.11.2 Property Description of Trend Graph Element 

Property Description of Trend Graph Element  

The first step for setting trend graph is to set the curve number in “Curve Field Total” option (range is 1~4) in 
property table. Then, setting the read address, read format, curve width and color in “Detail Setup” option to 
complete the setup. 
HMI will convert a series value of setting address to a trend graph on the screen. For example, if there are 
100 sampling points and four curves, there will be 100 X 4 = 400 points. If HMI is connected to Delta PLC, 
suppose that the read address is D0, it will read 400 words (D0~D399) after the address is triggered. Setting 
Y-axis of curve 1 is D0~D99, Y-axis of curve 2 is D100~D199, Y-axis of curve 3 is D200~D299 and Y-axis of 
curve 4 is D300~D399. If the value exceeds maximum value, it will be displayed with maximum value. If the 
value is less than minimum value, it will be displayed with minimum value. After setting, the users should set 
the address of the control block to trigger read data of trend graph, trend graph drawing and clear the curve. 
Please refer to Chapter 5 for the settings of the control block. 

Border Color 
Background Color 

Border Color option can be set only when the style of the trend graph element is 
selected as Raised and Sunken. The style of the element below is selected as “Raised”. 
Its background color is set to black and its border color is set to gray.  

  
Standard Raised Sunken Style 

 
Curve Field Total 1~4 curves can be set and displayed.  
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Property Description of Trend Graph Element  

 
Sample Number 

Max. Sample 
Number 

When Sample Number is a constant: The max. sample number is 
defined as the following:  
1. When the element style is selected as “Standard”, the max. 

sample number is the element width and the unit is pixels. 
2. When the element style is selected as “Raised” or “Sunken”, the 

max. sample number is the element width minus the border width 
(the value of the border width is 14 pixels). The border width is 
shown as the place where the arrow sign ends. 

 
Please note that when the sample number is a constant, the Max. 
Sample Number option is disabled.  
When Sample Number is a variable value: the system will refer to the 
value of Read Address+1 and regard the value as the max. sample 
number. Then, the Max. Sample Number option will be enabled. If the 
read value is more than the set Max. Sample Number, the system will 
take the set Max. Sample Number as the actual max. sample 
number.  

Word Read Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Read Address It is used to set the read address. The link type can be Base Port or 
Internal Memory. 

Sample Flag It is used to set trigger and clear flag. When sample flag is triggered, 
it will start to read data and draw the graph. This sample flag is 
located within the control block. Please refer to Chapter 5 for the 
settings of the control block. 

Minimum 

Detail Setup 

Maximum 

It is used to set the minimum and maximum value of the display data, 
i.e. the minimum and maximum value of Y-axis. If the read value is 
more the maximum or less than the minimum, the system will display 
the minimum and maximum value still.  
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Property Description of Trend Graph Element  

Curve Width It is used to the display curve width. The range is within 1 ~ 8 and the 
unit is pixel. 

Curve Color It is used to the display curve color.  

Grid Color 

Grid Number in 
Horiz. 

Please refer to the figure below. The grid color is set to red and the grid number in 
horizontal direction is set to 3. 

 

 X-Y Chart 

Table 3.11.3 Property Description of X-Y Chart Element 

Property Description of X-Y Chart Element  

HMI will convert a series value of setting address to a X-Y chart on the screen. For example, if there are 100 
sampling points and four curves, there will be 100 x 4 x 2 = 800 points. If HMI is connected to Delta PLC, 
suppose that the read address of X-axis is D0 and the read address of Y-axis is D500, it will read 800 words 
(D0~D399 and D500~D899) after the address is triggered. Setting X-axis of curve 1 is D0~D99, Y-axis of 
curve 1 is D500~D599, X-axis of curve 2 is D100~D199 and Y-axis of curve 2 is D600~D699, X-axis of 
curve 3 is D200~D299 and Y-axis of curve 3 is D700~D799, X-axis of curve 4 is D300~D399 and Y-axis of 
curve 4 is D800~D899. If the value exceeds maximum value, it will be displayed with maximum value. If the 
value is less than minimum value, it will be displayed with minimum value. After setting, the users should set 
the address of the control block to trigger read data and the drawings of the X-Y chart. Please refer to 
Chapter 5 for the settings of the control block. 

Border Color 
Background Color 

Border Color option can be set only when the style of the X-Y chart element is selected 
as Raised and Sunken. The style of the element below is selected as “Raised”. Its 
background color is set to yellow and its border color is set to gray.  

 
Standard Raised Sunken Style 

  
Connect Two 
Points 

If Yes option is selected, when drawing the X-Y chart on the screen, the space between 
two points on the X-Y chart will be connected by lines. 

Curve Field Total 1~4 curves can be set and displayed. 
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Property Description of X-Y Chart Element  

 
Sample Number 

Max. Sample 
Number 

When Sample Number is a constant: The max. sample number is 
defined as the following:  
1. When the element style is selected as “Standard”, the max. 

sample number is the element width and the unit is pixels. 
2. When the element style is selected as “Raised” or “Sunken”, the 

max. sample number is the element width minus the border width 
(the value of the border width is 14 pixels). The border width is 
shown as the place where the arrow sign ends. 

 
Please note that when the sample number is a constant, the Max. 
Sample Number option is disabled.  
When Sample Number is a variable value: the system will refer to the 
value of Read Address+1 and regard the value as the max. sample 
number. Then, the Max. Sample Number option will be enabled. If the 
read value is more than the set Max. Sample Number, the system will 
take the set Max. Sample Number as the actual max. sample 
number. 

Word Read Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Horiz. Read 
Address 

It is used to set the read address of the horizontal data. The link type 
can be Base Port or Internal Memory.  

Detail Setup 

Vert. Read 
Address 

It is used to set the read address of the vertical data. The link type 
can be Base Port or Internal Memory.  
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Property Description of X-Y Chart Element  

Sample Flag It is used to set trigger and clear flag. When sample flag is triggered, 
it will start to read data and draw the X-Y chart. This sample flag is 
located within the control block. Please refer to Chapter 5 for the 
settings of the control block. 

Horiz. Minimum 

Horiz. Maximum 

It is used to set the minimum and maximum value of the horizontal 
display data, i.e. the minimum and maximum value of X-axis. If the 
read value is more the maximum or less than the minimum, the 
system will display the minimum and maximum value still.  

Horiz. Minimum 

Horiz. Maximum 

It is used to set the minimum and maximum value of the vertical 
display data, i.e. the minimum and maximum value of Y-axis. If the 
read value is more the maximum or less than the minimum, the 
system will display the minimum and maximum value still.  

Curve Width It is used to the display curve width. The range is within 1 ~ 8 and the 
unit is pixel.  

Curve Color It is used to the display curve color.  

Grid Color 

Horiz. Line Number 

Vert. Line Number 

Please refer to the figure below. The grid color is set to red and the grid number in 
horizontal and vertical direction are both set to 2. 
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3.12 Sampling Element 

 
Fig. 3.12.1 Sampling element options 

The sampling element is designed to display the history data by history graph or table and can be updated 

immediately for the users to use and read more easily. Let us review the History Setup function (see page 2-

132) again. History Setup should be used with sampling elements. The users can click ”Option” > “History 

Setup” (Choosing History Setup command from menu bar) to execute this function.  

 

Table 3.12.1 History Setup Dialog Box 

History Setup Dialog Box 

 
Pressing Append button can add a history data. After the Append button is pressed, the 
following Buffer Properties dialog box will display. 

 

Append 

Read Address It is used to set the starting address for sampling the history data. 
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History Setup Dialog Box 

Data Length 
(Word) 

It is used to set how much Word the users want to sample? The range is 
within 1 ~ 13 continuous Words. It indicates that max. 13 continuous words 
can be sampled. 
For example: If the setting value of Data Length is set to 6, it indicates that 
there are 6 continuous Words (M100, M101, …, M105) can be sampled. The 
Sample Number option is used to set the max. sample number. If the 
Sample Number option is set to 100, the system will sample 6words x 100 = 
600 numbers of data each time. 

Cycle (ms) It is used to set the sampling cycle time for reading address (how long is it to 
read address one time). If the Trigger option is PLC, this option will be 
ineffective. The range of the sampling cycle time is within 0 ~ 86400000 ms.

Sample Number This option is used with the Auto Stop option. If the Auto Stop option is 
selected, HMI will stop recording the data after the numbers of records have 
reached the setting value of Sample Number option. If the Auto Stop option 
is not selected, when record number of data exceeds the setting value of 
Sample Number option, it will delete the first record and insert the new 
record into the last address. For example, if the setting value is set to 100 
and the number of records in history exceeds 100, the first record will be 
deleted and the second record will become to the third record, the third 
record will become to the forth record…and the 100th record will become to 
99th record. Therefore, the new record (101st record) will become to 100th 
record. 

Stamp Time and 
Date 

Use this option to determine if the time and date are also recorded during 
sampling operation. 

Auto Stop Use this option to determine if HMI stop recording when the max. number of 
record data is reached. 

Non-Volatile Using this option can enable to save sampling data in SRAM when the 
power is turned off. The capacity for saving history data of DOP-A series is 
240MBytes and DOP-AE series is 360MBytes. (The power of SRAM is 
battery when the power is turned off.) (In some HMI models, the users can 
save data in USB Disk or SMC card when the power is turned off and the 
capacity for saving history data depends on the capacity of USB Disk or 
SMC card.)  

Trigger There are Timer and PLC two options. It means that the sampling action is 
controlled by the Timer of the HMI or the external controller, i.e. PLC. When 
PLC option is selected, it indicates that the trigger bit designated by the 
register for sampling history buffer in the control block control the sampling 
action. 

OK / Cancel Press OK button to save the data and exit. Press Cancel to exit without 
saving data.  

Delete Pressing Delete button can delete a history data.  

Modify Pressing Modify button can modify a history data.  
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 Historical Trend Graph 

Table 3.12.2 Property Description of Historical Trend Graph Element 

Property Description of Historical Trend Graph Element  
Convert the history data to trend graph with continuous curves and display on HMI screen. 

Border Color 
Background Color 

The below element background color is set to black and its border color is set to gray.  

 
Curve Number 1~8 curves can be set and displayed.  

 
Logging Buffer Use this option to set the number (No.1 ~ No.X) of history buffer for 

reading the data of PLC corresponding address. The users can press 
the History Buffer Setup button or click ”Option” > “History Setup” 
(Choosing History Setup command from menu bar) to set the PLC 
corresponding address. 

Word 

Detail 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Floating 
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Property Description of Historical Trend Graph Element  

 Please note that if the data format is selected as “Floating”, the 
Data Length option in the History Setup dialog box must be 
greater than or equal to 2words or the following warning message 
dialog box will display on the screen.  

 
Minimum 

Maximum 

It is used to set the minimum and maximum value of the display data, 
i.e. the minimum and maximum value of Y-axis. If the read value is 
more the maximum or less than the minimum, the system will display 
the minimum and maximum value still.  

Integral Digits 

Fractional 
Digits 

Use this option to determine the digit number of integer and decimal 
fraction. The digit number is not a real digit number value. It is only the 
display format. The digit number will be a real decimal number only 
when the data format is selected as “Floating”.  

Time/Date 

Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

Date Format Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of formats.

Color When time or date format is selected, the users can use this option to 
designate the display color.  

Curve (No.1 ~ 8) 

Enable If this option is selected, the following curve options are enabled and 
can be set.  

Data No. It is used to set the reading Word data when triggering every time. For 
example, if the Data Length option in the History Setup dialog box is set 
to 3words, there are 0 ~ 2 data numbers can be selected in this option. 
When selecting 1, it indicates that this Curve 1 reads the data of the 
Read Address+1 set in History Setup dialog box. 
Please note that if the data format is selected as “Floating”, and 
the Data Length option in the History Setup dialog box is an odd 
numbers of words, ensure to set the Data No. as an even number.  

Curve Width It is used to the display curve width. The range is within 1 ~ 8 and the 
unit is pixel.  

Curve Color It is used to the display curve color.  

Grid Color 

Grid Number 

Please refer to the figure below. The grid color is set to red and the grid number in 
horizontal direction is set to 3. 
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Example of Historical Trend Graph element:  

 
Fig. 3.12.2 Historical Trend Graph 

 Historical Data Table 

Table 3.12.3 Property Description of Historical Data Table Element 

Property Description of Historical Data Table Element  
Convert the history data to numeric data and display on HMI screen by a data table. The read address in the 
History Setup dialog box needs to be set and its data length should be in several words. The range of data 
length is within 1 ~ 8words. The Data No. in History Data Detail dialog will also correspond to the selected 
Data Length. For example, if the value of Data Length is set to 5, the Data No. selection will be 5 also. The 
maximum of Data Field Number is 8. This number will also be related to Data No.  
Border Color 
Background Color 

The below element background color is set to green and its border color is set to gray.  

 
Data Field Number 1~8 data fields can be set. 
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Property Description of Historical Data Table Element  

 
Logging Buffer Use this option to set the number (No.1 ~ No.X) of history buffer for 

reading the data of PLC corresponding address. The users can press 
the History Buffer Setup button or click ”Option” > “History Setup” 
(Choosing History Setup command from menu bar) to set the PLC 
corresponding address. 

Time/Date 

Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

Date Format Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of formats.

Color When time or date format is selected, the users can use this option to 
designate the display color.  

Data No. (No. 1~8) 

Date Length There are 16bits Word and 32bits Double Word two options. 

There are following data format provided: 

Word Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 

Detail 

Data No. It is used to set the reading Word data when triggering every time. For 
example, if the Data Length option in the History Setup dialog box is set 
to 3words, there are 0 ~ 2 data numbers can be selected in this option. 
When selecting 1, it indicates that this Curve 1 reads the data of the 
Read Address+1 set in History Setup dialog box. 
Please note that if the data format is selected as “Floating”, and 
the Data Length option in the History Setup dialog box is an odd 
numbers of words, ensure to set the Data No. as an even number.  
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Property Description of Historical Data Table Element  

Display Color It is used to the display data color.  

Integral Digits 

Fractional 
Digits 

Use this option to determine the digit number of integer and decimal 
fraction. The digit number is not a real digit number value. It is only the 
display format. The digit number will be a real decimal number only 
when the data format is selected as “Floating”.  

Example of Historical Data Table element:  

 
Fig. 3.12.3 Historical Data Table 

 

 Historical Event Table 

Table 3.12.4 Property Description of Historical Event Table Element 

Property Description of Historical Event Table Element  

Convert the read history data to text or character and display on HMI screen by an event table. The users 
can set display message, color and HMI will display message on screen after reading data.  

Text / Text Size 
Font / Text Color 

The users can set the text, text size, font and text color that provided by 
Windows® to determine the text display on the element. (Please refer to Table 
3.2.2 Property Description of General Buttons.) 
Every input message in each state will be converted to a state value. The system 
will list all input message in the event table. 

Border Color 
Background Color 

The below element background color is set to light yellow and its border color is set 
to black.  

 
Word It can have 256 states. Data Length 

LSB It can have 16 states.  

Data Format This option can be set only when the data length is selected as Word. It provides 
BCD, Signed Decimal, Unsigned Decimal and Hex four kinds of data format to 
define the read memory content. 
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Property Description of Historical Event Table Element  

Add/Remove State It is used to set the state numbers of historical event table element. If the data 
length of the value is in Word, 1~256 states can be set. If the data length of the 
value is in LSB, 16 states can be set. If the data length of the value is in Bit, only 2 
states can be set.  

 
Logging Buffer Use this option to set the number (No.1 ~ No.X) of history buffer for 

reading the data of PLC corresponding address. The users can 
press the History Buffer Setup button or click ”Option” > “History 
Setup” (Choosing History Setup command from menu bar) to set 
the PLC corresponding address. 

Data No. It is used to set the reading Word data when triggering every time. 
For example, if the Data Length option in the History Setup dialog 
box is set to 3words, there are 0 ~ 2 data numbers can be selected 
in this option. When selecting 1, it indicates that this Curve 1 reads 
the data of the Read Address+1 set in History Setup dialog box. 

Time/Date 

Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

Date Format Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of 
formats. 

Detail 

Color When time or date format is selected, the users can use this option 
to designate the display color.  

Example of Historical Event Table element:  

1. D1000=0   

2. D1000=1   

3. D1000=2   

4. D1000=3   

5. D1000=4   
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6. D1000=5   

7. D1000=6   

 
Fig. 3.12.4 Historical Event Table 
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3.13 Alarm Element 

 
Fig. 3.13.1 Alarm element options 

 

Table 3.13.1 Function of Alarm elements 

Element Type Icon Function 

Alarm History Table  

HMI will monitor and read the read address in a fixed time automatically. If one 
Bit contact of the address is ON, the alarm message will be converted to Alarm 
History Table element and display on the screen.  

Active Alarm List  

HMI will only display the current alarm message by using Active Alarm List 
element on the screen if some certain Bit contact of the corresponding address 
is ON. 

Alarm Frequency 

Table 
 

HMI will monitor and read the read address set. If some certain Bit contact of 
the address is ON, the ON frequency of the contact will be converted to Alarm 
Frequency Table element and display on the screen. 

Alarm Moving Sign  

HMI will only display the current alarm message by using Alarm Moving Sign 
element on the screen if some certain Bit contact of the corresponding address 
is ON. 

 Alarm History Table 

Table 3.13.2 Property Description of Alarm History Table Element 

Property Description of Alarm History Table Element  
HMI will monitor and read the read address in a fixed time automatically. If one Bit contact of the address is 
ON, the alarm message will be converted to Alarm History Table element and display on the screen.  
Background Color The background color of the following two elements is set to white and blackish green 

respectively.  

  The background color is set to white. 

 The background color is set to blackish green. 
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Property Description of Alarm History Table Element  

 
Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

Date Format Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of formats.

Alarm Number If this option is selected, when the alarm occurs, the alarm number that 
is designated in Alarm Setup dialog box will also be shown in front of 
the alarm message. Please refer to the figures below: 

 

 

Detail 

Color When time or date format is selected, the users can use this option to 
designate the display color.  

 Active Alarm List 

Table 3.13.3 Property Description of Active Alarm List Element 

Property Description of Active Alarm List Element  
HMI will only display the current alarm message by using Active Alarm List element on the screen if some 
certain Bit contact of the corresponding address is ON.  
Background The background color of the following two elements is set to white and yellow 

respectively.  

 The background color is set to white. 

 The background color is set to yellow. 
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Property Description of Active Alarm List Element  

 
Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

Date Format Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of formats.

Alarm Number If this option is selected, when the alarm occurs, the alarm number for 
the alarm message will always be shown ahead. Please refer to the 
figures below:  

 

Detail 

Color When Time and Date these two options are selected, the users can 
designate the display color by using this option.  

 Alarm Frequency Table 

Table 3.13.4 Property Description of Alarm Frequency Table Element 

Property Description of Alarm Frequency Table Element  
HMI will monitor and read the read address set. If some certain Bit contact of the address is ON, the ON 
frequency of the contact will be converted to Alarm Frequency Table element and display on the screen.  
Background Color The background color of the following two elements is set to white and yellow 

respectively. 

  The background color is set to white. 

 The background color is set to yellow. 

Detail 
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Property Description of Alarm Frequency Table Element  

Time Format Provide HH:MM:SS, HH:MM two kinds of formats. 

Date Format Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of 
formats. 

Alarm Number If this option is selected, when the alarm occurs, the time and 
date when the alarm occurred will also be shown in front of the 
alarm message. Please refer to the figure below: 

Display for Counting 
Zero 

Use this option to decide if show the message on the Alarm 
Frequency Table element or not when the occurring times of the 
alarm message is zero.  

Color When Time and Date these two options are selected, the users 
can designate the display color by using this option.  

 Alarm Moving Sign 

Table 3.13.5 Property Description of Alarm Moving Sign Element 

Property Description of Alarm Moving Sign Element  

HMI will only display the current alarm message by using Alarm Moving Sign element on the screen if some 
certain Bit contact of the corresponding address is ON.  

Border Color 
Background Color 

The background color of the element below is set to blue green and its border color is 
set to red. 

 
Standard Raised Sunken Transparent Style 

  

Moving Points It is used to set the movement of the moving sign. The unit is Pixel and the range is 
within 1 ~ 50 Pixels. 

Interval(ms) It is used to set the interval time between two movements. The unit is ms and the range 
is within 50 ~ 3000 ms. 

 

Detail 

Time Provide HH:MM:SS and HH:MM two kinds of display format.  
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Property Description of Alarm Moving Sign Element  

Date Provide MM/DD/YY, DD/MM/YY and DD.MM.YY three kinds of display 
format.  

Alarm Number If this option is selected, when the alarm occurs, the alarm number that 
is designated in Alarm Setup dialog box will also be shown in front of 
the alarm message. Please refer to the figures below: 

 
Color When Time and Date these two options are selected, the users can 

designate the display color by using this option.  
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3.14 Graphic Element 

Maybe the users need some graphics that are not provided. Therefore, the following basic graphic elements 

are for the users to create their own graphs or drawings. 

 
Fig. 3.14.1 Graphic element options 

 

 Line 

Table 3.14.1 Property Description of Line Graphic Element 

Property Description of Line Graphic Element  
Left-click the mouse to draw and edit the line graphic element. The users can click where the users want to 
start the line and drag across the work place on the screen. Then, release the mouse to finish the line. When 
selecting this line graphic element, the users can see a rectangle range and this is designed for the users to 
move and adjust the line more quickly and conveniently. The users can set line color, size and style in 
property table freely. The range out of the line graphic element itself will be displayed in transparent color.  

                
Line direction                     Line width (1 to 8) 

Line Color It is used to set the display color of the line element. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Line Style There are following line styles can be selected.  
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 Rectangle 

Table 3.14.2 Property Description of Rectangle Graphic Element 

Property Description of Rectangle Graphic Element  
Left-click the mouse to draw and edit the rectangle graphic element. The users can drag the mouse across 
work place on the screen until the rectangle is the size that the users want. Then, release the mouse to 
finish. The users can import the picture into the rectangle from picture bank and set rectangle color, size and 
style in property table. This option is a good choice for the users who just need to import some certain 
picture on the screen simply. 
Line Color It is used to set the display color of the rectangle element. 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color It is used to set the display color of the rectangle graphic element. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Transparent When this option is selected, the element will display only with the border and there is 
no color in the element. The Foreground Color option will be disabled also.  

Round Radius 0~38 pixels round radius are provided for selection. 

 

 Circle 

Table 3.14.3 Property Description of Circle Graphic Element 

Property Description of Circle Graphic Element  
The users can draw an ellipse or circle by using this option. The users can drag the mouse across work 
place on the screen until the ellipse or circle is the size that the users want. Then, release the mouse to 
finish. If the width and height of the circle graphic element are the same size, the circle graphic element will 
be a round shape circle. If the width and height of the circle graphic element are not the same size, it will be 
an ellipse element. When selecting this circle graphic element, the users can see a rectangle range and this 
is designed for the users to move and adjust the circle more quickly and conveniently. Changing the size of 
the rectangle range is changing the size of circle graphic element directly. The range out of the circle graphic 
element itself will be displayed in transparent color. There is a “Transparent” option in the element property 
table. Once Yes is selected, the element will display only with the border and there is no color in the element. 
If there is any other element under this circle graphic element, it will show up and can be viewed on the 
screen.  
 

  An ellipse that its “Transparent” setting in the property table is set to “No”. 
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Property Description of Circle Graphic Element  
 

    An circle that its “Transparent” setting in the property table is set to “No”. 
 

  An circle that its “Transparent” setting in the property table is set to “Yes”.  
 

 An ellipse that its “Transparent” setting in the property table is set to “Yes”. 
  
Line Color It is used to set the line color of the circle graphic element.  

Foreground Color It is used to set the display color of the circle graphic element. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Transparent When this option is selected, the element will display only with the border and there is 
no color in the element. The Foreground Color option will be disabled also.  

 Polygon 

Table 3.14.4 Property Description of Polygon Graphic Element 

Property Description of Polygon Graphic Element  
Left-click the mouse to determine each node of the polygon graphic element. The users can click where the 
users want to place the first node and drag the mouse across work place on the screen until the next node is 
decided and left-click the mouse again to determine the position of the next node. Repeat the above action 
until the polygon is the size that the users want. Then, right-click the mouse the mouse to finish. When 
selecting this polygon graphic element, the users can see a rectangle range and this is designed for the 
users to move and adjust the polygon more quickly and conveniently. Changing the size of the rectangle 
range is changing the size of circle graphic element directly. The range out of the circle graphic element itself 
will be displayed in transparent color. There is a “Transparent” option in the element property table. Once 
Yes is selected, the element will display only with the border and there is no color in the element. If there is 
any other element under this circle graphic element, it will show up and can be viewed on the screen. 
Line Color It is used to set the line color of the polygon graphic element. 



Chapter 3  Element Function|ScrEdit Software User Manual 

3-76   Revision 05/30/2006, EH00 

Property Description of Polygon Graphic Element  

Foreground It is used to set the display color of the polygon graphic element. Please refer to the 
figures below: 

             
The foreground color is set to blue.       The foreground color is set to turquoise. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 

Transparent When this option is selected, the element will display only with the border and there is 
no color in the element. The Foreground Color option will be disabled also. Please 
refer to the figures below: 

 A polygon that its “Transparent” setting in the property table is    
set to “No”. 

 

 A polygon that its “Transparent” setting in the property table is    
set to “Yes”. 

 Arc 

Table 3.14.5 Property Description of Arc Graphic Element 

Property Description of Arc Graphic Element  
Left-click the mouse to draw and edit the arc graphic element. The users can click where the users want to 
start the arc and drag across the work place on the screen. Then, release the mouse to finish the arc. There 
is a “Transparent” option in the element property table. If this option is set to Yes, it indicates that this 
element is an arc. If this option is set to No, it indicates that this element is a sector. The range out of the 
circle graphic element itself will be displayed in transparent color. 

                  
When “Transparent” is set to “No”                When “Transparent” is set to “Yes”. 

Line Color It is used to set the line color of the arc graphic element.  

Foreground Color It is used to set the display color of the arc graphic element. 

Line Size The unit is Pixel and the range is within 1 ~ 8. 
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Property Description of Arc Graphic Element  

Transparent When this option is selected, the element will display only with the border and there is 
no color in the element. The Foreground Color option will be disabled also.  

 Text 

Table 3.14.6 Property Description of Text Graphic Element 

Property Description of Text Graphic Element  
This text graphic element is used to create a text frame, and add and edit the text on the screen. The users 
can drag the mouse across work place on the screen until the text frame is the size that the users want and 
release the mouse to finish. Then, add and edit the text in the text frame. The foreground color is the color of 
the text frame (“Transparent” should be set to “No”). 
Text 
Text Size 
Font 
Text Color 

The users can set the text, text size, font and text color that provided by Windows® to 

determine the text display on the element. When the users press  button next to 
“Font”, the following “Font Detail Setting” dialog box will display. 

 
In “Font Detail Setting” dialog box, the users can select Font Name, Font Size and 
Ratio of the text and view the text format from the Preview window in advance. If the 
multi-language function is used, the users can see different language tabs and edit 
different language font setting in “Font Detail Setting” dialog box. Please refer to the 
example figure above. 

Foreground Color It is used to set the text frame color. Please refer to the figure below. The foreground 
color of this text graphic element is set to blue. 

 
Transparent When this option is selected, the element will display the text only and there is no 

color in the element. The Foreground Color option will be disabled also.  

 Scale 

Table 3.14.7 Property Description of Scale Graphic Element 

Property Description of Scale Graphic Element  

The users can change the scale direction, main and sub scale number, and grid color in the property table to 
create a special and unique scale graphic element. The “Display Mark” option can be used to determine if 
the scale value display next to the scale or not. The minimum and maximum of the scale value can be set in 
“Detail Setup” option. 
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Property Description of Scale Graphic Element  

Text Size 
Text Color 

The users can set the text size and text color that provided by HMI to determine the 
text display on the element. HMI provides 8~70 kinds of default text font for the users 
to use. 

Standard Rotation 90 Rotation 180 Rotation 270 Style 

 

Main Scale Please refer to the figures below: 

           
When main scale number is set to 2         When main scale number is set to 3 

Display Mark It is used to determine if the scale value display next to the scale or not. 

 
Date Length There are 16bits Word and 32bits Double Word two options. 

There are following data format provided: 

Word/Double Word 

Data Format 

1. BCD 
2. Signed Decimal 
3. Unsigned Decimal 

Minimum 

Maximum 

The users can set the minimum and maximum of input setting value 
to determine the range of input setting value.  

Integral Digits 

Fractional Digits 

Use this option to determine the digit number of integer and decimal 
fraction. The digit number is not a real digit number value. It is only 
the display format. The digit number will be a real decimal number 
only when the data format is selected as “Floating”.  

Detail Setup 

When the users have input the minimum and maximum value, after pressing OK 
button, HMI will examine the value by referring to the selected data length, data 
format, integral and fractional digits.  

Grid Color It is used to set the grid color of the scale graphic element. 
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Property Description of Scale Graphic Element  

SubScale Number When the main scale number is set to 3 and the subscale number is also used, the 
scale graphic element will display as the figures below: 

           
When subscale number is set to 1         When main scale number is set to 2 

 Table 

Table 3.14.8 Property Description of Table Graphic Element 

Property Description of Table Graphic Element  
The users can change the cell numbers of the table, appearance and color in the property table to create a 
special and unique table graphic element. If it is used with other elements, each element will display more 
completely on the screen.  
Background Color It is used to set the display color of the table scale element.  

 
Row Header It is used to the color of the first row of the table. The 

users can enable or disable this option by checking the 
check box next to “Row Header”. 

Header 

Col Header It is used to the color of the first column of the table. The 
users can enable or disable this option by checking the 
check box next to “Col Header”. 

Rows It is used to the color of the interlacing rows of the table. 
The users can enable or disable this option by checking 
the check box next to “Rows”. 

Columns It is used to the color of the interlacing rows of the table. 
The users can enable or disable this option by checking 
the check box next to “Rows”. 

Row Header It is used to the color of the interlacing row header of the 
table. The users can enable or disable this option by 
checking the check box next to “Row Header”. 

Detail Setup 

Interlacing  

Columns 
Header 

It is used to the color of the interlacing column header of 
the table. The users can enable or disable this option by 
checking the check box next to “Columns Header”. 
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Property Description of Table Graphic Element  

Sep. Rows 
Evenly 

It is used to distribute rows of the table evenly. Cell Setting 

Sep. Col 
Evenly 

It is used to distribute columns of the table evenly. 

Border Color It is used to set the border color of the table.  

Grid Color It is used to set the grid color of the table.  

Number of Rows The range is within 1 ~ 99. 

Number of Columns The range is within 1 ~ 99. 
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3.15 Keypad Element 

Table 3.15.1 Property Description of Keypad Element 

Property Description of Keypad (1) / (2) / (3) Element  
Provide three kinds of default keypad elements for selection. The users can select decimal, hexadecimal or 
character these three kinds of keypad according to difference application requirement. 

             
                  Keypad (1) Decimal Keypad                               Keypad (2) Hexadecimal Keypad  

           
                                                          Keypad (3) Character Keypad 
 
The users can redefine the display text of each button shown on the keypad. The other buttons, such as  
<ENT> (Enter), <CLR> (Clear), <DEL> (Delete) and <ASCII> (Input Character) can also be renamed 
flexibly. Please refer to the following figure below: 

 
The keypad is displayed in a “Group” on the screen. The users can use “Ungroup” command from “Edit”
menu bar to ungroup all the buttons. Then, the users move and change the button size freely. At this time, 
the users can redefine the display text shown on the button in the property table. When the “Text” option is 
inputted as number “1”, the display text on the button will be “1”. If the users refine it as number “2”, the 
display text will be changed to “2”. If it is refined as character “A”, the display text will be changed to “A”. If it 
is changed to character “%“, the display text will be changed to “%” and vise versa.  
 
The input character will be sent to Active Numeric Entry element or Active Character Entry element. For 
these two kinds of elements, the users have to set the Input Mode  as “Active” option and set InterLock 
Address. Please refer to Table 3.10.2 & Table 3.10.3 for the property description of Numeric / Character 
Entry elements.  
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Property Description of Keypad (1) / (2) / (3) Element  

Text 
Text Size 
Font 
Text Color 

The users can set the text, text size, font and text color that provided by Windows® to 

determine the text display on the element. When the users press  button next to 
“Font”, the following “Font Detail Setting” dialog box will display. 

 
In “Font Detail Setting” dialog box, the users can select Font Name, Font Size and 
Ratio of the text and view the text format from the Preview window in advance. If the 
multi-language function is used, the users can see different language tabs and edit 
different language font setting in “Font Detail Setting” dialog box. Please refer to the 
example figure above. 

Picture Bank Name 
Picture Name 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Transparent Effect 
Transparent Color 

(Please refer to Table 3.2.2 Property Description of General Buttons.) 

Foreground Color 
Style 

There are Standard and Raised these two options.  

   (When the style is selected as Standard and the foreground color is set to 
green.) 

   (When the style is selected as Raised and the foreground color is set to red.)

The users can redefine the buttons of the keypad 

Display Display text or character 

Mode 

Detail Setup 

 

The are following modes provided:: 
1. <ENT>  Enter 
2. <CLR>  Clear 
3. <DEL>  Delete 
4. <ASCII> Character 
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Example for Creating a Keypad Element: 

1. Create the following elements first 

 

The created elements are: one Keypad (1) element, one Momentary button, three numeric entry 

elements and three numeric display elements. 

2. Related Element Property Description 

Element Property Description 

Keypad (1) Reserve the default value. The users can also change the display text.  

Momentary button The write address is set to Internal memory $10.1. The main function is 
used to enable the following numeric entry elements and let them receive 
the input value.  

Numeric Entry (Left) The write address is set to Internal memory $0, Input Mode is set to Active 
and the InterLock Address is set to $10.1. When the Momentary button is 
pressed, the numeric entry element will prepare to receive the input value. 
After the users press the Enter button, the numeric entry element will blink 
and it indicates that the numeric entry element is receiving the input value. 
When the value is received completely, the numeric entry element will 
stop blinking. In the figure below, the Numeric Entry (Left) will blink first. 
When the input value is transferred to the next element, the next element 
will blink next and vise versa.  
Please refer to the following figure: 

 
The element blinking order is determined by the order of creating 
elements. 

Numeric Entry (Middle) The write address is set to Internal memory $1, Input Mode is set to Active 
and the InterLock Address is set to $10.1. 

Numeric Entry (Right) The write address is set to Internal memory $2, Input Mode is set to Active 
and the InterLock Address is set to $10.1. 

Numeric Display (Left) The read address is set to Internal memory $0.  

Numeric Display (Middle) The read address is set to Internal memory $1. 

Numeric Display (Right) The read address is set to Internal memory $2. 
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Chapter 4  Macro Function 

Macro editing is a function in which allows the users to perform programming like programming in BASIC 

language. It provides the same language syntax as BASIC. It can also reduce the PLC program editing. 

Therefore, Macro is a very convenient function for the HMI users to use. After editing Macro, the users can 

test the Macro validity via either on-line simulation or off-line simulation on PC before downloading to HMI. 

The lines number for each macro is 512 lines and 128 words (max.) for writing comments or strings in a line. 

The sub-macro number is 512 sub-macros (number is 1-512). See Fig. 4.1 and Fig. 4.2. 

 

 

Fig. 4.1 
The users can comment each macro by sub-macro 
function for the convenience of management, 
maintain and operation. The initial name of all sub-
macro is Sub-macro (n) (n is from 1 to 512).  

 

Fig. 4.2 
The left-most field in the left window is sub-macro 
number. There are 512 sub-macros for editing. The 
users can write “CALL n (n is from 1 to 512)” to use 
sub-macro. 
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4.1 Macro Type 

 

Fig. 4.1.1 Choosing Macro command from menu bar 

 

Macro Name Numbers Remark 

Screen open Macro 1 There is a screen open macro for each screen. Therefore, there are n 
screen open macros for n screen.  

Screen close Macro 1 There is a screen close macro for each screen. Therefore, there are n 
screen close macros for n screen. 

Screen Cycle Macro 1 There is a screen cycle macro for each screen. Therefore, there are n 
screen cycle macros for n screen 

Initial Macro 1 There is only an initial Macro in a program.  
Background Macro 1 There is only an background Macro in a program.  

Clock Macro 1 There is only an clock Macro in a program. 
On Macro 1 The users can have an ON Macro for each specific button. 
Off Macro 1 The users can have an OFF Macro for each specific button. 
Sub-macro 512 There are only 512 sub-macros for a program.  

Table 4.1.1 Macro command table 

 Screen Open Macro 

The users can use open Macro to open each screen. Screen Open Macro will only be executed ONCE 

when you open screen (or switch to new screen) and finish execution ONCE. The screen element will 

be displayed after finishing executing Screen Open Macro. Therefore, the users need to pay close 

attention on designing Screen Open Macro to avoid infinite loop (program cannot be ended) as it may 

cause system delay or even cannot execute screen’s elements permanently. It is not recommended to 

write too long macro unless necessary. Please pay close attention on loop usage and test Macro with 

on-line/off-line simulation before downloading to HMI. 
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 Screen Close Macro 

The users can use close Macro to close each screen. Screen Close Macro will only be executed ONCE 

when you close screen and finish execution ONCE. The Screen Open Macro of new screen will be only 

executed after finishing Screen Close Macro. Therefore, the users should also be careful for infinite 

loop (program cannot be ended) to avoid unexpected error.  

 Screen Cycle Macro 

The users can use cycle Macro to cycle each screen. Screen Cycle Macro will only be executed ONCE 

when you change screen and the macro will be executed continuously until the screen is changed, 

program or machine is stopped. Therefore, it is not recommended to write too long macro unless 

necessary.  

 Initial Macro 

There is only one initial Macro in a program or a machine. It is executed in the beginning of program. 

The users can preset value to omit step-by-step settings and also control initial setting to avoid 

unexpected problem by unknown initial value. If the users need to setup any special setting in PLC 

special address, the users can use initial macro to set it. It saves much time with well-designed initial 

macro.  

 Background Macro 

There is only one initial Macro in a program or a machine. It will be executed continuously like 

background. But the execution of Background Macro is to execute one or more commands at a time, 

not finish the execution ONCE. If there is other executed Macro, such as cycle macro, it won’t have any 

influences. They are executed almost simultaneously (In fact, it is executed one by one physically. 

Since the execution time is so quick, it makes people feel that is executed simultaneously). The users 

do not need to write loop for continuous execution. Even the users writes END command for Macro it 

will still execute Macro again. 

 Clock Macro 

There is only an initial Macro in a program or a machine. It will be executed continuously, finish the 

execution ONCE and be executed again like cycle macro. Therefore, the same, it is not recommended 

to write too long macro unless necessary.  

 On Macro 

The users can use ON Macro for each specific button (Bit). It is called ON Macro because this start 

Macro is set to ON via setting the button (Bit). This Macro is also executed ONCE and finished 

executing ONCE. It will be started again when this button (Bit) is set to be ON again. The ON Macro will 

be only started when the button (Bit) is set to be ON and pressed button to be ON.  
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 Off Macro 

The users can use OFF Macro for each specific button (Bit). Same as ON Macro, OFF Macro is started 

via setting this button (Bit). This Macro is also executed ONCE and finished executing ONCE. It will be 

started again when this button (Bit) is set to be OFF again. The OFF Macro will be only started when 

the button (Bit) is set to be OFF and pressed button to be OFF.  

 Sub-macro 

There are 512 sub-macros for editing. Sub-macro is similar to the subroutine in the in program. The 

users can write repeated action or function in sub-macro to save macro editing time and easy maintain. 

That means the users can write a sub-macro to make it functions as a specific 10 sub-macros. For 

example, a function is written named sub-macro 1, the users only need to write “CALL 1” in Macro 

whenever it is used.  In this case, the users need only modify this sub-macro instead of modifying 10 

macros if necessary. The sub-macro can be named by its function for easy management. 

 

4.2 Macro Editing 

After choosing the desired Macro command from menu bar, the users can start editing Macro by clicking any 

line shown as Fig. 4.2.1 below. The Macro command dialog box will pop up when any line is clicked. The 

Macro editing window will be different by clicking position. For the users’ convenience, the most left number 

is line number.  

 
Fig. 4.2.1 Start editing Macro 

The users can also use the icons on the toolbars (Fig. 4.2.2) for Macro editing. 

Refer to Fig. 4.2.3, 512 lines (from 1 to 512) are available for editing Macro. Blank line in the program means 

that line will be set to comment line after updating as shown in Fig. 4-2-4.  

 

 

 

 

Editing 
Window 

Macro 
Command 
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Fig. 4.2.2 Toolbar 

 

Fig. 4.2.3 Last line of Macro 

 

Fig. 4.2.4 Blank line becomes comment line 

 

 

 

Open old 
Macro files

Save Macro files 

To previous line Macro command 
dialog box 

Insert / Replace 

To next line 

Insert a line

Delete a line 
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Once the editing Macro starts, the Macro command editing window will pop up (Fig. 4.2.5) by clicking any 

lines in the Macro. The users can determine the command that the users need by pressing the command 

button or clicking command from menu bar. Then, the users only need to move the mouse cursor to the 

position of the command and all the commands will display. At this time, the users can start to edit Macro. 

Refer to the following sections for Macro editing methods.  

 

Fig. 4.2.5 Macro command editing window 

 File 

 Open Macro 

ScrEdit provides open old macro function for the convenience of editing macro. The users can open old 

Macro files when using any PLC brand to save Macro editing time without re-input. Refer to Fig. 4.2.6 

for Open Macro window. 

 

Fig. 4.2.6 Open Macro 

 Save As Macro 

ScrEdit also provides “Save As” function for the users to modify old macro and save macro as other 

macro to backup or save re-input time of other macro commands.  
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Fig. 4.2.7 Save As Macro 

 Edit 

The users can edit Macro via edit option in Macro Command dialog box. If it is PLC address, it will be in 

bracket to distinguish with internal memory.  

 
Fig. 4.2.8 Edit 

 Previous 

 

Move the selected line to the upper line of macro and the upper line of macro will move backward a line. 

 Next 

 

Move the selected line to the lower line of macro and the lower line of macro will move forward a line. 
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 Update 

 

Update the current line of macro. The modification will not be updated if “update” is not pressed after 

editing. This gives user a second chance to decide to modify or not.  Therefore, if the users forget to 

update after editing, the users should re-do again.  

 Insert 

 

Insert the editing macro between two lines of macro. After inserting a new line, the existing line of 

macro will move backward a line. 

 Delete 

 

Delete the selected line. Lines after the delete line will be pushed upward after delete.  

 Comment 

 

Any comments or equations can be given for any lines to read/modify macro easily. The users can 

choose the desired text, characters or any symbols from menu bar or toolbar. 

 Command 

The users can use commands to edit the macro. No matter the command and equation all can be typed 

directly, or chosen from menu bar, or be selected by clicking button “Command”. For the detailed 

options of Command, please see Fig. 4.2.9 to Fig. 4.2.18. 

    
Fig. 4.2.9  

Commands options 
Fig. 4.2.10 
Arithmetic 

Fig. 4.2.11 
Logical 

Fig. 4.2.12 
Data transfer 
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Fig. 4.2.13  

Data conversion 
Fig. 4.2.14 

Comparison 
Fig. 4.2.15 

Flow control 
Fig. 4.2.16 
Bit setting 

    

Fig. 4.2.17 
Communication 

Fig. 4.2.18 
Others   

 Keypad 

For the convenience of editing macro, ScrEdit allows the users to edit Macro by using keypad (key in 

manually). ScrEdit will check the validity automatically. If there are any errors, a warning dialog box will 

pop up to remind the users. There are no limit spaces between operand and operation symbol for the 

users to key in. After finishing inputting, ScrEdit will convert the macro to the best format automatically 

after updating the macro or pressing Enter key. But please notice that ScrEdit has not verified the 

macro yet at this time.  

4.3 Macro Operation 

 Definition 

WORD 16 Bit data (It is made up of continuous 2 bytes, i.e. 16 bits, b15~b0. It can be used to 

represent 0000~FFFF of hexadecimal system. 

DWORD, DW 32 Bit data (It is made up of continuous 2 words, i.e. 32 bits, b31~b0. It can be used to 

represent 00000000~FFFFFFFF of hexadecimal.) 

BYTE 8 Bit data (It is made up of continuous 2 nibbles, i.e. 8 bits, b7~b0. It can be used to 

represent 00~FF of hexadecimal system.) 

Signed A signed value is a numeric value with polarity. It means that the value is interpreted as 

essentially the 'plus' sign that can be found in front of a positive number and the 

'minus' sign that can be found in front of a negative number.  
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 Arithmetic Operation 

Arithmetic Operation divides into two parts: Integer Operation and Floating Point Operation.  

Each operand can be internal memory or constant. But it shall be internal memory only when outputting. 

Please refer to following table 4.3.1 and examples below for more information. 

Command Equation Description Remark 

+ V1=V2 + V2 Addition 

- V1=V2 - V3 Subtraction 

* V1 = V2 * V3 Multiplication 

/ V1 = V2 / V3 Division 

In
te

ge
r O

pe
ra

tio
n 

% V1 = V2 % V3 Get Remainder 

The calculation result can 
be stored as signed or 
unsigned WORD and 
DWORD. 
When the data exceeds 
the length of designated 
unit, the data out of range 
will be discarded. 

FADD V1=FADD(V2, V3) Addition 

FSUB V1=FSUB(V2, V3) Subtraction 

FMUL V1=FMUL(V2, V3) Multiplication 

FDIV V1=FDIV(V2, V3) Division 

Fl
oa

tin
g 

P
oi

nt
 

O
pe

ra
tio

n 

FMOD V1=FMOD(V2, V3) Get Remainder 

Floating Point Operation is 
the operation of signed 32 
Bit data. 

Table 4.3.1 Arithmetic command table 

 +, FADD 

Addition  

Equation: V1 = V2 + V3[(Signed | DW)] 

 V1 = FADD(V2, V3) (Signed DW) 

Perform the addition on V2 and V3, and store the addition result in V1. 

Example: 

The value contained within the internal memory address #2 plus 1 

$2 = $2 + 1 

The values contained within the internal memory address #1 and #2 are combined and the total is 

stored in the address #3. 

$3 = $2 + $1 

The value contained within the internal memory address #4 plus 1.9 

$4 = FADD($4, 1.9) 

The floating point values contained within the internal memory address #4 and #5 are combined and 

the total is stored in the address #6. 

$6 = FADD($5, $4) 
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 -, FSUB 

Subtraction 

Equation: V1 = V2 - V3[(Signed | DW)] 

 V1 = FSUB(V2, V3) (Signed DW) 

Perform the subtraction of V2 and V3, and store the subtraction result in V1. 

Example： 

Subtract 1 form the value contained within the internal memory address #2 

$2 = $2 - 1 

The value contained within the internal memory address #1 is subtracted from the value contained 

within the internal memory address #2 and the result of this calculation is stored in the internal memory 

address #3. 

$3 = $2 - $1 

Subtract 1.9 form the value contained within the internal memory address #4 

$4 = FSUB($4, 1.9) 

The floating point value contained within the internal memory address #4 is subtracted from the floating 

point value contained within the internal memory address #5 and the result of this calculation is stored 

in the internal memory address #6. 

$6 = FSUB($5, $4) 

 *, FMUL 

Multiplication 

Equation: V1 = V2 * V3[(Signed | DW)] 

 V1 = FMUL(V2, V3) (Signed DW) 

Perform the multiplication of V2 and V3, and store the multiplication result in V1. 

Example: 

The value contained within the internal memory address #2 multiplied by 2 

$2 = $2 * 2 

The value contained within the internal memory address #2 multiplied by #1 and the result of this 

calculation is stored in the address #3. 

$3 = $2 * $1 

The value contained within the internal memory address #4 multiplied by 1.5 

$4 = FMUL($4, 1.5) 

The floating point value contained within the internal memory address #4 multiplied by #5 and the result 

of this calculation is stored in the address #6. 

$6 = FMUL($5, $4) 
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 /, FDIV 

Division 

Equation: V1 = V2 / V3[(Signed | DW)] 

 V1 = FDIV(V2, V3) (Signed DW) 

Perform the division of V2 and V3, and store the division result in V1. The value contained 

within V3 cannot be equal to 0(zero). 

Example: 

Subtract 1 form the value contained within the internal memory address #2 

$2 = $2 - 1 

The value contained within the internal memory address #2 divided by 5 and the result of this 

calculation is stored in the address #3. 

$3 = $2 / 5 

Subtract 1.9 form the value contained within the internal memory address #4 

$4 = FSUB($4, 1.9) 

The value contained within the internal memory address #4 divided by 4.3 and the result of this 

calculation is stored in the address #6. 

$6 = FDIV($4, 4.3) 

 %, FMOD 

Get Remainder 

Equation: V1 = V2 % V3[(Signed | DW)] 

 V1 = FMOD(V2, V3) (Signed DW) 

Perform the division of V2 and V3, and store the remainder in V1. The value contained within V3 

cannot be equal to 0(zero). 

Example: 

Subtract 1 form the value contained within the internal memory address #2 

$2 = $2 - 1 

The value contained within the internal memory address #2 divided by 5 and the remainder of the result 

of this calculation is stored in the address #3. 

$3 = $2 % 5 

Subtract 1.9 form the value contained within the internal memory address #4 

$4 = FSUB($4, 1.9) 

The value contained within the internal memory address #4 divided by 4 and the remainder of the result 

of this calculation is stored in the address #6. 

$6 = FMOD($4, 4) 
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 ADDSUMW 

Repeated Addition 

Equation: V1 = ADDSUMW(V2, V3)[(DW)] 

Perform the addition on V2, V2+1, V2+2, …, V2+V3, and store the repeated addition result in V1. 

Example: 

$2 = 1 

$3 = 2 

$4 = 3 

$5 = 3 

$0 = ADDSUMW($2, $5) 

Add up the values contained within the internal memory address #2, #3, #4 and #5 (3 Words started 

from address #2) and the grand total is stored in the address #0. The value of the grand total is equal to 

6. 

 Logical Operation 

Six logical operations includes OR, AND, XOR, NOT, Shift-left and Shift-right. SHR. There are three 

operands for each operation. Each operand can be internal memory or constant. But it shall be internal 

memory only when outputting. The unit can be Word and Double Word. Please refer to following table 

4.3.2 and examples below for more information. 

Command Equation Description Remark 
| V1 = V2 | V3 Logical OR operation 

&& V1 = V2 && V3 Logical AND operation 
^ V1 = V2 ^ V3 Logical XOR operation  

NOT V1 = NOT V2 Logical NOT operation 
<< V1 = V2 << V3 Logical Shift-left operation 
>> V1 = V2 >> V3 Logical Shift-rightt operation

The calculation result can be 
stored as WORD and 
DWORD. 
 

Table 4.3.2 Logical operation command table 

 | Operand 

Logical OR operation  

Equation: V1 = V2 | V3[(DW)] 

Perform the logical OR operation on V2 and V3 and save the result of this calculation in V1. 

Example: 

$2 = F000H 

$4 = 0F00H 

$2 = $2 | $4 

Store the result of $2 in FF00H 
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 && Operand 

Logical AND operation 

Equation: V1 = V2 && V3[(DW)] 

Perform the logical AND operation on V2 and V3 and save the result of this calculation in V1. 

Example: 

$2 = F000H 

$4 = 0F00H 

$2 = $2 && $4 

Store the result of $2 in 0000H 

 ^ Operand 

Logical XOR operation 

Equation: V1 = V2 ^ V3[(DW)] 

Perform the logical XOR operation on V2 and V3 and save the result of this calculation in V1. 

Example: 

$2 = F100H 

$4 = 0F00H 

$2 = $2 ^ $4 

Store the result of $2 in FE00H 

 NOT 

Logical NOT operation 

Equation: V1 = NOT V2 [(Signed | DW)] 

Perform the logical NOT operation on V2 and V3 and save the result of this calculation in V1. 

Example: 

$2 = F100H 

$4 = NOT $2 

Store the result of $$ in 0EFFH 

 << Operand 

Logical Shift-left operation 

Equation: V1 = V2 << V3[(DW)] 

Shift V2 (WORD/DWORD) data to left (number of bit is V3). The result of this calculation is 

stored in V1. 

Example: 
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$2 = F100H 

$2 = $2 << 4 

$2 shift-left 4 bits and becomes 1000H 

 >> Operand 

Logical Shift-right operation 

Equation: V1 = V2 >> V3[(DW)] 

Shift V2 (WORD/DWORD) data to right (number of bit is V3). The result of this calculation is 

stored in V1. 

Example: 

$2 = F100H 

$2 = $2 >> 4 

$2 shift-right 4 bits and becomes 0F10H 

 Data Transfer 

There are five commands for data transfer, including =, BMOV, FILL, CHR and FMOV. Please refer to 

following table 4.3.3 and examples below for more information. 

Command Equation: Description Remark 

= V1 = V2 Transfer data Data type for V1 only can be 
P, M 

BMOV BMOV(V1, V2, V3) Block move Data type for A1 and A2 only 
can be P, M 

FILL FILL(V1, V2, V3) Fill the memory  
CHR CHR(V1, "V2") Convert text to ASCII code V2 is a input string of texts 

FMOV V1 = FMOV(V2) Transfer floating point data  

P- PLC address, M- Internal memory, C- Constant 

Table 4.3.3 Data transfer command table 

 = Operand 

Transfer data 

Equation: V1 = V2[(Signed DW | DW)] 

Transfer data from V2 to V1. No data change within A2 after executing MOV command. 

Example: 

The data within the internal memory address $0 is designated the constant 4. 

$0 = 4 

The data within the internal memory address #4 is designated the same as the data within the internal 

memory address $2. 

$4 = $2 
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 BMOV 

Block move Copy Block 

Equation: BMOV(V1, V2, V3) 

BMOV (V1, V2, V3) means to move data (number of word is A3) of data from address V2 to 

address V1 in block. Data format is word. If the block length is more than internal memory or 

max number of PLC register, there will be error when compiling. 

Example: 

Move the data in $0, $1, $2, $3, $4 to $10, $11, $12, $13 in order. Total the same 4 Words. 

$0 = 1 

$1 = 2 

$2 = 3 

$3 = 4 

BMOV($10, $1, 4) 

After executing BMOV command, $10=1, $11=2, $12=3, $13=4. 

 FILL 

Fill the Memory 

Equation: FILL(V1, V2, V3) [(Signed)] 

FILL(V1, V2, V3) means to fill address V1 with data in address V2 and the data number is V3. If 

the block length is more than internal memory or max number of PLC register, there will be 

error when compiling. 

Example: 

$5 = 10 

FILL($0, $5, 4) 

Executing FILL command to fill $0, $1, $2, $3 with constant 10. 

 CHR 

Convert Text to ASCII code 

Equation: CHR(V1, "V2") 

CHR(V1, "V2") means to convert text in address V2 to ASCII code and store in V1. The max 

length is 128 words. 

Example: 

CHR($1, "AB12") 

After executing CHR command, 4241H will be stored in $1 and 3130H will be stored in $2. 
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 FMOV 

Transfer Floating Point Data 

Equation: V1 = FMOV(V2) (Signed DW) 

Transfer floating point data from V2 to V1. No data change within V2 after executing FMOV 

command.  

Example: 

Transfer constant 44.3 to the internal memory address $0. 

$0 = FMOV(44.3) (Signed DW) 

Transfer the same data of PLC 1@X0 to the internal memory address $0. 

$0 = FMOV(1@X0) (Signed DW) 

 Data Conversion 

Command Equation Description 

BCD V1 = BCD(V2) Converts BIN Data into BCD 

BIN V1 = BIN(V2) Decimal value conversion  

W2D V1 = W2D(V2) Convert WORD to DWORD 

B2W V1 = B2W(V2, V3) Convert BYTE to WORD 

W2B V1 = W2B(V2, V3) Convert WORD to BYTE 

SWAP SWAP (V1, V2, V3) Swap BYTE data 

XCHG XCHG (V1, V2, V3) Exchange data 

MAX V1 = MAX(V2, V3) Get Maximum value 

MIN V1 = MIN(V2, V3) Get Minimum value 

A2H V1 = A2H(V2) Convert ASCII code to 4-digit integer  

H2A V1= H2A (V2) Convert hexadecimal integer to ASCII code 

FCNV V1= FCNV (V2) Convert integer to floating point value  

ICNV V1= ICNV (V2) Convert floating point value to integer 

Table 4.3.4 Data conversion command table 

 BCD 

Convert BIN Data into BCD value 

Equation: V1 = BCD(V2) [(DW)] 

The binary data in V2 is converted into BCD value, and stored in V1. 

Example: 

The binary data in $4 is 5564. After executing BCD command, the binary data in $4 is converted to 

5564H. 

$4 = 5564 

$4 = BCD($4) 
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 BIN 

Converts BCD Data into BIN value 

Equation: V1 = BIN(V2) [(DW)] 

The BCD data in V2 is converted into BCD value, and stored in V1. 

Example: 

The BCD (hexadecimal) data in $4 is 5564H. After executing BIN command, the BCD data in $4 is 

converted to 5564. 

$4 = 5564H 

$4 = BIN($4) 

 W2D 

Convert WORD to DWORD 

Equation: V1 = W2D(V2) [Signed] 

The WORD value in V2 is converted into DWORD value, and stored in V1. 

Example: 

The WORD value in decimal format in $4 is -7. After executing W2D command, the value in $7 is 

converted to -7. 

$4 = -7 

$7 = W2D($4)(Signed) 

 B2W 

Convert BYTE to WORD 

Equation: V1 = B2W(V2, V3) 

Convert BYTE data (number of byte is V3) from V2 to WORD value and store the result in V1. 

The high byte will be filled with 0. In other words, that each word of V2 is two bytes. These two 

bytes will be converted to two words and stored in V1.  

Example: 

Assume that the value of $65534 is 12. That means converting 12 BYTES (6 WORDS) to 12 WORDS 

from $785 and store the result in $10 to $21. 

$10=B2W($785, $65534） 

 W2B 

Convert WORD to BYTE 

Equation: V1 = W2B(V2, V3) 

Convert WORD data (number of word is V3) from low-byte of V2 to BYTE format (discard high-

byte of V2) and store the result in V1.  
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Assume that the value of $985 is 12. It means to read 12 WORDS from low-byte of $986 and convert 

these 12 WORDS to 12 BYTES (6 WORDS) and store the result in $65 to $70. 

$65= W2B($986, $985) 

 SWAP 

Swap BYTE Data 

Equation: SWAP (V1, V2, V3) 

Swap high-byte and low-byte of V2, V2+1, V2+2…V2+V3 (WORD) and store the result in the 

starting position of V1, V1+1, V1+2…V1+V3 in order. 

Example: 

Swap the high-byte and low-byte of $10, $11, …, $14 and store the result in $1, $2, .., $5 in order. 

SWAP($1, $10, 5) 

If $11 = 1234H, after executing SWAP command, $2 = 3412H. 

 XCHG 

Exchange Data  

Equation: XCHG (V1, V2, V3)[(DW)] 

Exchange the data of V2, V2+1, V2+2…V2+V3 and the data of V1, V1+1, V1+2.., V1+V3. The data 

of V1 and V2 will be exchanged after executing XCHG command. 

Example: 

Exchange the data of $10, $11, …, $14 and the data of $1, $2, .., $5 in order. 

XCHG($1, $10, 5) 

If $11 = 1234H and $2 = 5678H, $2 = 1234H and $1 = 5678H after executing XCHG command. 

 MAX 

Get Maximum Value  

Equation: V1 = MAX(V2, V3)[ (Signed DW | DW)] 

Get the maximum value from V2 and V3 and store the result in V1. 

Example: 

$0 = 0 

$1 = 2 

$2 =10 

$0 = MAX($1, $2) 

The result  $0 = 10 
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 MIN 

Get Minimum Value  

Equation: V1 = MIN(V2, V3)[ (Signed DW | DW)] 

Get the minimum value from V2 and V3 and store the result in V1. 

Example: 

$0 = 0 

$1 = 2 

$2 =10 

$0 = MIN($1, $2) 

The result  $0 = 2 

 A2H 

Converts 4 ASCII code to a four digits integer in hexadecimal format 

Equation: V1 = A2H(V2) 

Convert the ASCII code of V2 (4 WORDS) to integer and store the result in V1. 

Example: 

$10 = 0034H 

$11 = 0033H 

$12 = 0036H 

$13 = 0038H 

$1 = A2H($10) 

After executing A2H command, the data in $1 will be converted to 4368H. 

 H2A 

Converts four digits integer in hexadecimal format to 4 ASCII code 

Equation: V1= H2A (V2) 

Convert V2 (1 WORD in hexadecimal format) to the ASCII (4 WORDS) code and store the result 

in V1. 

Example: 

$2 = 1234H 

$10 = H2A($2) 

After executing H2A command, $10=0031H, $11=0032H, $12=0033H and $13=0034H. 
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 FCNV 

Convert integer to floating point value 

Equation: V1= FCNV (V2)(Signed DW) 

Convert floating point value or integer in V2 to floating point value and store in V1.  

Example: 

$2 = 100 

$1 = FCNV($2)(Signed DW) 

The result  $1 = 100.0 

 ICNV 

Convert floating point value to integer  

Equation: V1= ICNV (V2) 

Convert floating point value or integer in V2 to integer and store in V1.  

Example: 

FMOV($2, 100.5) 

$1 = ICNV ($2)(Signed DW) 

The result  $1 = 100 

 Comparison 

 IF…THEN GOTO LABEL … 

Equation: IF expression THEN GOTO LABEL identifier 

If the command of expression is true, then it will go to LABEL identifier perform the program. 

Please refer to the following table for the command of expression. 

Command Description Remark 
V1 == V2 V1 is equal to V2 
V1 != V2 V1 is not equal to V2 
V1 > V2 V1 is greater than V2 

V1 >= V2 V1 is greater than or equal to V2 
V1 < V2 V1 is smaller than V2 
V1<= V2 V1 is smaller than or equal to V2 

V1 && V2 == 0 
Perform AND command on V1 andV2 
and the result of AND operation is equal 
to 0 

V1 && V2 != 0 
Perform AND command on V1 andV2 
and the result of AND operation is not 
equal to 0 

V1== ON V1 is ON 
V1== OFF V1 is OFF 

V1 and V2 should be 
internal memory or 
constant. 

Table 4.3.5 Comparison command table 
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Example: 

When $2 is greater than or equal to 10, it will go to LABEL 1 and continue to perform the program.  

IF $2 >= 10 THEN GOTO LABEL 1 

….. 

LABEL 1 

….. 

 

Equation: IFB V1 == {ON | OFF} THEN GOTO LABEL identifier 

If V1 is ON or OFF, it will go to LABEL identifier to perform the program. V1 is PLC address. 

Example: 

IFB 1@X0 == ON THEN GOTO LABEL 1 

 

 IF…THEN CALL … 

Equation: IF V1 == V2 THEN CALL macro 

If V1 is equal to V2, it will call macro. V1 and V2 should be internal memory or constant. 

Example 

If $2 is equal to 10, then it will cal sub-macro 1. 

IF 10 = $2 THEN CALL 1 

 

 IF…ELSE…ENDIF 

Equation: 

IF expression1 

Statement1 

ELSEIF expression2 

Statement2 

ELSE 

Statement3 

ENDIF 

This is logical determination from multiple conditions. If expression1 is true, Statement1 will be 

executed. If expression1 is false, it will run expression2. If expression 2 is true, Stemenent2 will be 

executed. If both expression 1 and expression 2 are false, Statement3 will be executed. 

For the command of expression, please refer to table 4.3.5 (Comparison command table). 

Example 

If $1 is smaller than 100, $1 = $1 + 1 is executed. Otherwise $1 = $1 + 10 is executed. 
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IF $1 < 100 

$1 = $1 + 1 

ELSE 

$1 = $1 + 10 

ENDIF 

 Flow Control 

There are five types for flow control: GOTO, LABEL, CALL..RET, FOR…NEXT and END. 

 GOTO 

Unconditionally go to a specific Label. GOTO command will jump to designated label like Label V1 

unconditionally. 

Equation: GOTO LABEL V1 

Go to the internal designated Label V1 in the program unconditionally.  

Example: 

Go to the position of designated Label 2 and continue to execute the program unconditionally.  

GOTO LABEL 2 

….. 

LABEL 2 

 

 LABEL 

Label such as Label V1 

Equation: LABEL V1 

Please notice that the label cannot be repeated in a Macro. 

Example: 

Go to the position of designated Label 2 and continue to execute the program unconditionally.  

GOTO LABEL 2 

….. 

LABEL 2 

….. 

The Label 2 is repeated. An error will occur at this time to warn the users to indicate it is illegal. 

LABEL 2 

….. 
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Main
Macro

Sub-Macro
A1

CALL

RET

 CALL..RET 

Call Sub-macro program 

Equation: CALL V1 

V1 represents the sub-macro number. The sub-macro number could be 001 ~ 512 and V1 should be 

internal memory address or constant. 

 

 

 
Fig. 4.3.1 

The rights of macro control will be transferred to sub-macro after 

CALL V1 command is executed. V1 needs to return through RET 

command. RET command will transfer the rights of macro control 

to the next command of CALL command. The sub-macro number 

could be 001 ~ 512 and the users also can name it freely. In the 

sub-macro program, the users also can CALL another sub-macro 

but the levels for CALL sub-macro should be less than 6 levels 

due to memory limit and also for avoiding unexpected error. 

 FOR…NEXT 

Program Loop 

Equation: 

FOR V1 

Statement 

NEXT 

It is for nested loops. ”FOR” is the start of loop and ”NEXT” is the end of loop. The nested loop can up 

to 5 levels max. V1 can be the internal memory or constant. When this command is executed, the 

number of V1 Statement will be executed continuously. Statement is the combination of a section of 

macro commands and also can be within the nested loop. The users can change V1 value through 

command, but the number of times cannot be changed. 

Example: 

$10 = 10 

$1 = 0 

FOR $10 

$1 = $1 + 1 

$10 = 2 

NEXT 

After the operation, the result is $1 = 10, $10 = 2.  

Please notice that the loop times will not change even the users reset the value within $10. 
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 END 

End the macro  

Equation: 

Statemenets1 

END 

Statements2 

End command is used to end the macro program. Statements2 will not be executed after Statemenets1 

is executed. The program will execute from the command of the first line next time. Please notice that 

END means finishing executing macro. If END command is used in sub-macro, it indicates the program 

is end here. 

Example: 

$1 = 10 

$1 = $1 + 1 

END 

$1 = $1 + 1 

After the operation, the result is $1 = 11, not $1 = 12 as the END command has ended the macro 

program.  

 Bit Setting 

There are four settings for BIT settings: SETB, CLRBL, INVB and GETB.  

Command Equation Description 
SETB SETB V1 Set V1 Bit to be ON 

CLRBL CLRB V1 Set V1 Bit to be OFF 
INVB INVB V1 Set V1 Bit  to be inversed 
GETB V1 = GETB V2 Get V2 Bit value and store in V1 

Table 4.3.6 Bit setting command table 

 SETB 

Sets specific bit to be ON. 

Equation: SETB V1 

Set V1 Bit to be ON 

Example: 

Set a value of 0 to the 0 number of bit within the internal memory $0. 

$0 = FFFEH 

SETB $0.0 

The result  $0 = FFFFH 
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 CLRB 

Sets specific bit to be OFF.  

Equation: CLRB V1 

Set V1 Bit to be OFF 

Example: 

Set a value of 0 to the 0 number of bit within the internal memory $0. 

$0 = FFFFH 

CLRB $0.0 

The result  $0 = FFFEH 

 INVB 

Sets specific bit to be inversed. ON  OFF, OFF  ON 

Equation: INVB V1 

Set V1 Bit  to be inversed. ON  OFF, OFF  ON 

Example: 

Set a value of 0 to the 0 number of bit within the inversed internal memory $0. 

$0 = FFFEH 

INVB $0.0 

The result  $0 = FFFFH 

 GETB 

Get bit value 

Equation: V1 = GETB V2 

Get V2 Bit value and store in V1 

Example: 

Get the 3rd Bit value within $0 and store it to the 5th Bit within $10. 

$2 = FFFEH 

$10 = 0 

$10.5 = GETB $0.3 

The result  $10 = 4 
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 Communication 

Command Equation Description 
INITCOM V1= INITCOM (V2) Initial setup COM port 
ADDSUM V1=ADDSUM(V2, V3) Use addition to calculate checksum
XORSUM V1 = XORSUM(V2, V3) Use XOR to calculate checksum 

PUTCHARS V1 = PUTCHARS(V2, V3, V4) Output characters by COM port 
GETCHARS V1 = GETCHARS(V2, V3, V4) Get characters by COM port 

SELECTCOM SELECTCOM(V1) Select COM port 
CLEARCOMBUFFER CLEARCOMBUFFER(V1, V2) Clear COM port buffer 

CHRCHKSUM V1 = CHRCHKSUM(V2, V3, V4) Calculate the length of texts and 
checksum 

Table 4.3.7 Communication command table 

 INITCOM 

INITCOM → Initial setup COM port to start communication and set communication protocol.  

 

Fig. 4.3.2 INITCOM 
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Fig. 4.3.3 Variable2 settings in INITCOM (communication protocol) 

 
Fig. 4.3.4 COM port 

 
Fig. 4.3.5 Communication interface 

 
Fig. 4.3.6 Data Bit 

 
Fig. 4.3.7 Parity bit 

 
Fig. 4.3.8 Stop bit 

 
Fig. 4.3.9 Baud rate 

Flow Control: The transmission speed and communication validity are enhanced during 

communication due to new transmission technology, such as compress immediately, debug,…etc. But 

the new technology also makes the transmission speed between HMI and PC will longer than the 

actual transmission speed. Therefore, ensure the data security and transmit complete data between 

computer and HMI, the flow control is necessary. 

No Flow Control: Flow control function is disabled. 

CTS/RTS: It is flow control for hardware. It uses handshaking signal to control receiving and sending 

data. The control is achieved via internal modem or external modem that connect to HMI by connecting 

cable.  

DSR/DTR: It is flow control for hardware also. It is used when PC and HMI is connected by cable 

directly. 

XON/XOFF: It is flow control for software. It is only used for 2400bps modem. The control method is to 

generate control code by software and add it in the transmission data.  



Chapter 4  Macro Function|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   4-29 

 

Fig. 4.3.10 Flow control 

 ADDSUM 

ADDSUM → It uses addition to calculate checksum. V1=ADDSUM(V2, V3). V1 is the value after 

calculation, V2 is the starting address for calculation and V3 is data length. 

 

Fig. 4.3.11 ADDSUM 

 XORSUM 

XORSUM → It uses XOR to calculate checksum. V1=XORSUM (V2, V3) V1 is the value after 

calculation, V2 is the starting address for calculation and V3 is data length. 

 

Fig. 4.3.12 XORSUM 
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 PUTCHARS 

PUTCHARS → Output characters by COM port. V1= PUTCHARS (V2, V3, V4). V1 is the response 

value after communication, V2 is the starting address of transmission data, V3 is data length, and V4 is 

the allowance communication time (unit is ms). The result will be stored in V1.  

 
Fig. 4.3.13 PUTCHARS 

 GETCHARS 

GETCHARS → Get characters by COM port. V1= GETCHARS (V2, V3, V4). V1 is the response value 

after communication, V2 is the starting address of transmission data, V3 is data length, and V4 is the 

allowance communication time (unit is ms). The result will be stored in V1. 

 
Fig. 4.3.14 GETCHARS 

 

Fig. 4.3.15 Example 1 of Delta PLC 
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In example 1 of Delta PLC shows the initial setup operation of Delta PLC. The users can see the 

INITCOM command example in Fig. 4.3.15.  

 
Fig. 4.3.16 Example 2 of Delta PLC 

Example 2 of Delta PLC in Fig. 4.3.16 shows the communication macro for background macro. From 

Line 1 to line 3, the users can see that Y0 is set to be ON and written into internal memory *10. From 

Line 4 to line 6, the users can see that Y0 is set to be OFF and written into internal memory *30. Then, 

output ON data in line 12 and output OFF data in line 14. Therefore, when HMI execute these 

commands, the users can see Y0 LED will be ON and OFF alternately. From this example, the users 

can know that communication Macro let the users have the rights of PLC control simultaneously when 

you have PLC communication data. Even if Delta DOP series HMI does not support the types of PLCs 

or any new PLCs, the users still can control those PLCs by using communication Macro with 

communication protocol. 

 SELECTCOM 

SELECTCOM → It is used to select COM port. When not select connecting PLC (set PLC to NULL) in 

Options > Configuration in ScrEdit, the users can use two COM ports (0:COM1, 1:COM2) at the same 

time. (All communication commands will be processed via the COM port the users select after 

executing this command. Different macros will not support each other or have any interference.) 

 
Fig. 4.3.17 SELECTCOM 
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 CLEARCOMBUFFER 

Clear COM port buffer. 

 
Fig. 4.3.18 CLEARCOMBUFFER 

Equation: CLEARCOMBUFFER(V1, V2) 

V1 is the number of communication port. It represents as constant 0(COM1) or 1(COM2). 

V2 is the type of buffer area. It represents as constant 0 (receiving buffer area) or  1(sending buffer 

area) 

Example: 

Clear sending buffer area of COM2 

CLEARCOMBUFFER(1, 0) 

 CHRCHKSUM 

Calculate the data length of texts or characters and checksum. 

 
Fig. 4.3.19 CHRCHKSUM 
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Equation: V1 = CHRCHKSUM(V2, V3, V4) 

V1 is the internal memory address where stores the text length of V2. 

V2 is the string of text. 

V3 is the internal memory address where stores the checksum of V2. 

V4 is the data length of the checksum that stores in V3. 0 represents Byte and 1 represents Word. 

Operation of checksum: 

Convert format of each data characters to ASCII code and add up them. For example, convert ’2’ to 

ASCII code ‘31H’, convert ’4’ to ASCII code ‘34H’ and the checksum is 31H + 34H = 65H. 

Example: 

Calculate the data length of "24" and checksum 

$0 = CHRCHKSUM("24", $10, 2) 

After the above operation, 2 is stored in $0 and 2 represents the data length is 2 bytes. The checksum 

stored in $10 is 65H. 

 Others 

Command Equation Descrption 

TIMETICK V1 = TIMETICK Get the time from system startup to 
present 

GETLASSERROR V1 = GETLASTERROR Get last error value 
# #V1 Comment 

delay delay V1 System delay 
GETSYSTEMTIME V1 = GETSYSTEMTIME Get system time 
SETSYSTEMTIME SETSYSTEMTIME(V1) Set system time 

GETHISTORY V1 = GETHISTORY (V2, V3, 
V4, V5, V6) Get history data 

 TIMETICK 

TIMETICK → Get the time from system startup to present and put into the specific address. An 

increment of 1 means 100ms is added. 
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Fig. 4.3.20 TIMETICK 

 GETLASTERROR 

GETLASTERROR → Get last error value. If there is no error occurred, the result of GETLASTERROR 

will be 0. Even if each Macro is executed simultaneously, the error message will not interfere one 

another. For error code information, please refer to section 4.4. 

 

Fig. 4.3.21 GETLASTERROR 

 COMMENT 

COMMENT → It lets Macro to be readable. Using this command will not affect macro function. The 

users only need to put “#” in front of the equation and the macro will become readable. If the users 

want to change the comment to be back to equation, just remove the “#” symbol. 
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Fig. 4.3.22 COMMENT 

 Delay 

Delay → Delays the user setting time by system. As HMI system is a multiplexer system, the system 

delay problem may occur. Therefore, setting time will be increased due to “system busy” and the 

condition that the setting time move forward will not happen. The unit of delay time is ms. 

 

Fig. 4.3.23 Delay 

 GETSYSTEMTIME 

Get system time 

Equation: V1 = GETSYSTEMTIME 

V1 is the starting address of continuous 7Words within the internal memory address. 
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V1 Year 

V1 + 1 Month 

V1 + 2 Date 

V1 + 3 Week 

V1 + 4 Hour 

V1 + 5 Minute 

V1 + 6 Second 

Example: 

Now the system time is 2006/01/04 Wed 09:26:25. Using this command to get the current system time 

and store in $1~$7. 

$1 = GETSYSTEMTIME 

Get $1 = 2006, $2 = 01, $3 = 4, $4 = 3, $5 = 9, $6 = 26, $7 = 25 

 SETSYSTEMTIME 

Set system time 

Equation: SETSYSTEMTIME(V1) 

V1 is the starting address of continuous 7Words within the internal memory address. 

V1 Year 

V1 + 1 Month 

V1 + 2 Date 

V1 + 3 Week 

V1 + 4 Hour 

V1 + 5 Minute 

V1 + 6 Second 

Example: 

Set the current system time as 2006/01/04 Wed 09:26:25. 

$1 = 2006 

$2 = 1 

$3 = 4 

$4 = 3 

$5 = 9 

$6 = 26 

$7 = 25 

SETSYSTEMTIME($1) 
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 GETHISTORY 

Get history data 

Equation: V1 = GETHISTORY (V2, V3, V4, V5, V6) 

V1 is the internal memory address where store the data length. 

V2 is the internal memory, constant, the buffer number of history buffer area. 

V3 is the internal memory, constant, the starting address for sampling. 

V4 is the internal memory, constant, the points for reading 

V5 is the internal memory, PLC address, the address where store the data 

V6 is the internal memory, constant, the data type for reading 

0: Data, 1: Time, 2: Time and Data 

 

4.4 Error Messages 

When compiling, it will shows errors in output window for user to find out easily. Some errors occur because 

of the users’ carelessness, sometimes just because the users miss to input some commands. Some errors 

will be found out easily in short program. But that will be difficulty in long Macro. To help the users to debug, 

ScrEdit provides error messages to show what the error is. But for those logic errors, the users should be 

aware of it and avoid making this kind of mistake. 

 Error messages when editing 

 Code – 100: LABEL cannot be found 

There is no such LABEL that GOTO designates.  

 Code – 101: Recursion occurs 

This error message is usually occurred in sub-macro. The ability of a sub-macro to CALL itself is called 

recursion. No matter it is called directly or indirectly. Basically, recursion cannot be adopted for sub-

macro. The users can use GOTO or FOR (infinite times) to replace it. 

 Code – 102: More than 3 nested FOR is used 

This error message is to warn the users not to use more than 3 nested FOR commands. The purpose 

is to avoid insufficient memory. The users can use GOTO or IF to replace it. 

 Code – 103: Sub-macro does not exist 

This error message means that there is no sub-macro in the program. For example, CALL 5 means 

CALL sub-macro 5. If the users do not edit sub-macro 5 in the program, this error message will display 

to warn the users. The purpose is to warn the users to be more careful when editing (reduce input error 

or avoid forgetting editing the corresponding sub-macro) and prevent unexpected error. 



Chapter 4  Macro Function|ScrEdit Software User Manual 

4-38   Revision 05/30/2006, EH00 

 Code – 104: Number of NEXT is less than the number of FOR 

Number of NEXT and FOR should match. This error code is used to remind the users finding out the 

missing NEXT.  

 Code –105: Number of FOR is less than the number of NEXT 

Number of FOR and NEXT should match. This error code is used to remind the user if there is any 

missing FOR. 

 Code–106: Repeated LABEL 

This error message means that there are repeated LABEL in the same Macro. The program will be 

confusing with that. That may be caused by carelessness (input error or forget to edit the corresponding 

sub-macro) and the users will get error message during editing to avoid unexpected error. 

 Code–107: There is RET in Macro 

This error message means that there is RET command in Macro. RET command should be used for 

sub-macro to return program. But in Macro, it should use END not RET.  

 HMI Macro Error Messages 

The users can read error messages by macro. Once there is an error and the users execute a correct 

command before reading error message, the error message will be overwritten. When executing each macro, 

each Macro error message will not be influenced by other macro.  

 Code–10: GOTO Error 

This message means that there is GOTO error in macro.  

 Code–11: Stack Overflow 

This message means that stack in macro is full. That may be cause by using too many sub-macros or 

execute different macros at the same time. This is to avoid insufficient memory.  

 Code–12: CALL Empty Sub-macro 

This is CALL sub-macro error. The sub-macro that is called should not be an empty sub-macro. This 

message is to avoid unexpected error.  

 Code–13: Data Read Error 

This is data read error. Sometimes this may be caused by memory data error but most of the time is 

PLC data read error.  

 Code–14: Data Write Error 

This is data write error. Sometimes this may be caused by memory data error but most of the time is 

PLC data write error.  
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 Code–15: Divisor is 0 

This error message means that the devisor is 0 when performing division operation.  

 HMI Communication Error Messages 

 

Fig. 4.4.1 Example of n HMI Communication Error Message 

 Communication Busy 

Error Message: Com ? Station ?: Communication Busy ... 

 Unknown Code 

Error Message: Com ? Station ?: Receive Unknow Code ... 

 No Response from Controller 

Error Message: Com ? Station ?: Controller No Response ... 

 HMI CheckSum Error 

Error Message: Com ? Station ?: Check Sum Error in HMI Message ... 

 Controller CheckSum Error 

Error Message: Com ? Station ?: Check Sum Error in Controller Message ... 

 Incorrect Command 

Error Message: Com %d Station %d: Command Can Not be Executed ... 

 Incorrect Address 

Error Message: Com ? Station ?: Address Fault ... 

 Incorrect Value 

Error Message: Com ? Station ?: Value is Incorrect ... 

 Controller is Busy 

Error Message: Com ? Station ?: Controller is Busy ... 

 CTS Signal Fail 

Error Message: Com ? Station ?: CTS Signal Fail ... 
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 No Such Resource in Controller 

Error Message: Com ? Station ?: No Such Resource ... 

 No Such Service in Controller 

Error Message: Com ? Station ?: No Such Service ... 

 Must Retry 

Error Message: Com ? Station ?: Must Retry ... 

 HMI Station Number Error 

Error Message: Com ? Station ?: HMI Station Number Error ... 

 Controller Station Number Error 

Error Message: Com ? Station ?: Controller Station Number Error ... 

 UART Communication Error 

Error Message: Com ? Station ?: UART Communication Error ... 

 Other Communication Error 

Error Message: Com? Station ?: Other Communication Error ... 
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Chapter 5  Control Block and Status Block 

For two-way communication and display screen between DOP series and all brands’ PLC, it needs to define 

the address of HMI control block and status block in Standard tab. Please choose Options > Configuration to 

find the Standard tab in Configuration dialog box (Fig. 5.1 and Fig. 5.2). 

 
Fig. 5.1 Configuration settings 

 
Fig. 5.2 Standard tab 
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5.1 Control Block  

HMI can be controlled via PLC by designating the register from control block settings. The register is a 

continuous data block and its length is from 0 to 8 WORDs. The length is different depends on function. For 

example, it needs at least 7 WORDs for recipe function. When the control block size is set to 0, the control 

block function is disabled. If the control block function is enabled, HMI can judge the operation that 

commanded by the external controller by reading the setting in control block rapidly and continuously. 

The function and explanation of each WORD are listed below. (In the following table, we assume that the 

users use Delta PLC, so the available starting addresses in control block are Dn ~ Dn+7 (D0 ~ D7).) 

Word Number Register Number Example 

0 Register for designating Screen Number (SNIR)  Dn (D0) 

1 Control Flag Register (CFR)  Dn+1 (D1) 

2 Curve Control Register (CUCR)  Dn+2 (D2) 

3 Register for Sampling History Buffer (HBSR)  Dn+3 (D3) 

4 Register for Clearing History Buffer (HBCR)  Dn+4 (D4) 

5 Recipe Control Register (RECR)  Dn+5 (D5) 

6 Register for designating Recipe Group Number (RBIR)  Dn+6 (D6) 

7 System Control Flag Register (SCFR)   Dn+7 (D7) 

 Register for Designating Screen Number (SNIR) 

Word Function 

0 Designate screen number 

This register SNIR (Dn) is used to designate HMI screen by setting PLC (D0). HMI screen can be switched 

automatically by changing D0.  

 Control Flag Register (CFR) 

Bit Number Function 

0 Enable / disable communication 

1 Enable / disable back light 

2 Enable / disable buzzer 

3 Clear alarm buffer 

4 Clear alarm counter 

5~7 Reserved 

8 Setting user level bit0 

9 Setting user level bit1 

10 Setting user level bit2 

11~15 Reserved 
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 Enable / Disable Communication 

Control the HMI communication. When Bit 1 is set to ON, it will disable HMI communication. When Bit 1 

is set to OFF, it will enable HMI communication. 

 Enable / Disable Back Light 

Control HMI back light. When Bit 1 is set to ON, it will turn off HMI back light. When Bit 1 is set to OFF, 

it will turn on HMI back light.  

 Enable / Disable Buzzer 

Control HMI buzzer. When Bit 2 is set to ON, it will turn off HMI buzzer. When Bit 1 is set to OFF, it will 

turn on HMI buzzer. 

 Clear Control Flag for Alarm Buffer  

It is used to clear alarm buffer. Set Bit 3 to be ON to trigger this control flag. It clears alarm buffer when 

this flag is triggered to ON. This flag needs be set to OFF and then ON if the users want to trigger again. 

 Clear Control Flag for Alarm Counter  

It is used to clear alarm counter. Set Bit 4 to be ON to trigger this control flag. It clears alarm buffer 

when this flag is triggered. This flag needs be set to OFF and then ON if the users want to trigger again. 

 Setting User Level 

PLC can set the user level of using HMI from Bit 8, Bit 9 and Bit 10. The setting level is from level 0 to 

level 7. MSB: Bit 10 and LSB: Bit 8. 

 Curve Control Register (CUCR) 

Bit Number Function 
0 Curve sampling flag 1 

1 Curve sampling flag 2 

2 Curve sampling flag 3 

3 Curve sampling flag 4 

4~7 Reserved 

8 Curve clear flag 1 

9 Curve clear flag 2 

10 Curve clear flag 3 

11 Curve clear flag 4 

12~15 Reserved 
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 Curve Sampling Control Flag (1-4)  

HMI curve (general curve or X-Y curve) sampling is controlled by PLC. When this control flag is 

triggered to ON (Bit 0 ~ Bit 3 is set to ON), HMI will sample ONCE by reading continuous data of curve 

on HMI screen and convert the data to graph and show on HMI screen. This flag needs be set to OFF 

and then ON if the users want to trigger again. 

 Curve Clear Control Flag (1-4)  

Clear HMI curve (general curve or X-Y curve) when this control flag is triggered (Bit 8 ~ Bit 11 is set to 

ON). This flag needs be set to OFF and then ON if the users want to trigger again. 

 Register for Sampling History Buffer (HBSR)  

For the settings of sampling history buffer, the users can refer to the description of “History Setup” in Chapter 

2. HMI provides 12 records for tracking sampling register of history buffer. Besides, HMI time interval settings, 

sampling or clearing history buffer can be controlled via PLC.  

Bit Number Function 

0 Control flag for Sampling History Buffer 1 

1 Control flag for Sampling History Buffer 2 

2 Control flag for Sampling History Buffer 3 

3 Control flag for Sampling History Buffer 4 

4 Control flag for Sampling History Buffer 5 

5 Control flag for Sampling History Buffer 6 

6 Control flag for Sampling History Buffer 7 

7 Control flag for Sampling History Buffer 8 

8 Control flag for Sampling History Buffer 9 

9 Control flag for Sampling History Buffer 10 

10 Control flag for Sampling History Buffer 11 

11 Control flag for Sampling History Buffer 12 

12~15 Reserved 

 Control Flag Register for Sampling History Buffer  

Controls sampling history buffer operation of HMI by the external controller, i.e. PLC. It will sample 1 

time once the control flag is triggered to ON (Bit 1 ~ Bit 12 is set to ON). This flag needs be set to OFF 

and then ON if the users want to trigger again. 
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 Register for Clearing History Buffer (HBCR) 

Bit Number Function 
0 Clear flag of history buffer 1 

1 Clear flag of history buffer 2 

2 Clear flag of history buffer 3 

3 Clear flag of history buffer 4 

4 Clear flag of history buffer 5 

5 Clear flag of history buffer 6 

6 Clear flag of history buffer 7 

7 Clear flag of history buffer 8 

8 Clear flag of history buffer 9 

9 Clear flag of history buffer 10 

10 Clear flag of history buffer 11 

11 Clear flag of history buffer 12 

12~15 Reserved 

 Clear flag of history buffer  

HMI history buffer can be cleared by the external controller, i.e. PLC. Once the control flag is triggered 

to ON (Bit 1 ~ Bit 12 is set to ON), it will clear HMI history buffer ONCE. This flag needs be set to OFF 

and then ON if the users want to trigger again. 

 Recipe Control Register (RECR) 

Bit Number Function 
0 Change recipe group number  

1 Read recipe (PLC → HMI) 

2 Write recipe (HMI → PLC) 

3~15 Reserved 

 Control flag for changing recipe group number  

RCPNo is the internal system register used for designating recipe group number. RCPNo value can be 

changed by writing recipe group number (N) into Designated Recipe Group Number Register (RBIR) 

Dn+6 and trigger this control flag to ON (Bit 0 is set to ON). After setting, RCPNo will be changed to N 

automatically. This flag needs be set to OFF and then ON if the users want to trigger again. 

 Control flag for reading recipe  

Before reading a recipe from PLC, the users should designate the recipe group number (N) first 

(Please refer to the section “Control flag for changing recipe group number”). Then, trigger this control 

flag to ON (Bit 1 is set to ON). After setting, the recipe will be read from PLC and stored in designating 

area of HMI. This flag needs be set to OFF and then ON if the users want to trigger again. 
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 Control flag for writing recipe  

Before writing a recipe to PLC, the users should designate the recipe group number (N) first (Please 

refer to the section “Control flag for changing recipe group number”). Then, trigger this control flag to 

ON (Bit 2 is set to ON). After setting, the recipe will be written to PLC. This flag needs be set to OFF 

and then ON if the users want to trigger again. 

 Register for designating Recipe Group Number (RBIR) 

Word Function 

0 Designate receipt group number which 

By writing recipe group number (N) into Designated Recipe Group Number Register (RBIR), RCPNo value 

can be changed. The users can use the control flag for changing recipe group number of Recipe Control 

Register (RECR) to write recipe group number (N) into Designated Recipe Group Number Register (RBIR) 

and change RCPNo value.  

 System Control Flag Register (SCFR) 

Bit Number Function 
0 Multi-language setting value Bit 0 

1 Multi-language setting value Bit 1 

2 Multi-language setting value Bit 2 

3 Multi-language setting value Bit 3 

4 Multi-language setting value Bit 4 

5 Multi-language setting value Bit 5 

6 Multi-language setting value Bit 6 

7 Multi-language setting value Bit 7 

8 Printer flag 

9 Printer form feed flag 

10~15 Reserved 

 Multi-language Setting Value 

Store the designating multi-language setting value into this register and command HMI to switch to the 

designating language according to the settings in this register.  

 Printer Flag 

When this flag is triggered to ON, the current display or editing screen can be printed out. When this 

flag is set to OFF, the printer function is disabled. 

 Printer Form Feed Flag 

When this flag is triggered to ON, the printer will retract the paper and align the paper for the next run 

automatically. When this flag is set to OFF, the printing form feed function is disabled. 
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5.2 Status Block 

For two-way communication and display screen between DOP series and all brands’ PLC, it needs to input 

starting address of response register in status block. The status block in DOP series is a continuous data 

block, such as Dm=D10 (length is 8 WORDs = D10-D17). When the control block size is set to 0, the control 

block function is disabled. If the control block function is disabled, the status block function is also disabled. 

When the status block function is enabled, the external controller, i.e. PLC can know the status of HMI by 

writing the setting in status block. The function and explanation of each WORD are listed below. (In the 

following table, we assume that the users use Delta PLC, so the available starting addresses in control block 

are Dm ~ Dm+7 (D10 ~ D17).) 

Word Number Register  

0 Status Register for General Control (GCSR) Dm (D10) 

1 Status Register for Screen Number (SNSR) Dm+1 (D11) 

2 Status Register for Curve Control (CCSR) Dm+2 (D12) 

3 Status Register for Sampling History Buffer (HSSR) Dm+3 (D13) 

4 Status Register for Clearing History Buffer (HCSR) Dm+4 (D14) 

5 Recipe Status Register (RESR) Dm+5 (D15) 

6 Status Register for Recipe Number (RBSR) Dm+6 (D16) 

7 Status Register 2 for General Control (GCSR2) Dm+7 (D17) 

 Status Register for General Control (GCSR) 

Bit Number Function 

0 Screen Switch Status  

1~2 Reserved 

3 Clear Status of Alarm Buffer  

4 Clear Status of Alarm Counter  

5-7 Reserved 

8 User Level (Bit0) 

9 User Level (Bit1) 

10 User Level (Bit2) 

11 User Level (Bit3) 

12~15 Reserved 

 Screen Switch Status  

When the screen is switched, the Bit will be set to ON. After screen switch is completed, the Bit will be 

OFF. 

 Clear Status of Alarm Buffer 

When HMI clear the alarm buffer (clear status of alarm buffer function is enabled), the Bit will be set to 

ON. After this function is completed, the Bit will be OFF. 
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 Clear Status of Alarm Counter 

When HMI clear the alarm counter (clear status of alarm counter function is enabled), the Bit will be set 

to ON. After this function is completed, the Bit will be OFF. 

 User Level Status  

Bit 8 ~ Bit 11 are used to record the users level when HMI is in communication.  
                       Bit 

User Level  Bit 8 Bit 9 Bit 10 Bit 11 

0 OFF OFF OFF OFF 

1 ON OFF OFF OFF 

2 OFF ON OFF OFF 

3 ON ON OFF OFF 

4 OFF OFF ON OFF 

5 ON OFF ON OFF 

6 OFF ON ON OFF 

7 ON ON ON OFF 

8 OFF OFF OFF ON 

 Status Register for Screen Number (SNSR) 

Word Function 

0 The last open screen number 

 The last open screen number 

The register SNSR (Dm+1) is used to store the last screen number you opened. Every time the screen 

is switched, the last screen that the users open (including sub-screen) will be memorized and stored in 

this status register (D11).  

 Status Register of Curve Control (CCSR) 

Bit Number Function 
0 Sampling status of curve 1  

1 Sampling status of curve 2  

2 Sampling status of curve 3 

3 Sampling status of curve 4 

8 Clear status of curve 1 

9 Clear status of curve 2 

10 Clear status of curve 3 

11 Clear status of curve 4 

4~7;12~15 Reserved 
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 Curve Sampling Status Flag 

When sampling general curve or X-Y curve, the curve sampling status flag will be set to be ON (Bit 0 ~ 

Bit 3 is set to ON). After sampling operation is completed, the curve sampling status flag will be OFF.  

 Curve Clear Status Flag 

When clearing general curve or X-Y curve, the curve clear status flag will be set to be ON (Bit 8 ~ Bit 11 

is set to ON). After clear operation is completed, the curve clear status flag will be OFF.  

 Status Register for Sampling History Buffer (HSSR) 

Bit Number Function 
0 Sampling Status of History Buffer 1  

1 Sampling Status of History Buffer 2  

2 Sampling Status of History Buffer 3 

3 Sampling Status of History Buffer 4 

4 Sampling Status of History Buffer 5 

5 Sampling Status of History Buffer 6 

6 Sampling Status of History Buffer 7 

7 Sampling Status of History Buffer 8  

8 Sampling Status of History Buffer 9 

9 Sampling Status of History Buffer 10 

10 Sampling Status of History Buffer 11 

11 Sampling Status of History Buffer 12 

12-15 Reserved 

 Sampling History Buffer Flag  

When sampling history buffer, the sampling history buffer flag will be set to be ON (Bit 0 ~ Bit 11 is set 

to ON). After sampling operation is completed, the sampling history buffer flag will be OFF.  

 Status Register for Clearing History Buffer (HCSR) 

Bit Number Function 
0 Clear Status of History Buffer 1  

1 Clear Status of History Buffer 2 

2 Clear Status of History Buffer 3 

3 Clear Status of History Buffer 4 

4 Clear Status of History Buffer 5 

5 Clear Status of History Buffer 6 

6 Clear Status of History Buffer 7 

7 Clear Status of History Buffer 8 

8 Clear Status of History Buffer 9 
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Bit Number Function 
9 Clear Status of History Buffer 10 

10 Clear Status of History Buffer 11 

11 Clear Status of History Buffer 12 

12~15 Reserved 

 Clear History Buffer Flag  

When clearing history buffer, the clear history buffer flag will be set to be ON (Bit 0 ~ Bit 11 is set to ON). 

After sampling operation is completed, the clear history buffer flag will be OFF.  

 Recipe Status Register (RESR) 

Bit Number Function 
0 Change Status of Recipe Number  

1 Recipe Read Status (PLC → HMI)  

2 Recipe Write Status (HMI → PLC)  

3~15 Reserved 

 Change Status of Recipe Number Flag 

When change status of recipe number is controlled by PLC, the change status of recipe number flag 

(Bit 0) is set to ON. After HMI change the status of recipe number and update the RCPNo value, the 

change status of recipe number flag will be OFF.  

 Recipe Read Status Flag 

When HMI read one recipe data from PLC, the recipe read status flag (Bit 1) is set to ON. When the 

recipe data is read and saved in HMI completely, the recipe read status flag will be OFF.  

 Recipe Write Status Flag 

When HMI send one recipe data to PLC, the recipe write status flag (Bit 2) is set to ON. When the 

recipe data is sent and written to PLC completely, the recipe write status flag will be OFF.  

 Status Register for Recipe Number (RBSR) 

Word Function 

0 Current recipe number 

When recipe number register RCPNo is changed (no matter it is changed by PLC or HMI), the status register 

for recipe number (RBSR) (Dm+6) will be updated also. Monitoring this status register for recipe number 

(RBSR) can know the current recipe number. 
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 Status Register 2 for General Control (GCSR2) 

Bit Number Function 
0 Multi-language status value Bit 0 

1 Multi-language status value Bit 1 

2 Multi-language status value Bit 2 

3 Multi-language status value Bit 3 

4 Multi-language status value Bit 4 

5 Multi-language status value Bit 5 

6 Multi-language status value Bit 6 

7 Multi-language status value Bit 7 

8 Printer status flag 

9 Printer form feed status flag 

10~15 Reserved 

 Multi-language Status Value 

The users can know the current multi-language shown on HMI from the multi-language status value. 

 Printer Status Flag 

When this flag is triggered to ON, it indicates that the printer is printing current display or editing screen. 

When this flag is set to OFF, the printer function is disabled. 

 Printer Form Feed Status Flag 

When this flag is triggered to ON, it indicates that the printer is retracting the paper and aligning the 

paper for the next run automatically. When this flag is set to OFF, the printing form feed function is 

disabled. 
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Chapter 6  Internal Memory 

 Internal Register (R/W): $ 

Word access:  $n (n:  0~65535) 

Bit access:  $n.b (n:  0~65535, b: 0~15) 

Delta DOP series HMI provides 65536 16-bit internal registers ($0 ~ $65535). 

 Non-volatile Internal Register (R/W): $M 

Word access:  $Mn (n:  0~1023) 

Bit access:  $Mn.b (n:  0~1023, b: 0~15) 

Delta DOP series HMI provides 1024 16-bit non-volatile internal registers ($M0 ~ $M1023). 

 Indirect Address Register (R/W): *$ 

Word access:  *$n (n:  0~65535) 

Indirect addressing register is the register stored in the range from the address to the internal register. 

The users need to get the address from $n and then get the value stored in this address. 

*$n =  

 

 

For example, if $n = m; $m = X; then *$n = X. (the value of m cannot exceed 65535) 

 Receipt Number Register (R/W): RCPNO 

It is 16-bit register that is used to designate the receipt group number. The minimum receipt group 

number should be 1 and the maximum group number is determined when editing the receipts. 

PLC upload/download will read/write a group of recipe according to the setting of recipe number 

register. The length of each group of receipt is determined when editing the receipts. 

Delta DOP series HMI provides a space of 64K Words max. for the users to store the receipts.  

 Receipt Register (R/W): RCP 

The receipt length is L and the receipt group number is N. 

Word access:  RCPn (n:  0~NxL+(L-1)) 

Bit access:   RCPn.b (n:  0~NxL+(L-1), b: 0~15) 

The recipe register is used to save the recipe that download from HMI after finishing ScrEdit. 

There are two methods to read/write these registers: 

$n m 

X 
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Assume that the users set the receipt length is L and the receipt group number is N: 

Group Address Access: 

This method is accessed by RCPNO and RCP0~RCP (L-1).  

For example: if RCPNO=3, HMI will read RCPNO 3 data out and save it in RCP0~RCP (L-1). Then 

PLC can read RCPNO 3 data from this area. RCP0~RCP (L-1) can be regarded as a common area. 

Absolute Address Access: 

This method is used to access the data that data address is greater than RCP (L-1). At this time, the 

starting address of 1st recipe is RCP (1XL), the starting address of 2nd recipe is RCP (2XL) and vise 

versa. Therefore, if the users want to access the mth word of nth recipe, the users can use the equation: 

RCP(nxL+m) to achieve the purpose. 

RCP0 RCP1 RCP2 RCP (L-1)...

1xL 1xL+1 1xL+2 1xL+(L-1)
2xL 2xL+1 2xL+2

...

...

...

2xL+(L-1)

...

NxL NxL+1 NxL+2 NxL+(L-1)

RCP0=1
RCP0=2

RCP0=N

RCP0=X; (1<=X<=N)
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Appendix A  Specifications and Installation 

A.1 Specifications 

Model A(E)57BSTD A(E)57GSTD A(E)57CSTD A75CSTD AE80THTD A10TCTD /
AE10THTD Note

Display Type STN FSTN STN STN TFT-LCD  

Display Color 8 Grays 16 Grays 256 Colors 256 Colors
256 Colors  

(AE series: 65536 Colors)  

Screen Pixels 320 x 240 pixels 640 x 480 pixels  

Back-light Life About 50 thousand hour at 25°C 
About 20 
thousand 

hour at 25°C

About 30 
thousand 

hour at 25°C 

About 30 
thousand 

hour at 25°C
 

Display Size 5.7” (118.2 x 89.4mm) 7.5” (158.0 
x118.0mm)

8.0” (162.2 
x121.7mm) 

10.4” (215.2 
x 162.4mm)

 

Operation System Windows Base Real Time OS  
MCU 32-bit RISC Micro-controller / 202.8MHz  
ROM 3M Bytes 7M Bytes  

Backup Memory 
(SRAM) 256K Bytes (AE：512K Bytes) (non-volatile internal memory)  

EXT. Memory Card Smart Media Card / USB Host Ver 1.1 (AE series only except 5.7”) ※

USB for download USB CLIENT Ver 1.1 & COM1, COM2  
Serial 

communication 
(UART) 

COM1(RS-232),COM2&COM3(RS-232C/422/485) 
(AE series: COM3 (RS-232C/422/485)) 

 

Function Keys User-defined keys*4 User-defined keys*6 User-defined 
keys*7  

RTC Built-in  

Lithium Battery 3V Lithium CR2032 x 1  

Buzzer 85dB  

Operation 
Voltage DC +24V (-10%~+20%)  

Power 
Consumption 7.2W max 10W max 14W max 15W max  

Cooling Method Natural air circulation  

Water Proof & 
Agency Approval  IP65 / NEMA4 & CE, UL, C-tick (except AE series)  

Operating Temp. 0°C to 50°C  

Storage Temp. -20°C to +60°C  

Ambient Humidity 10% ~ 90% RH (0℃~40℃), 10%~55% RH (41℃~50℃)  

Vibration 
Resistance 

IEC61131-2 compliant 
When vibration is NOT continuous: 5Hz-9Hz 3.5mm, 9Hz-150Hz 1G 

X, Y, Z directions for 10 times  
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Model A(E)57BSTD A(E)57GSTD A(E)57CSTD A75CSTD AE80THTD A10TCTD /
AE10THTD Note

(W) x (H) x (D) mm 
Dimensions / Panel 

Cutout 

184.1 x 144.1 x 47mm / 172.4 x 
132.4mm 

243.1 x178.1 
x 47mm / 
231.4 x 

166.4mm 

243.1x 178.1 
x 52.4mm / 

231.4 x 
166.4mm 

297.1 x 
222.1 x 

51.1mm / 
285.2 x 

210.2mm 

 

Weight 768g 942g 1147g 1721g  

※ Compatible with general Expansion Memory Card (4M~128M) on the market 
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A.2 Dimensions 

 DOPA(E)57G(C)(B)STD 

Vertical View -- Units: mm (inch) 

169.0(6.65)

 
Front Panel -- Units: mm(inch) Right Side Diagram -- Units: mm(inch) 

14
4.

1(
5.

67
)

184.1(7.25)

 

6.1(0.24)

12
9.

0(
5.

08
)

47.0(1.85)
8.0(0.31)

 

 DOPA75CSTD 

Vertical View -- Units: mm (inch) 

228.0(8.98)

 
Front Panel -- Units: mm(inch) Right Side Diagram -- Units: mm(inch) 

17
8.

1(
7.

01
)

243.1(9.57)

 

(1.85)47.0 6.1(0.24)

16
3.

0(
6.

42
)

8.0(0.31)
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 DOP-AE80THTD 

Vertical View -- Units: mm (inch) 

228.0(8.98)

 
Front Panel -- Units: mm(inch) Right Side Diagram -- Units: mm(inch) 

17
8.

1(
7.

01
)

243.1(9.57)

 
15(0.59)

89
.1

(3
.5

1)

8.0(0.31)
(2.06)52.4 6.1(0.24)

16
3.

0(
6.

42
)

 

 DOP-A10TCTD/DOP-AE10THTD 

Vertical View -- Units: mm (inch) 

281.7(8.98)

 

Front Panel -- Units: mm(inch) Right Side Diagram -- Units: mm(inch) 

297.1(9.57)

22
2.

4(
7.

01
)

 

51.1(1.85) 6.1(0.24)
8.0(0.31)

20
6.

7(
6.

42
)
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A.3 Profile 

 DOPA(E)57G(C)(B)STD 

A Display area 

B Touch screen 

C Power LED state  

 Dark LED: power is off. 

 Green LED: normal operation 

D Power input terminal  

E Expansion slot 

F Memory card 

G COM 2 

H COM 1 

I USB 

( ) ( )( ) ( )

A,B

C

D

E

F

G H I

F

 

 DOP-A75CSTD 

A Display area 

B Touch screen 

C Power LED State 

 Dark LED: power is off 

 Green LED: normal operation 

D Power input terminal 

E Expansion slot 

F Memory card 

G COM 2 

H COM 1 

I USB 

F

C

F

J GHI

E

A,B

D

 

 

 

Front View 

Rear View Side View 

Front View 

Rear View Side View 
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 DOP-AE80THTD 

A Display area 

B Touch screen 

C Power LED State 

 Dark LED: power is off 

 Green LED: normal operation 

D Power input terminal 

E Expansion slot 

F Memory card 

G COM 2 

H COM 1 

I USB 
H

E

J I

F

G

A,B

C

D

F

 

 DOP-A10TCTD/DOP-AE10THTD 

A Display area 

B Touch screen 

C Power LED State 

 Dark LED: power is off. 

 Green LED: normal operation 

D Power input terminal 

E Expansion slot 

F Memory card 

G COM 2 

H COM 1 

I USB 

J Battery cover 

F

E

H G

D

A,B

F

C

J I  

 

Front View 

Rear View Side View 

Front View 

Rear View Side View 
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A.4 Cutout Dimension 

5.7": 172.4mm (6.79") +1mm (0.04") and 132.4mm (5.21")+1mm (0.04")   Units: mm (inch) 

Panel thickness: 1.6mm (0.06in)~3.0mm (0.12in) 

4-R3(0.12)

T

NOTE:

172.4

13
2.

4

14
4.

1(
5.

67
)

184.1(7.25)

6.1(0.24)39.0(1.54)

DOP-A(E)57G(B)(C)STD(-W)

3.0mm(0.12in)
T=1.6mm(0.06in) ~ (5

.2
1 

   
)

+1  0
+0

.0
4

 0

(6.79    ) 0
+1 +0.04

 0

 

 

7.5": 231.4mm (9.11")+1mm (0.04") and 166.4mm (6.55")+1mm (0.04")      Units: mm (in.) 

Panel thickness: 1.6mm (0.06in)~3.0mm (0.12in) 

39.0
T

NOTE:

17
8.

1(
7.

01
)

243.1(9.57) (44.4)
6.1(0.24)

231.4

16
6.

4

DOP-A75CSTD

+0
.0

4
 0

 0
4-R

3.0
(0.

12
)

 0
+1

3.0mm(0.12in)
T=1.6mm(0.06in) ~

(6
.5

5 
   

   
)

 0+1

+0.04(9.11      )

 
 

Snap-in panel mount 

Snap-in panel mount 
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8.0": 231.4mm (9.11")+1mm (0.04") and 166.4mm (6.55")+1mm (0.04")      Units: mm (in.) 

Panel thickness: 1.6mm (0.06in)~3.0mm (0.12in) 

T=1.6mm(0.06in) ~
3.0mm(0.12in)

(1.75)

DOP-A(E)80TC(H)TD

17
8.

1(
7.

01
)

243.1(9.57)

 0
+1231.4  0(9.11      )+0.04

+0
.0

4
(6

.5
5 

   
   

)
 0+1

16
6.

4
 0

NOTE:

4-R
3.0

(0.
12

)

44.4
T

6.1(0.24)

 

10.4": 285.2mm (11.22")+1mm (0.04") and 210.2mm (8.27")+1mm (0.04")      Units: mm (in.) 

Panel thickness:  1.6mm (0.06in)~3.0mm (0.12in) 

NOTE:

T

21
0.

2

285.2
4-R

3.0
(0.

12
)

DOP-A(E)10TC(H)TD
+0.04

(11.22       )+1
 0  0

T=1.6mm(0.06in) ~

(8
.2

7 
   

   
)

+1  0
+0

.0
4

 0

3.0mm(0.12in)

297.1(11.70)

22
2.

1(
8.

74
)

43.1(1.70) 6.1(0.24)

 

 

Snap-in panel mount 

Snap-in panel mount 
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A.5 Installation  

 

 If the users turn the screw exceeds torque: 0.5N.M, plastic box may be damaged. 

5.7” Panel (DOP-A(E)57GSTD, DOP-A(E)57CSTD, DOP-A(E)57BSTD) 

DOPA(E)57G(C)(B)STD(-W)

 

7.5” Panel (DOP-A75CSTD) 

DOPA75CSTD

 

8.0” Panel (DOP-AE80THTD) 

DOPA(E)80TC(H)TD

 

Front View 
Mounting holes 

Bottom View 
Mounting holes 

Fixed support 
Snap-in panel mount 

Front View 
Mounting holes 

Bottom View 
Mounting holes 

Fixed support Snap-in panel mount 

Front View 
Mounting holes 

Bottom View 
Mounting holes 

Fixed support 
Snap-in panel mount 
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10.4” Panel (DOP-A(E)10TCTD) 

DOPA(E)10TC(H)TD

 

 

 

Fixed support 
Snap-in panel mount 

Front View 
Mounting holes 

Bottom View 
Mounting holes 
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Appendix B Communication 

B.1 Pin Definition of Serial Communication  

 COM1 

Pin Contact 
1 N.C. 
2 RXD 
3 TXD 
4 N.C. 
5 GND 
6 N.C. 
7 RTS 
8 CTS 

 

9 N.C. 

 

 COM2 

MODE1 MODE2 MODE3 
Pin

RS-232 RS-422 RS-485 
1 N.C. RXD- D- 
2 RXD RXD+ D+ 
3 TXD TXD+ D+ 
4 N.C. TXD- D- 
5 GND GND GND 
6 N.C. RTS- N.C. 
7 RTS RTS+ N.C. 
8 CTS CTS+ N.C. 

 

9 N.C. CTS- N.C. 

NOTE  

1) Mode 3 is for RS-485. Pin 2 & 3 are D+ and pin 1 & 4 are D-. 

2) Well-grounded is highly recommended if RS-485 & RS-422 are used for long transmission. 

3) DO NOT connect Frame Ground (FGND) to GND. Please connect FGND to the outer covering of 

connector. 

4) There are relations among transfer rate, distance and baud rate. 

 

Pin1

Pin1 
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B.2 Cable for Download  

The cable header used to connect DOP series is 9-pin D-SUB male.  
 

 

Refer to the following tables for the connection to each device. 

RS-232 Connection 

DOP series 
9 pin D-SUB male 

(RS-232) 

PC  
9 pin D-SUB female  

(RS-232) 

PC  
9 pin D-SUB female 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND

RTS (7) (8) CTS

CTS (8) (7) RTS  

 
 
 
 
 
 
 

 
D-SUB 9pin to DOP series (male)                                                   D-SUB 9pin to PC (female) 

 
Grounding + Shielding 

Fig. RS-232 TO PC 

USB Connection 

 
USB TYPE B to DOP series                                                                        USB TYPE A to PC 

 
Fig. USB TO PC 

Pin1



Appendix B  Communication|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   B-3 

B.3 Communication Settings and Connections between HMI and Connectable 

 Controllers 

The cable header used to connect DOP series is 9-pin D-SUB male.  

 

 

Brand Controller Name / Series Name 

Delta Controller 
For Servo/AC drive/Temperature Controller/PLC 
(984 RTU mode / ASCII mode) Delta 

Delta DVP PLC 

MicroLogix PLC 
Allen Bradley 

SLC5 PLC 

Danfoss VLT 2800 (FC Protocol) 

Facon Facon PLC 

Festo Festo_PLC 

GE Fanuc 90 Series SNP PLC 

Hust Hust CNC Controller 

Nano Series PLC 
Jetter 

JC Series PLC 

Keyence KV/KZ Series 

SU/DL Series 
Koyo 

K-Sequence 

Lenze LECOM-A/B Protocol 

Master K120S/200S 

Glofa GM6 CNET LG 

Master-K CNET 

LI YAN LYPLC EX 

M2i Master 
M2i 

M2i Slave 

Matsushita FP Series 

Mirle FAMA SC 

Mitsubishi FX / FX2N 



Appendix B  Communication|ScrEdit Software User Manual 

B-4   Revision 05/30/2006, EH00 

Brand Controller Name / Series Name 

A Series/J71UC24 

Mitsubish A2A/A2AS/A2USH A1SH/A3N/A2ASH CPU Port 

Q Series CPU Port 

MKS CT150 

Modbus (Master) --- 984 RTU / ASCII mode 

Hexadecimal Address (Master) --- RTU / ASCII mode 

nW (Master) --- RTU / ASCII mode 
Modbus 

Modbus (Slave) --- RTU / ASCII mode 

TSX Micro (Uni-Telway) 
Modicon 

TWIDO 

NIKKI DENSO NCS-FI/FS Series 

C Series 
Omron 

CJ1/CS1 Series 

S7 200 

S7-300 (with PC Adaptor) Siemens 

S7-300 (without PC Adaptor) 

Taian TP02 PLC 

Vigor M Series 

Yokogawa ACE PLC 

 



Appendix B  Communication|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   B-5 

Delta (Servo/AC Drive/PLC/Temperature) Controller DELTA 

A. HMI factory setting 

Baud rate: ASCII: 9600, 7, None, 2.  

 RTU: 9600, 8. None, 2 

Controller station number: 1. 

Control area/state area: None. 

NOTE  

1) This driver can support Delta all products, i.e. AC drive, PLC, Servo, Temperature Controller and 

Modbus standard connection. The users can easily set and communicate with these devices via using 

this driver. 

2) For the people who are used to use Modbus standard connection: 

Modbus / ASCII (Master), Modbus / 984 RTU (Master), Modbus / ASCII Hex Address (Master) and 

Modbus / RTU Hex Address (Master) can be compatible with the new Delta controller ASCII and Delta 

controller RTU. If desiring to change the driver settings, the users only need to change the “Controller” 

Option which is used to set the controller that the users use, and then the new driver can be used 

immediately. 

B. Definition of controller Read/Write address 

Registers 

Read/Write range 
Register Type Format 

Word No. Bit No. 
Data length 

Servo communication 
address SERVO-n n: 0 ~ 0700h N/A Word 

AC drive communication 
address INVERTER-n n: 0 ~ 2299h N/A Word 

TCntrl communication 
address TEMP_CTRL-n n: 0 ~ 6000h N/A Word 

WORD_DEVICE_X PLC_Xn n: 0 ~ 360(octal) N/A Word 

WORD_DEVICE_Y PLC_Yn n: 0 ~ 360(octal) N/A Word 

WORD_DEVICE_M PLC_Mn n: 0 ~ 1520, N/A Word 

  1536 ~ 4080 N/A Word 

WORD_DEVICE_S PLC_Sn n: 0 ~ 1008 N/A Word 

WORD_DEVICE_T PLC_Tn n: 0 ~ 255 N/A Word 

WORD_DEVICE_C PLC_Cn n: 0 ~ 199 N/A Word 

WORD_DEVICE_D PLC_Dn n: 0 ~ 4095, N/A Word 

  4096 ~ 9999 N/A Word 

WORD_DEVICE_HC PLC_HCn n: 200 ~ 255 N/A Double Word 
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Read/Write range 
Register Type Format 

Word No. Bit No. 
Data length 

PLC communication 
address Module PLC_Modulen n: 4000 ~ 4499h N/A Word 

Output Registers RW-n n: 0 ~ FFFFh N/A Word 

Input Registers R-n n: 0 ~ FFFFh N/A Word 

Output Registers Wn n: 40001 ~  50000 N/A Word 

Input Registers Wn n: 30001 ~ 40000 N/A Word 

NOTE  

1) The above addresses of Servo, AC drive, TCNTRL (Temperature controller) and PLC Module are in 

hexadecimal format. PLC Word Device X and Y are in octal format. Other PLC Word Device M, S, T, C, 

D and HC are in decimal format. 

2) WORD_DEVICE_ X / WORD_DEVICE_Y / WORD_DEVICE_M / WORD_DEVICE_S: Address must be 

0 or the multiple of 16. 

Contacts 

Read/Write range 
Contact type Format 

Word No. Bit No. 

Servo communication address SERVO-n.b n: 0 ~ 0700h b: 0 ~ f 

AC drive communication address INVERTER-n.b n: 0 ~ 2299h b: 0 ~ f 

TCntrl communication address TEMP_CTRL-n.b n: 0 ~ 6000h b: 0 ~ f 

Servo Digital Input SERVO_DI-n N/A n: 1 ~ 8 

Servo Digital Output SERVO_DO-n N/A n: 1 ~ 5 

WORD_DEVICE_X PLC_Xn N/A n: 0 ~ 377(octal) 

WORD_DEVICE_Y PLC_Yn N/A n: 0 ~ 377(octal) 

WORD_DEVICE_M PLC_Mn N/A n: 0 ~ 1535 

   1536 ~ 4095 

WORD_DEVICE_S PLC_Sn N/A n: 0 ~ 1023 

WORD_DEVICE_T PLC_Tn N/A n: 0 ~ 255 

WORD_DEVICE_C PLC_Cn N/A n: 0 ~ 255 

TCntrl Bit communication address TEMP_CTRLB-n N/A n: 800 ~ 8FFh 

Discrete Outputs RWB-n N/A n: 0 ~ FFFFh 

Discrete Inputs RB-n N/A n: 0 ~ FFFFh 

Discrete Outputs Bn N/A n: 1 ~ 10000 

Discrete Inputs Bn N/A n: 10001 ~ 20000 

NOTE  

1) The above addresses of Servo, AC drive, TCNTRL (Temperature controller) and PLC Module are in 

hexadecimal format.  
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2) PLC Word Device X and Y are in octal format. Other PLC Word Device M, S, T, C, D and HC are in 

decimal format. 

3) Servo Digital Input and Servo Digital Output are only for Servo. 

Pay close attention on the following important notes: 

4) For Delta AC drive: 

It needs to set communication address for HMI read/write address setting. (hexadecimal format for HMI). 

For detail information about communication address of Delta AC drive, please refer to Delta AC drive 

each series “User Manual”. 

Example 1: Parameter 9-01 of Delta VFD-S drive Transmission Speed needs set to INVERTER901 in 

HMI. (Decimal 9 is converted to 09 in hexadecimal and 01 is converted to 01 in hexadecimal. Therefore, 

setting INVERTER901 to HMI will discard the first 0) 

Decimal value 

Hexadecimal value

01 (Hexadecimal value)

09 (Hexadecimal value) 
The communication address of parameter 9-01 is 0901H. 

Example 2: if set parameter 8-17 (Lower Bound of DC Braking Start-up Frequency) of Delta VFD-S drive 

is desired, user needs set INVERTER811 in HMI. (8 is converted to 08 in hexadecimal and 17 is 

converted to 11 in hexadecimal. Therefore, setting the INVERTER811 to HMI will discard the first 0) 

Decimal value 

Hexadecimal value

11 (Hexadecimal value)

08 (Hexadecimal value) 
The communication address of parameter 8-17 is 0811H. 

5) For Delta Servo drive: 

 HMI Read/Write address setting needs to input the communication address listed in SERVO “User 

Manual”. 

 Servo Digital Input and Servo Digital Output are only for Servo. 

6) For Delta Temperature Controller (DTA series): 

HMI can be set up to connect to several Delta A series temperature controllers on standard Modbus 

networks by using RTU transmission mode. However, the communication delay time may need to 

increase. Therefore, 5ms or longer is highly recommended. 
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C. Connections (Connector Pinouts) 

Delta Servo 

RS-232 Connection 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
CN3 cable connector (RS-232) 

Controller 
CN3 cable connector 

(RS-232) 

RXD (2) (2) TX

TXD (3)

GND (5)

(4) RX

(1) GND 

 
1  

2  

3  5  

4  6 
Top View  

RS-422 Connection 

DOP Series 
9 pin D-SUB male (RS-422) 

Controller 
CN3 cable connector (RS-422) 

Controller 
CN3 cable connector 

(RS-422) 

RXD+ (2) (5) TX+

RXD- (1)

TXD+ (3)

(6) TX-

(3) RX+

TXD- (4) (4) RX-  

 
1  

2  

3  5  

4  6 
Top View  

RS-485 Connection 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
CN3 cable connector (RS-485) 

Controller 
CN3 cable connector 

(RS-485) 

RXD+ (2) (3) 485+

TXD+ (3)

RXD- (1)

(5) 485+

(4) 485-

TXD- (4) (6) 485-  

 
1  

2  

3  5  

4  6 
Top View  
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Delta AC drive 

RS-485 Connection 

DOP Series 
9 pin D-SUB male 

(RS-485) 

Controller  
RJ-11 cable connector 

(RS-485) 

Controller  
RJ-11 cable connector 

(RS-485) 

RXD+ (2) (4 ) SG+

TXD+ (3)

RXD- (1 )

TXD- (4) (3 ) SG-

GND (5) (2 ) GND 

Top View

DO NOT use Pin 1, 5 and 6 while
using RS-485 communication.

61

2: GND
3: SG-
4: SG+

 

 When connecting to Delta VFD-M series AC drives, please connect Pin 5 (GND) of a Delta HMI and Pin 

2 (GND) of a Delta VFD-M AC drive. 

Temperature Controller 

RS-485 Connection 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
RS-485 cable connector 

RXD+ (2) D+

TXD+ (3)

RXD- (1)

TXD- (4) D-  
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Delta DVP PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, Even, 2. 

Controller station number: 1. 

Control area/state area: D0 / D10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 

X_Data Xn n: 0 ~ 360(octal) N/A 

Y_Data Yn n: 0 ~ 360(octal) N/A 

M_Data Mn n: 0 ~ 1520, 1536 ~ 4080 N/A 

S_Data Sn n: 0 ~ 1008 N/A 

T_Register Tn n: 0 ~ 255 N/A 

C_Register Cn n: 0 ~ 199 N/A 

D_Register Dn n: 0 ~ 4095, 4096 ~ 9999 N/A 

HC_Register Cn n: 200 ~ 255 N/A 

NOTE  

1) (W) is “Word”. 

2) (DW) is “Double Word”. 

3) X_Data / Y_Data / M_Data / S_Data: Address must be 0 or the multiple of 16.  

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

X_Data Xn N/A n: 0 ~ 377(octal) 

Y_Data Yn N/A n: 0 ~ 377(octal) 

M_Data Mn N/A n: 0 ~ 1520, 

   1536 ~ 4080 

S_Data Sn N/A n: 0 ~ 1023 

T_Coil Tn N/A n: 0 ~ 255 

C_Coil Cn N/A n: 0 ~ 255 
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C. Connections (Connector Pinouts) 

RS-232 Connection 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232)

RXD (2) (5) TXD

TXD (3)

GND (5)

(4) RXD

(8) GND 

 1 
4 5 

8 

Top View  

RS-485 Connection 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
RS-485 cable connector 

RXD+ (2) D+

TXD+ (3)

RXD- (1 )

TXD- (4) D-  
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AllenBradley MicroLogix PLC DELTA 

A. HMI factory setting 

Baud rate: 19200, 8, None, 1. 

PLC station number: 1. 

Control area/state area: B3:0/B3:10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 

Bit No. 
Register Type Format 

Word No. 
Low Byte 

High Byte 
File No. 

Output file O:n n: 0 ~ 3 N/A 0 

Input file I:n n: 0 ~ 3 N/A 1 

Status file S2:n n: 0 ~ 65 N/A 2 

Bit file B3:n n: 0 ~ 255 N/A 3 

Timer flag T4:n n: 0 ~ 255 N/A 4 

Timer Preset Value T4:n.PRE n: 0 ~ 255 N/A 4 

Timer Accumulator Value T4:n.ACC n: 0 ~ 255 N/A 4 

Counter flag C5:n n: 0 ~ 255 N/A 5 

Counter Preset Value C5:n.PRE n: 0 ~ 255 N/A 5 

Counter Accumulator Value C5:n.ACC n: 0 ~ 255 N/A 5 

Control file R6:n n: 0 ~ 255 N/A 6 

Control Size of Bit Array R6:n.LEN n: 0 ~ 255 N/A 6 

Control Reserved file R6:n.POS n: 0 ~ 255 N/A 6 

Integer file N7:n n: 0 ~ 255 N/A 7 

 Bit No : Low byte is not used, so the value is 0. High byte stores file number. 

 Data Size : Word. 

 T4, C5 and R6 only read 1 Word once. 

 If reading multiple Words once, the communication speed of PLC will be slow. 

NOTE   

1) If last communication data has been memorized by PLC (PLC will send 0x10 0x05 consecutively), 

communication may be fail. At this time, power off and power up HMI or power off and power up PLC 

once. 
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Contacts 

Read/Write Range 

Bit No. 

Low Byte High Byte 
Contact Type Format 

Word No. 

Bits File No. 

Output O:n/b n: 0 ~ 3 b: 0 ~ 15 0 

Input  I:n/b n: 0 ~ 3 b: 0 ~ 15 1 

Status S2:n/b n: 0 ~ 65 b: 0 ~ 15 2 

Bit B3:n/b n: 0 ~ 255 b: 0 ~ 15 3 

Timer T4:n/b n: 0 ~ 255 b: 0 ~ 15 

 T4:n/EN n: 0 ~ 255 15 

 T4:n/TT n: 0 ~ 255 14 

 T4:n/DN n: 0 ~ 255 13 

4 

Timer Preset Value T4:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 4 

Timer Accumulator Value T4:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 4 

Counter flag C5:n/b n: 0 ~ 255 b: 0 ~ 15 

 C5:n/CU n: 0 ~ 255 15 

 C5:n/CD n: 0 ~ 255 14 

 C5:n/DN n: 0 ~ 255 13 

 C5:n/OV n: 0 ~ 255 12 

 C5:n/UN n: 0 ~ 255 11 

 C5:n/UA n: 0 ~ 255 10 

5 

Counter Preset Value C5:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 5 

Counter Accumulator Value C5:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 5 

Control R6:n/b n: 0 ~ 255 b: 0 ~ 15 

 R6:n/EN n: 0 ~ 255 15 

 R6:n/DN n: 0 ~ 255 13 

 R6:n/ER n: 0 ~ 255 11 

 R6:n/UL n: 0 ~ 255 10 

 R6:n/IN n: 0 ~ 255 9 

 R6:n/FD n: 0 ~ 255 8 

6 

Control Size of Bit Array R6:n.LEN/b n: 0 ~ 255 b: 0 ~ 15 6 

Control Reserved R6:n.POS/b n: 0 ~ 255 b: 0 ~ 15 6 

Integer N7:n/b n: 0 ~ 255 b: 0 ~ 15 7 

 Bit No : Low byte stores Bit address. High byte stores file number. 
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C. Connections (Connector Pinouts) 

RS-232 Connection 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
8 pin Mini DIN male 

(RS-232) 

Controller 
8 pin Mini DIN male 

(RS-232) 

RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(2) GND

(3) RTS

(6) CTS  

 1 
4 3 
7 

2 

6 

Top View  
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AllenBradley SLC5 PLC DELTA 

A. HMI factory setting 

Baud rate: 19200, 8, None, 1. 

PLC station number: 1. 

Control area/state area: B3:0/B3:10. 

NOTE   

1) Error Check uses CRC (Cyclical Redundancy Check). 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 

Word No. Bit No. 

Low Byte High Byte 
Register Type Format 

Element No.
 Slot or File No. 

Output file O:n 
O:s.n 

n: 0 ~ 30 N/A Slot No. s = 0 
s: 0 ~ 255 
File No. = 0 

Input file I:n 
I:s.n 

n: 0 ~ 30 N/A Slot No. s = 0 
s: 0 ~ 255 
File No. = 1 

Status file S2:n n: 0 ~ 255 N/A File No. = 2 

Bit file Bf:n n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 3. 

Timer flag Tf:n n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 4. 

Timer Preset Value Tf:n.PRE n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 4. 

Timer Accumulator Value Tf:n.ACC n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 4. 

Counter flag Cf:n n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 5. 

Counter Preset Value Cf:n.PRE n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 5. 
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Read/Write Range 

Word No. Bit No. 

Low Byte High Byte 
Register Type Format 

Element No.
 Slot or File No. 

Counter Accumulator Value Cf:n.ACC n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 5. 

Control file Rf:n n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 6. 

Control Size of Bit Array Rf:n.LEN n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 6. 

Control Reserved file Rf:n.POS n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 6. 

Integer file Nf:n n: 0 ~ 255 N/A f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 7. 

 Bit No : Low byte is not used, so the value is 0. High byte stores file number. 

Contacts 

Read/Write Range 

Word No. Bit No. 

Low Byte High Byte 
Contact Type Format 

Element No.
Bits Slot or File No. 

Output O:n/b 
O:s.n/b 

n: 0 ~ 30 b: 0 ~ 15 Slot No. s = 0 
s: 0 ~ 255 
File No. = 0 

Input I:n/b 
I:s.n/b 

n: 0 ~ 30 b: 0 ~ 15 Slot No. 
s = 0 
s: 0 ~ 255 
File No. = 1 

Status S2:n/b n: 0 ~ 31 b: 0 ~ 15 2 

Bit Bf:n/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 3. 

Timer Tf:n/b n: 0 ~ 255 b: 0 ~ 15 

 Tf:n/EN n: 0 ~ 255 15 

 Tf:n/TT n: 0 ~ 255 14 

 Tf:n/DN n: 0 ~ 255 13 

f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 4. 

Timer Preset Value Tf:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 4. 
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Read/Write Range 

Word No. Bit No. 

Low Byte High Byte 
Contact Type Format 

Element No.
Bits Slot or File No. 

Timer Accumulator Value Tf:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 4. 

Counter flag Cf:n/b n: 0 ~ 255 b: 0 ~ 15 

 Cf:n/CU n: 0 ~ 255 15 

 Cf:n/CD n: 0 ~ 255 14 

 Cf:n/DN n: 0 ~ 255 13 

 Cf:n/OV n: 0 ~ 255 12 

 Cf:n/UN n: 0 ~ 255 11 

 Cf:n/UA n: 0 ~ 255 10 

f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 5. 

Counter Preset Value Cf:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 5. 

Counter Accumulator Value Cf:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 5. 

Control Rf:n/b n: 0 ~ 255 b: 0 ~ 15 

 Rf:n/EN n: 0 ~ 255 15 

 Rf:n/DN n: 0 ~ 255 13 

 Rf:n/ER n: 0 ~ 255 11 

 Rf:n/UL n: 0 ~ 255 10 

 Rf:n/IN n: 0 ~ 255 9 

 Rf:n/FD n: 0 ~ 255 8 

f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 6. 

Control Size of Bit Array Rf:n.LEN/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 6. 

Control Reserved Rf:n.POS/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 6. 

Integer Nf:n/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
If f is ignored, file no. will be 
default setting 7. 

 Bit No : Low byte stores Bit address. High byte stores file number. 

NOTE   

1) Device O and I need to assign Slot No. (s). If not assign Slot No., it will use default setting 0. 

 

 



Appendix B  Communication|ScrEdit Software User Manual 

B-18   Revision 05/30/2006, EH00 

C. Connections (Connector Pinouts) 

RS-232 Connection 

DOP series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB female 

(RS-232) 

Controller 
9 pin D-SUB female 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG

(7) RTS

(8) CTS 

 
 
 
 
 
 

Top View 

 
 

Pin1
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Danfoss VLT 2800 (FC Protocol) DELTA 

A. HMI factory setting 

Baud rate: 9600, 8, Even, 1, RS-485. 

PLC station number: 1. 

Control area/state area: None / None. 

NOTE   

1) Delta HMI can be connected to for VLT-2800, 5000, 6000, 7000 controllers. 

2) Each data length format of Danfoss AC drive parameter is not fixed, therefore, “Multiple Duplicate” 

function is not provided. 

3) Max. supported alarm number is 16. If the alarm number is over 16, a fault will occur. 

4) Not support “optimum read/write” characteristic. 

5) If the selected element is a string, the minimum data length should be more than 2. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 

Bit No. 

Low Byte High Byte 
Register Type Format 

Word No. 

 Index No. 

Parameter Pn:I n: 0 ~ 999 0 I: 0 ~ 31 

Control Word CTRWD 0 N/A N/A 

Status Word STAWD 0 N/A N/A 

 Index No : If the index No. is not used, its default setting will be 0. The default setting of index No. for 

parameter P606 ~ P617 is 1. 

 Please notice that it is necessary to input the index No. when using some parameters of Danfoss 

controllers. At this time, please pay close attention on the setting range of index number. If the setting 

range is not started from 0, the parameter read & write failure will occur. For example, the index No. 

setting range of the parameter P615 is from 1 to 20, if the users do not input the index No., the system 

will assume the index number is 0 (default setting) and the a fault will occur when the users read or write 

the parameter. 

 CTRWD: Write-only. (Can not be used on the devices which can display the value or input value. It is 

recommended to be used on the setting value/setting constant (button), or marco function.) 

 STAWD: Read-only. 

 Control & Status Word: Please refer to the explanation on the next page (page B-20). 
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Contacts 

Read/Write Range 

Word No. Bit No. 

Low Byte High Byte 
Contact Type Format 

Element No.
Bits Index No. 

Parameter Pn:I.b n: 0 ~ 999 b: 0 ~ 31 I: 0 ~ 31 

 Bit No : Low byte stores Bit address. High byte stores index number. 

C. Connections (Connector Pinouts) 

RS-485 Connection 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
RS-485 cable connector 

RXD+ (2) 68 TXD/RXD+

TXD+ (3 )

RXD- (1 )

TXD- (4)

Shell Shell

69 TXD/RXD-

 

Explanation of Control Word & Status Word 

Control Word 

Bit Bit = 0 Bit = 1 

15 No Function Reversing 

14 Choice of Setup 2 (msb) 

13 Choice of Setup 1 (lsb) 

12 No Function Relay 04 activated 

11 No Function Relay 01 activated 

10 Data Not Vaild Vaild 

9 Ramp 1 Ramp2 

8 Jog 1 OFF ON 

7 No Function Reset 

6 Ramp Stop Start 

5 Hold Ramp Enable 

4 Quick-Stop Ramp 

3 Coasting Enable 

2 DC Brake Ramp 

1 Preset reference choice msb 

0 Preset reference choice msb 

 When Bit 10 = 1 (Data Valid), the Control Word is valid. 
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Status Word 

Bit Bit = 0 Bit = 1 

15 Timer OK Above limit 

14 Torque OK Above limit 

13 Voltage OK Above limit 

12 Temperature OK Over-Temp, auto-start pending 

11 Not Running Running 

10 Out of Range Frequency OK 

9 Local Control Bus Control 

8 Speed ≠ reference Speed = reference 

7 No Warning Warning 

6 Reserved 

5 Reserved 

4 Reserved 

3 No Fault Trip 

2 Coasting Enabled 

1 VLT not ready Ready 

0 Control not ready Ready 
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Facon FB Series PLC DELTA 

A. HMI factory settings  

Baud rate: 9600, 7, Even, 1. 

Controller Station number: 1. 

Control area/state area: R0 / R10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write range 
Register Type Format 

Word No. Bit No. 
Data length 

Input Relay WXn n: 0 ~ 9992 N/A Byte 

Output Relay WYn n: 0 ~ 9992 N/A Byte 

Internal Relay WMn n: 0 ~ 9992 N/A Byte 

Step Relay WSn n: 0 ~ 9992 N/A Byte 

Data Register Rn n: 0 ~ 65534 N/A Word 

Data Register Dn n: 0 ~ 65534 N/A Word 

Timer Present Value RTn n: 0 ~ 9999 N/A Word 

Counter Present Value RCn n: 0 ~ 9999 N/A Word 

Data Register DRCn n: 200 ~ 255 N/A Double Word 

 Input Relay / Output Relay / Internal Relay / Special Relay: Address must be the multiple of 8. 

Contacts 

Read/Write range 
Contact type Format 

Word No. Bit No. 

Input Relay Xn N/A n: 0 ~ 9999 

Output Relay Yn N/A n: 0 ~ 9999 

Internal Relay Mn N/A n: 0 ~ 9999 

Step Relay Sn N/A n: 0 ~ 9999 

Timer Flag Tn N/A n: 0 ~ 9999 

Counter Flag Cn N/A n: 0 ~ 9999 
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C. Connections (Connector Pinouts) 

RS-232 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
15 pin male (RS-232) 

Controller 
15 pin male (RS-232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(1) RXD

(6) SG

(3) RTS

(4) CTS 

 
Top View 

RS-232 

Connecting to CB (Communication Board) or CM (Communication Module) 

FBs Series Port 1 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male (RS-232)

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(5) GND

(8) RTS

(7) CTS  

 

 

RS-232 

FBs Series Port 0 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
4 pin Mini DIN male 

(RS-232) 

Controller 
4 pin Mini DIN male 

(RS-232) 

RXD (2) (4) TXD

TXD (3)

GND (5)

(2) RXD

(1) GND

(3) +5V  

 
1 2 

3 4 

Top View  
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Festo PLC DELTA 

A. HMI factory settings  

Baud rate: 9600, 8, None, 1. 

Controller Station number: 0. (no PLC station number in protocol) 

Control area/state area: R0 / R10. 

NOTE  

1) Connectable PLC: FEC-FC Model 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size 

WORD_DEVICE_IW Iwn n: 0 ~ 255 N/A Word 

WORD_DEVICE_OW Own n: 0 ~ 255 N/A Word 

WORD_DEVICE_FW FWn n: 0 ~ 9999 N/A Word 

WORD_DEVICE_TW TWn n: 0 ~ 255 N/A Word 

WORD_DEVICE_CW CWn n: 0 ~ 255 N/A Word 

WORD_DEVICE_R Rn n: 0 ~ 255 N/A Word 

WORD_DEVICE_TP TPn n: 0 ~ 255 N/A Word 

WORD_DEVICE_CP CPn n: 0 ~ 255 N/A Word 

Contacts 

Register Type Format Word No. Bit No. 

BIT_DEVICE_I In.b n: 0 ~ 255 b: 0 ~ 15 

BIT_DEVICE_O On.b n: 0 ~ 255 b: 0 ~ 15 

BIT_DEVICE_F Fn.b n: 0 ~ 9999 b: 0 ~ 15 

BIT_DEVICE_T Tn N/A n: 0 ~ 255 

BIT_DEVICE_C Cn N/A n: 0 ~ 255 

BIT_DEVICE_TON TONn N/A n: 0 ~ 255 

BIT_DEVICE_TOFF TOFFn N/A n: 0 ~ 255 

 BIT_DEVICE_T / BIT_DEVICE_C / BIT_DEVICE_TON / BIT_DEVICE_TOFF: Only 1 Bit can be 

transferred for each communication. 

 Only 1 Bit or 1 Word can be transferred for each write command.  
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C. Connections 

NOTE  

1) Communication port of PLC: COM port 

2) It needs to use the dedicated cable for FESTO controllers  Cable for transferring TTL to RS-232 and it 

is 6 pin RJ-12 connector at PLC side. 
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GE Fanuc 90 Series SNP PLC DELTA 

A. HMI factory settings  

Baud rate: 19200, 8, ODD, 1. 

Controller Station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: %R1 / %R10. 

NOTE  

1) Please notice that no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) communication 

is allowed. 

2) If the PLC enabled “Check Password” function, the user needs to set the password by clicking Option > 

Configuration > Communication. The user can find Controller Settings and set PLC password on 

Communication Tab in the Configuration dialog box. Please enter a 4-digit password (If entering a 

password that exceeds 4-digit number, only the first 4-digit number is valid). 

B. Definition of controller Read/Write address 

Registers 

Read/Write range 
Register Type Format 

Word No. Bit No. 
Data length 

Discrete Inputs %In n: 1 ~ 12288 N/A Word (the multiple of 16 + 1) 

Discrete Outputs %Qn n: 1 ~ 12288 N/A Word (the multiple of 16 + 1) 

Discrete Temporaries %Tn n: 1 ~ 256 N/A Word (the multiple of 16 + 1) 

Discrete Internals %Mn n: 1 ~ 12288 N/A Word (the multiple of 16 + 1) 

%SA Discretes %SAn n: 1 ~ 128 N/A Word (the multiple of 16 + 1) 

%SB Discretes %SBn n: 1 ~ 128 N/A Word (the multiple of 16 + 1) 

%SC Discretes %SCn n: 1 ~ 128 N/A Word (the multiple of 16 + 1) 

%S Discretes %S-n n: 1 ~ 128 N/A Word (the multiple of 16 + 1) 

Genius Global Data %Gn n: 1 ~ 7680 N/A Word (the multiple of 16 + 1) 

Registers %Rn n: 1 ~ 16384 N/A Word 

Analog Inputs %AIn n: 1 ~ 8192 N/A Word 

Analog Outputs %AQn n: 1 ~ 8192 N/A Word 
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Contacts 

Read/Write range 
Contact Type Format 

Word No. Bit No. 

Discrete Inputs %In N/A n: 1 ~ 12288 

Discrete Outputs %Qn N/A n: 1 ~ 12288 

Discrete Temporaries %Tn N/A n: 1 ~ 256 

Discrete Internals %Mn N/A n: 1 ~ 12288 

%SA Discretes %SAn N/A n: 1 ~ 128 

%SB Discretes %SBn N/A n: 1 ~ 128 

%SC Discretes %SCn N/A n: 1 ~ 128 

%S Discretes %-Sn N/A n: 1 ~ 128 

Genius Global Data %Gn N/A n: 1 ~ 7680 

C. Connections (Connector Pinouts) 

RS-232 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
RJ-45 cable connector 

(RS-232) 

Controller 
RJ-45 cable connector 

(RS-232) 
 

RXD (2) (5) TXD

TXD (3)

GND (5)

(6) RXD

(4) GND Top View
81
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HUST CNC Controller DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 2. 

Controller station number: 0. 

Control area/state area: W0 / W10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data Length 

Word Register Wn n: 0 ~ 13500 N/A Word 

Double Word Register Dn n: 0 ~ 13500 N/A Double Word 

NOTE   

1) The unit for Hust CNC controller is D Word and Wn is the low word of Dn. 

Contacts 

Read/Write range 
Contact Type Format 

Word No. Bit No. 

BIT_DEVICE_B Bm.n m: 0 ~ 13500 n: 0 ~ 31 

BIT_DEVICE_I In N/A n: 0 ~ 255 (8 DW) 

BIT_DEVICE_O On N/A n: 0 ~ 255 (8 DW) 

BIT_DEVICE_C Cn N/A n: 0 ~ 255 (8 DW) 

BIT_DEVICE_S Sn N/A n: 0 ~ 255 (8 DW) 

BIT_DEVICE_A An N/A n: 0 ~ 1023 (32 DW) 

C. Connections (Connector Pinouts) 

RS-232 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(5) SG

(8) RTS

(7) CTS 

Top View
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Jetter Nano Series PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, EVEN, 1 (RS-232). 

Controller station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: WR0 / WR10. 

NOTE  

1) Please notice that no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) communication 

is allowed. 

2) Only 1 Bit or 1 Word can be transferred for each communication. 

3) In general, each register occupies max. 24 Bits. However, some registers occupies 8 Bits only. 

4) Because the initial time of this controller is longer, it is recommended to set HMI startup delay time 

(Recommended time is 10 seconds). 

5) When the register R is used for Double Word device, please set its format as signed format. (The default 

format in Screen Editor is signed format) 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data 

Length 

16 Bits Register WRn n: 0 ~ 32767 N/A 16 Bits 

32 Bits Register Rn n: 0 ~ 32767 N/A 24 Bits 

Only the first 16 bits are used for WRn registers. 

Only the first 24 bits are used for Rn registers, the highest 8 bits (Bit 24 ~ 31) are set to 0 by default setting. 

(24-bit Integer : If in decimal format, the range is -8388608 ~ +8388607. If in hexadecimal format, the range 

is 0x000000 ~ 0xFFFFFF.) 

NOTE   

1) The difference between WRn and Rn: 

 When using devices that the data length is in Word, only Bit 0 ~ 15 are valid for both of WRn and 

Rn registers. 

 When using devices that the data length is in Double Word,  

if the read/write address format is set to WRn, the Bit 0 ~ 15 of WRn register is the low word of a 

read/write value, the Bit 0 ~ 15 of WRn+1 register is the high word of a read/write value.  



Appendix B  Communication|ScrEdit Software User Manual 

B-30   Revision 05/30/2006, EH00 

if the read/write address format is set to Rn, only Bit 0 ~ 23 are valid for Rn registers. 

(Notice: As the Jetter controller is a 24-bit format controller, the valid setting range is 24 Bits. 

If exceeds this range, HMI will stop read/write operation and show  “…..Value is Incorrect” 

on the screen. So, please do not set any bit on Bit24 ~ Bit31 (Bit24 ~ Bit31 cannot be written).  

 When using devices that the data length is in m Words,  

if the read/write address format is set to WRn, the Bit 0 ~ 15 of WRn register is the lowest word of a 

read/write value and the Bit 0 ~ 15 of WRn+m-1 register is the highest word of a read/write value. 

if the read/write address format is set to Rn, the Bit 0 ~ 23 of Rn register is the lowest word of a 

read/write value and the Bit 0 ~ 23 of Rn+1 register is the highest word of a read/write value. 

Each register is regards as a “Double Word”. The value of Bit24 ~ Bit31 is 0.  

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Relay Inbb n: 1 ~ 32 bb: 01 ~ 08 

Output Relay Onbb n: 1 ~ 32 bb: 01 ~ 08 

Flag Relay Fn N/A n: 0 ~ 32767 

C. Connections (Connector Pinouts) 

RS-232 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(7) GND 
Top View

 The pin definition of the cable of Jetter controller is different than the general cable. Please pay close 

attention on it and do not mistake. 
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Jetter JC Series PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, EVEN, 1 (RS-232). 

Controller station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: WR0 / WR10. 

NOTE  

1) Please notice that no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) communication 

is allowed. 

2) Only 1 Bit or 1 Word / 2 Words can be transferred for each read and write command. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data 

Length 

16 Bits Register WRn n: 0 ~ 32767 N/A 16 Bits 

32 Bits Register Rn n: 0 ~ 32767 N/A 24 Bits 

The characteristics of WRn and Rn of JC series are the same as the Nano series. Please refer to page B-29 

and B-30. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Relay Inbb n: 1 ~ 32 bb: 01 ~ 16 

Output Relay Onbb n: 1 ~ 32 bb: 01 ~ 16 

Flag Relay Fn N/A n: 0 ~ 32767 
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C. Connections (Connector Pinouts) 

RS-232 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232)

RXD (2) (8) TXD

TXD (3)

GND (5)

(4) RXD

(2) GND 

 2 
4 

8 

 
Top View 

 

Controller side (Comm. Port)
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Keyence KV/KZ Series DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, EVEN, 1 (RS-232). 

Controller station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: DM-0 / DM-10. 

NOTE  

1) Please notice that no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) communication 

is allowed. 

2) Only 1 Bit or 1 Word can be transferred for each communication. (Communication speed is slow.) 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data Length 

Timer T-nnn nnn: 0 ~ 199 N/A Word 

Counter C-nnn nnn: 0 ~ 199 N/A Word 

High-speed counter CTH-n n: 0 ~ 1 N/A Word 

High-speed counter 
comparator CTC-n n: 0 ~ 3 N/A Word 

Data memory DM-nnnn nnnn: 0 ~ 1999 N/A Word 

Temporary data memory TM-nn nn: 0 ~ 31 N/A Word 

Timer preset value PT-nnn nnn: 0 ~ 199 N/A Word 

Counter preset value PC-nnn nnn: 0 ~ 199 N/A Word 

CTC preset value PCTC-n n: 0 ~ 3 N/A Word 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Relay R-nnnbb nnn: 0 ~ 69 bb: 00 ~ 15 

Timer T-nnn N/A nnn: 0 ~ 199 

Counter C-nnn N/A nnn: 0 ~ 199 

High-speed counter  
comparator 

CTC-n N/A n: 0 ~ 3 

 

 



Appendix B  Communication|ScrEdit Software User Manual 

B-34   Revision 05/30/2006, EH00 

NOTE  

When using the protocol format of KV series and connecting to KZ-80T PLC, some errors occur. Please refer 

to the following description: 

1) Readable Timer address is not continuous. For example, T-0 ~ T-9 can be read, T10 cannot be read, 

T11 ~ T20 can be read, T21 ~ T50 cannot be read, …etc. 

2) Counter cannot be read. For example, 

Registers: C- (Counter), CTH- (High-speed counter), CTC- (High-speed counter comparator), 

PC- (Counter preset value), PCTC- (CTC preset value) they all cannot be read. 

Contacts: C- (Counter), CTC- (High-speed counter comparator) they all cannot be read also. 

C. Connections (Connector Pinouts) 

RS-232 

KV Series 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

RXD (2) (3) SD

TXD (3)

GND (5)

(5) RD

(4) SG 

 

Top View
6 - 1

 
 

 
PLC side (Comm. Port) 

KZ Series 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

RXD (2) (5) SD

TXD (3)

GND (5)

(3) RD

(4) SG 

 

Top View
6 - 1

 

 
PLC side (Comm. Port) 
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NOTE  

1) Communication Cable: The pins of SD and RD of KZ-80T and KV Series are reverse. 
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Koyo SU/DL Series DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1 (RS-232). 

Controller station number: 1. 

Control area/state area: V1400 / V1410. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data 

Length 

Timer Accumulated Vn n: 0 ~ 177 (octal) N/A Word 

Counter Accumulated Vn n: 1000 ~ 1177 (octal) N/A Word 

V Memory Vn n:  1400 ~ 7777 (octal) N/A Word 

Linker Relays Vn n: 40000 ~ 40037 (octal) N/A Word 

Input Status Vn n: 40400 ~ 40423 (octal) N/A Word 

Output Status Vn n: 40500 ~ 40523 (octal) N/A Word 

Control Relays Vn n: 40600 ~ 40635 (octal) N/A Word 

Stage Vn n: 41000 ~ 41027 (octal) N/A Word 

Timer Status Vn n: 41100 ~ 41107 (octal) N/A Word 

Counter Status Vn n: 41140 ~ 41147 (octal) N/A Word 

Spec. Relay 1 Vn n: 41200 ~ 41205 (octal) N/A Word 

Spec. Relay 2 Vn n: 41216 ~ 41230 (octal) N/A Word 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

 Linker Relays GXn N/A n: 0 ~ 777 (octal) 

 Input Status Xn N/A n: 0 ~ 477 (octal) 

 Output Status Yn N/A n: 0 ~ 477 (octal) 

 Control Relays Cn N/A n: 0 ~ 737 (octal) 

 Stage Sn N/A n: 0 ~ 577 (octal) 

 Timer Status Tn N/A n: 0 ~ 177 (octal) 

 Counter Status CTn N/A n: 0 ~ 177 (octal) 

 Spec. Relay 1 SPn N/A n: 0 ~ 137 (octal) 

 Spec. Relay 2 SPn N/A n: 320 ~ 617 (octal) 
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C. Connections (Connector Pinouts) 

RS-232 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

RXD(2)

TXD(3)

GND(5)

(4)TXD

(3)RXD

(1)GND

(6)GND 

 

Top View
1 - 6
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Koyo K-Sequence DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1 (RS-232). 

Controller station number: 1. 

Control area/state area: R1400 / R1420. 

NOTE  

1) If read / write the address that exceeds the valid range, HMI will stop read/write operation and show  

“….Error 6….. Command Can Not be Executed….” on the screen. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data 

Length 

Input Status Xnnnn nnnn: 0 ~ 1760 (octal) N/A Word 

Output Status Ynnnn nnnn: 0 ~ 1760 (octal) N/A Word 

Link Relays GXnnnn nnnn: 0 ~ 3760 (octal) N/A Word 

Relays GQnnnn nnnn: 0 ~ 3760 (octal) N/A Word 

Relays Mnnnn nnnn: 0 ~ 3760 (octal) N/A Word 

Stage Snnnn nnnn: 0 ~ 1760 (octal) N/A Word 

Timer Status Tnnn nnn: 0 ~ 360 (octal) N/A Word 

Control Relays Cnnn nnn: 0 ~ 360 (octal) N/A Word 

Special Relay 1 SPnnn nnn: 0 ~ 760 (octal) N/A Word 

Register Rnnnnn nnnnn: 0 ~ 41237 (octal) N/A Word 

Register Pnnnnn nnnnn: 0 ~ 37777 (octal) N/A Word 

 nnnn: It is in octal format and it must be the multiple of 16 except for R and P. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Status Xnnnn N/A nnnn: 0 ~ 1777 (octal) 

Output Status Ynnnn N/A nnnn: 0 ~ 1777 (octal) 

Linker Relays GXnnnn N/A nnnn: 0 ~ 3777 (octal) 

Relays GQnnnn N/A nnnn: 0 ~ 3777 (octal) 

Control Relays Mnnnn N/A nnnn: 0 ~ 3777 (octal) 

Stage Snnnn N/A nnnn: 0 ~ 1777 (octal) 

Timer Status Tnnn N/A nnn: 0 ~ 377 (octal) 
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Read/Write Range 
Contact type Format 

Word No. Bit No. 

Counter Status Cnnn N/A nnn: 0 ~ 377 (octal) 

Spec. Relay 1 SPnnn N/A nnn: 0 ~ 777 (octal) 

C. Connections (Connector Pinouts) 

RS-232 

Port 0 Communication Cable 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

Controller 
RJ-11 cable connector 

(RS-232) 

RXD(2)

TXD(3)

GND(5)

(4 )TXD

(3 )RXD

(1 )GND

(6 )GND  (Note 1) 

 

Top View
1 - 6

 

 If pin 6 is not grounded, a communication error may occur when connecting to a CKD SM 24R controller. 

Ensure that pin 6 is well grounded. There is no problem when connecting to SN32DRA controller no 

matter pin6 is grounded or not. 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  
Top View

RS-485 

Port 1 Communication Cable 

DOP 
9 pin D-SUB male (RS-485) 

DOP 
9 pin D-SUB male (RS-485) 

D- (1) D-

D+ (2)

D+ (3)

D+

D- (4)
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The corresponding registers of CCM2 and K-Sequence 

Address Corresponding Relationship: 

CCM2 K sequence SN32DRA 
V R R 
X X I 
Y Y Q 
C M M 
S S S 
T T T 

CT C C 
SP SP SP 
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Lenze LECOM-A/B Protocol DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1 (Baudrate: 1200/2400/4800/9600/19200). 

Controller station number: 1 (1~99). 

Control area/state area: None / None. 

NOTE   

1) Please pay close attention to each pin definition of cable connectors. 

2) Ensure not to use the general RS-232 5-pin cable. This is because if pin 2, 3, 5, 7, 8 are all connected to 

the drive, the drive can not recognize the communication signal and can not identify what kind of 

communication it is.  

3) For more detailed information of pin definition of cable connectors, please refer to the  C. Connections 

(Connector Pinouts) in page B-26 and B-27. 

4) Ensure the HMI communication data format (The communication data written into the drive) is correct. 

The Word “m” in the following table is used to specify the HMI communication data format. 

5) Ensure the HMI display data format (Property table/Setting value...etc.) is correct. 

6) When using broadcast function, please check if the using device is available. This is because the 

broadcast function can be activated only when the user choose “write only” device for broadcast station 

number (only choose setting value/setting constant (button) and then the broadcast function can be 

used). If choosing other devices, the system will ask you to read back the drive setting value, so please 

ensure to choose the correct device. If choosing the incorrect devices, a “Controller Station Number 

Error…” fault message will display on HMI screen. 

7) Support 82XX frequency AC drives and 93XX servo drives. 

B. Definition of controller Read/Write address 

Registers (n, m, y are in decimal) 

Read/Write Range 

Word No. Bit No. 

 LowByte HighByte 
Register Type Format 

  subcode 

Data Length 

CWn n: 1 ~ 10000 N/A N/A Word Parameter without subcode

CWn.m n: 1 ~ 10000 m: 0 ~ 23 N/A Word 

Parameter with subcode CWn/y n: 1 ~ 10000 N/A y:1 ~ 255 Word 

 CWn/y.m n: 1 ~ 10000 m: 0 ~ 23 y:1 ~ 255 Word 
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Read/Write Range 

Word No. Bit No. 

 LowByte HighByte 
Register Type Format 

  subcode 

Data Length 

CDn n: 1 ~ 10000 N/A N/A DoubleWord Parameter without subcode

CDn.m n: 1 ~ 10000 m: 0 ~ 23 N/A DoubleWord 

Parameter with subcode CDn/y n: 1 ~ 10000 N/A y:1 ~ 255 DoubleWord 

 CDn/y.m n: 1 ~ 10000 m: 0 ~ 23 y:1 ~ 255 DoubleWord 

NOTE   

1) m :  HMI communication data format 

2) The value of m represents the different communication data format: 

 If m value is undefined: ASCII hexadecimal format (VH). (4 or 8 numbers.) 

 m >= 23 : ASCII hexadecimal format (VH). (4 or 8 numbers.) 

 m = 0 ~10 : unsigned, ASCII decimal format (VD). 

m represents decimal place, For example: 

m=0  no decimal place 

m=1  one decimal place (tenth) 

m=2  two decimal place (hundredth) 

 m = 11 ~20 : signed, ASCII decimal format (VD). 

m represents decimal place, For example: 

m=11  one decimal place (tenth) 

m=12  two decimal place (hundredth) 

 m = 21 : signed, ASCII decimal format (VD). 

without decimal place 

 m = 22 : ASCII hexadecimal format (VH). 2 numbers. 

when using this format, the write value will be limited within the range of 0~0xFF 
(low byte). 

For example: when entering 0x1234 during communication, the actual write value 
is 0x34, not 0x1234. 

Contacts (n, b, y are in decimal) 

Read/Write Range 

Word No. Bit No. 

 LowByte HighByte 
Register Type Format 

  subcode 

Parameter without subcode CBn.b n: 1 ~ 10000 b: 0 ~ 31 N/A 

Parameter with subcode CBn/y.b n: 1 ~ 10000 b: 0 ~ 31 1 ~ 255 
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Only VH type parameter can provide Bit read/write function (it is convenient for the user to read/write Bit No. 

of parameters). 

CBn.b, CWn (CWn.m), CDn (CDn.m): read/write address is the same (address n). 

NOTE   

1) Since the data format of this controller is complicated (a. VS (String format), b. VO (Octet string format 

data blocks), c. VH (ASCII hexadecimal format)(1, 2, 4 bytes), d. VD (ASCII decimal format)(positive, 

negative, decimal,..)) and the communication format is not compatible, therefore, it is needed to ensure 

the HMI communication data format is correct, or the error may occur. 

2) Registers: only can read/write the data of ASCII hexadecimal format (VH), ASCII decimal format (VD) 

(i.e. Either VH or VD data format can be set via communication.) 

Contacts: only can read/write the data of ASCII hexadecimal format (VH) 

HMI display data format (Property table/Setting value...etc.) should also be correct. 

Explanation: 

 Registers: only can read/write the data of VH, VD. HMI needs to set communication data format 

(please refer to 4), 5) and 6)). String format (VS), and Octet string format for data blocks (VO) can 

not be used. If the controller returns the data in VS or VO format, HMI will show “……Value Is 

Incorrect” on the screen. 

 Contacts: only can read/write the data of ASCII hexadecimal format (VH). Only VH type parameter 

can provide Bit read/write function. If the controller returns the data in other format, HMI will show 

“……Value Is Incorrect” on the screen. 

 Do not write the inexistent Bit address, or HMI will show “….Write …. Command Can Not be 

Executed” on the screen.  

For example: CW470/1. The valid value of CW470/1 is within the range of 0 ~ 0xFF. Therefore, Bit 

8 ~31 is not existed. Although HMI will show the value of Bit 8 ~31 is 0, the user can not write or set 

the value. 

 The settings of ASCII hexadecimal format (VH) and ASCII decimal format (VD) should be correct. If 

the VD data is set in VH format in HMI (m value is undefined, or m=22 or 23) or the VH data is set 

in VD format in HMI (m=0 ~ 21), when HMI write the data, HMI will show “….Write …. Command 

Can Not be Executed” on the screen or tell the user the write value is incorrect. 

 The decimal place of ASCII decimal format (VD) should be set correctly, or the write value will not 

be correct. The decimal place displayed on HMI should also be correct, or the display value will be 

incorrect. 

 ASCII hexadecimal format (VH), 2 numbers (m = 22). The value is limited to 2 numbers. Using this 

format the write value will be limited within the range of 0 ~ 0xFF (low byte) automatically. 

3) Station Number and Broadcast 

 The valid station number is from 0 to 99. If exceeds this range, HMI will stop read/write operation 

and show “Controller Station Number Error …”on the screen. 
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 00 indicates the global broadcasting number (1~99). 

 10, 20, 30, 40, 50, 60, 70, 80, 90 are local broadcasting number. 

The affected ranges are: 11~19, 21~29, 31~39, 41~49, 51~59, 61~69, 71~79, 81~89 and 91~99 

respectively. Only choose setting value/setting constant (button), and then the broadcast function 

can be used. If choosing other devices, the system will be confused while reading back the drive 

setting value via broadcast function, so please ensure to choose the correct device. If choosing the 

incorrect devices, a “Controller Station Number Error…” fault message will display on HMI screen. 

 Use in LECOM-A/B protocol. 82XX frequency AC drives and 93XX servo drives all use this protocol. 

4) Explanation of communication error address 

 Registers: display CW n,  CWy n,  CD n,  CDy n  in order 

 Contacts: display CB n,  CByn  in order                     (n: address value) 

5) HMI data format explanation 

 Some controller parameters are in Word and some are in Double Word. Therefore, there are two 

kinds of data format: Word ( CWn (CWn.m), CWn/y(CWn/y.m) ) and Double Word ( CDn (CDn.m), 

CDn/y(CDn/y.m) ). 

 Furthermore, regarding to Bit No., HMI only read/write 32Bit (Bit0 ~ Bit31) of parameters in VH 

format. 

 CWn(CWn.m), CDn(CDn.m), or CBn.b: read/write address is the same (address n), but 

When symbol is set to CW, read/write value is the low word of parameters (n) only, 

When symbol is set to CD, read/write value is the Double Word of whole parameters (n), 

When symbol is set to CB, read/write value is the Bit (b) No. of parameters (n). 

(m : HMI communication data format) 

 (CWn/y(CWn/y.m), CDn/y(CDn/y.m), CBn/y.b: read/write address, which y subcode is the 

same(address n), but 

When symbol is set to CW, read/write value is the low word of parameters (n) only, 

When symbol is set to CD, read/write value is the Double Word of whole parameters (n), 

When symbol is set to CB, read/write value is the Bit (b) No. of parameters (n). 

(m : HMI communication data format) 

 Actually when using HMI, 

i) When using devices that the unit is in Word (e.g. numeric devices (numeric value display, 

numeric value input…)…), the read/write value will be the same no matter the read/write 

address format is set to CWn or CDn as read/write value is the low word of parameters (n) 

only. 

ii) When using devices that the unit is in Double Word (e.g. numeric devices (numeric value 

display, numeric value input…)…), if the read/write address format is set to CWn, 

read/write value is coming from the low word of CWn and CWn+1 these two addresses. 

(The low word of CWn is regarded as “low word” and the low word of CWn+1 is regarded 

as “high word”, and then combining “low word” and “high word” to a Double Word.) 
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If the read/write address format is set to CDn, read/write value is the whole Double Word 

of CDn (1 address). 

iii) When using character device (e.g. character display, character input…), if the read/write 

address format is set to CWn, the read/write value is coming from the low word of CWn, 

CWn+1, CWn+2, …every address. 

If the read/write address format is set to CDn, read/write value is the whole Double Word 

of CDn, CDn+1, CDn+2,…every address. 

iv) When using “Multiple Duplicate” function, if the Word and Bit addresses exceed the valid 

range, the Word and Bit addresses will be set to 0 automatically. Sometime error will 

occur to remind the user when compiling. 

v) CBn.b, CBn/y.b are added for the user to read and write Bit No. of parameters in VH 

format more easily. 

vi) Only can read or write 1 parameter for each communication.  

C. Connections (Connector Pinouts) 

Pin 2, 3, 5 are for RS-232 communication. Pin 7, 8 are for RS-485 communication. 

RS-232 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 

 

 
Top View 

RS-485 

DOP 
9 pin D-SUB male 

(RS-485) 

Controller 
9 pin D-SUB male 

(RS-485) 

Controller 
9 pin D-SUB male 

(RS-485) 

D- (1) (7) T/R (A)

D+ (2)

D+ (3)

(8) T/R (B)

D- (4)

 

 

 
Top View 
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LG Master K120S/200S DELTA 

A. HMI factory settings 

Baud rate: 38400, 8, None, 1. (RS-232) 

Controller station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: DW0 / DW10. 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size 

WORD_DEVICE_PW PWn n: 0 ~ 15 N/A Word 

WORD_DEVICE_MW MWn n: 0 ~ 191 N/A Word 

WORD_DEVICE_KW KWn n: 0 ~ 31 N/A Word 

WORD_DEVICE_LW LWn n: 0 ~ 63 N/A Word 

WORD_DEVICE_FW FWn n: 0 ~ 63 N/A Word 

WORD_DEVICE_TW TWn n: 0 ~ 255 N/A Word 

WORD_DEVICE_CW CWn n: 0 ~ 255 N/A Word 

WORD_DEVICE_DW DWn n: 0 ~ 9999 N/A Word 

Contacts 

Contact type Format Word No. Bit No. 

BIT_DEVICE_P Pnb n: 0 ~ 15 b: 0 ~ f 

BIT_DEVICE_M Mnb n: 0 ~ 191 b: 0 ~ f 

BIT_DEVICE_K Knb n: 0 ~ 31 b: 0 ~ f 

BIT_DEVICE_L Lnb n: 0 ~ 63 b: 0 ~ f 

BIT_DEVICE_F Fnb n: 0 ~ 63 b: 0 ~ f 

BIT_DEVICE_T Tn N/A n: 0 ~ 255 

BIT_DEVICE_C Cn N/A n: 0 ~ 255 
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C. Connections (Connector Pinouts) 

RS-232 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 9 pin D-SUB male 
(RS-232 for LG K120S/200S) 

Controller 9 pin D-SUB male
(RS-232 for LG K120S/200S)

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 

 

 
Top View 

NOTE   

1) If connecting to Pin 4 (RXD), Pin 7 (TXD) and Pin5 (SG), it indicates that CNet protocol is used (Please 

refer to the section “LG Master-K CNET” on page B-50. 120S/200S protocol and CNet protocol cannot 

be used simultaneously. The users only can select either 120S/200S protocol or CNet protocol. 
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LG Glofa GM6 CNET DELTA 

A. HMI factory settings 

Baud rate: 19200, 8, None, 1. (RS-232) 

Controller station number: 0. 

Control area/state area: %MW0 / %MW10. 

NOTE   

1) HMI default setting is predefined for CPU Port. If the user want to connect to CNET communication 

module, the baud rate should be changed to 38400, 8, None, 1. (RS-422 / RS-485). 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size 

Input Image IWb.s.w 
w(word):0 ~ 3 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 Word 

Input Image IDb.s.w 
w(word):0 ~ 1 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 DWord 

Output Image QWb.s.w 
w(word):0 ~ 3 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 Word 

Output Image QDb.s.w 
w(word):0 ~ 1 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 DWord 

Internal Memory MWn n: 0 ~ 4095 N/A Word 

Internal Memory MDn n: 0 ~ 2047 N/A DWord 

Contacts 

Contact type Format Word No. Bit No. 

Input Image IXb.s.n s(slot): 0 ~ 7 
n(bit): 0 ~ 63 
b(base): 0 ~ 1 

Output Image QXb.s.n s(slot): 0 ~ 7 
n(bit): 0 ~ 63 
b(base): 0 ~ 1 

Internal Memory MXn N/A n: 0 ~ 65535 
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C. Connections (Connector Pinouts) 

RS-232 

via CPU Port 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male  

(RS-232) 

RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(5) GND 

 

 
Top View 

RS-422 

via G6L-CUEC CNET communication module 

DOP 
9 pin D-SUB male (RS-422) 

Controller 
Cable Connector (RS-422) 

RXD+ (2) SDA

RXD- (1)

TXD- (4)

SDB

RDA

TXD+ (3) RDB

GND (5) SG  
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LG Master-K CNET DELTA 

A. HMI factory settings 

Baud rate: 38400, 8, None, 1. (RS-422) 

Controller station number: 0. 

Control area/state area: DW0 / DW10. 

NOTE   

1) HMI default setting is predefined for G6L-CUEC CNET communication module. 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size 

I/O relay PWn n: 0 ~ 31 N/A Word 

Auxiliary relay MWn n: 0 ~ 191 N/A Word 

Keep relay KWn n: 0 ~ 31 N/A Word 

Link relay LWn n: 0 ~ 63 N/A Word 

Special relay FWn n: 0 ~ 63 N/A Word (Read Only) 

Timer elapsed value TWn n: 0 ~ 255 N/A Word 

Counter elapsed value CWn n: 0 ~ 255 N/A Word 

Data register DWn n: 0 ~ 9999 N/A Word 

Contacts 

Contact type Format Word No. Bit No. 

I/O relay PXnb n: 0 ~ 31 b: 0 ~ F 

Auxiliary relay MXnb n: 0 ~ 191 b: 0 ~ F 

Keep relay KXnb n: 0 ~ 31 b: 0 ~ F 

Link relay LXnb n: 0 ~ 63 b: 0 ~ F 

Special relay FXnb n: 0 ~ 63 b: 0 ~ F 

Timer contact relay TXb N/A b: 0 ~ 255 

Counter contact relay CXb N/A b: 0 ~ 255 
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C. Connections (Connector Pinouts) 

RS-422 

via G6L-CUEC CNET communication module 

DOP 
9 pin D-SUB male (RS-422) 

Controller 
Cable Connector (RS-422) 

RXD+ (2) SDA

RXD- (1)

TXD- (4)

SDB

RDA

TXD+ (3) RDB

GND (5) SG  

RS-232 

via LG-120S PLC (Master K) 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male  

(RS-232) 

RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(5) GND 

 

 
Top View 
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LIYAN LYPLC EX DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1. 

Controller station number: 0. 

Control area/state area: D0 / D10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Auxiliary Relay Mn n: 0 ~ 3064 N/A Byte 

Special Auxiliary Relay Mn n: 8000 ~ 8248 N/A Byte 

Status Relay Sn n: 0 ~ 992 N/A Byte 

Input Relay Xn n: 0 ~ 360(octal) N/A Byte 

Output Relay Yn n: 0 ~ 360(octal) N/A Byte 

Timer PV Tn n: 0 ~ 255 N/A Word 

16-bit Counter PV Cn n: 0 ~ 199 N/A Word 

32-bit Counter PV Cn n: 200 ~ 255 N/A Double Word 

Data Register Dn n: 0 ~ 7999 N/A Word 

Special Data Register Dn n: 8000 ~ 8255 N/A Word 

Auxiliary Relay / Special Auxiliary Relay / Status Relay / Input Relay / Output Relay: Address must be the 

multiple of 8. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Auxiliary Relay Mn N/A n: 0 ~ 3071 

Special Auxiliary Relay Mn N/A n: 8000 ~ 8255 

Status Relay Sn N/A n: 0 ~ 999 

Input Relay Xn N/A n: 0 ~ 377(octal) 

Output Relay Yn N/A n: 0 ~ 377(octal) 

Timer Flag Tn N/A n: 0 ~ 255 

Counter Flag Cn N/A n: 0 ~ 255 
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C. Connections (Connector Pinouts) 

RS-232 

DOP 
9 pin D-SUB male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232)

RXD (2) (2) TXD

TXD (3)

GND (5)

(7) RXD

(3) GND

(6) GND 

 

 2 
3 
6 7 

 
 

Top View 

 



Appendix B  Communication|ScrEdit Software User Manual 

B-54   Revision 05/30/2006, EH00 

M2i Master DELTA 

A. HMI factory settings 

Baud rate: 38400, 8, None, 1. 

Controller station number: 1. 

Control area/state area: SB0 / SB10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Word Address SBn n: 0000 ~ FFFF N/A Word 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Bit Address SBn.b n: 0000 ~ FFFF b: 0 ~ F 
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M2i Slave DELTA 

A. HMI factory settings 

Baud rate: 38400, 8, None, 1. 

Controller station number: 1 (no function) 

Control area/state area: SB0 / SB10. 

NOTE   

1) HMI station number is Slave station number. (default setting is 0) 

2) The relation between M2i communication address and HMI internal registers. 

Modbus address  Data definition in HMI 

SB0000 ~ SB7FFF  $0 ~ $32767 

SB8000 ~ SB83FF  $M0 ~ $M1023 

SB8400  RCPNO 

SB8500 ~ SBFFFF  RCP0 ~ RCP31487 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size 

Word Address SBn n: 0000 ~ FFFF N/A Word 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Bit Address SBn.b n:0000 ~ FFFF b: 0 ~ F 

C. Connections (Connector Pinouts):  

Please refer to B-1 Pin Definition of Serial Communication for detail. 
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Matsushita FP PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 

Controller station number: 238. 

Control area/state area: DT0 / DT10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Internal Relay WRn n: 0 ~ 886, N/A Word 

Special Internal Relay  900 ~ 910   

Link Relay WLn n: 0 ~ 639 N/A Word 

External Input Relay WXn n: 0 ~ 511 N/A Word 

External Output Relay WYn n: 0 ~ 511 N/A Word 

Timer/Counter P.V. EVn n: 0 ~ 3071 N/A Word 

Timer/Counter S.V. SVn n: 0 ~ 3071 N/A Word 

Data Register DTn n: 0 ~ 32764 N/A Word 

Link Data Register LDn n: 0 ~ 8447 N/A Word 

File Register FLn n: 0 ~ 32764 N/A Word 

Special Data Register DT9_n n: 0 ~ 511 N/A Word 

 DT9_0 ~ DT9_511 are applicable for FP0 T32C, FP2, FP2SH, FP10SH controllers. (Special data 

registers are all within the range of DT90000 ~ DT9XXXX). 

 The actual transmitted address of DT9_n is 90000 + n (for DT). For example, the actual transmitted 

address of DT9_1 is 90001 (for DT), the actual transmitted address of DT9_2 is 90002 (for DT) and vise 

versa. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Internal Relay Rnb n: 0 ~ 886 b: 0 ~ f 

Special Internal Relay  n: 900 ~ 910 b: 0 ~ f 

Link Relay Lnb n: 0 ~ 639 b: 0 ~ f 

External Input Relay Xnb n: 0 ~ 511 b: 0 ~ f 

External Output Relay Ynb n: 0 ~ 511 b: 0 ~ f 

Timer Flag Contact Tn N/A n: 0 ~ 3071 

Counter Flag Contact Cn N/A n: 0 ~ 3071 
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 Increase the range of read / write address (for FP2SH / FP10SH controllers). 

C. Connections (Connector Pinouts) 

RS-232 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
5 pin Mini DIN male  

(RS-232 for FP0) 

Controller 
5 pin Mini DIN male 

(RS-232 for FP0) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(1) SG  

Top View  

RS-232 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller  
9 pin D-SUB male  
(RS-232 for FP1) 

Controller  
9 pin D-SUB male 
(RS-232 for FP1) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(7) GND

(4) RTS

(5) CTS  

Top View
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Mirle FAMA SC DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1. 

Controller station number: 0. 

Control area/state area: 40100 / 40200. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data Length 

Output Registers Wn n: 40001 ~ 50000 N/A Word 

Input Registers Wn n: 30001 ~ 40000 N/A Word 

 Input Registers is “read only”. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Discrete Outputs Bn N/A n: 1 ~ 10000 

Discrete Inputs Bn N/A n: 10001 ~ 20000 

 Discrete Inputs is “read only”. 

C. Connections (Connector Pinouts) 

RS-232 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  
Top View  
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Mitsubish FX/FX2N PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1. 

Controller Station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: D0 / D10. 

NOTE  

1) If connecting to Mitsubishi FXxN series PLC, the user can use FX2N and FX series both communication 

protocol. 

2) If connecting to Mitsubishi FX series PLC, the user can only use FX series communication protocol. 

3) Some registers of Mitsubishi PLCs are “read only”, however, when you write these “read only” registers, 

PLCs will not report any communication error to HMI and this will cause that HMI may misjudge. Please 

aware of this when editing PLC program (this kind of case easily occurs when the user use FX series 

protocol when connecting to a FXxN series PLC). 

4) If connecting to Mitsubishi FXxN series PLC, it is recommended for the user to use FX2N protocol. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Auxiliary Relay Mn n: 0 ~ 3064 N/A Byte 

Special Auxiliary Relay Mn n: 8000 ~ 8248 N/A Byte 

Status Relay Sn n: 0 ~ 992 N/A Byte 

Input Relay Xn n: 0 ~ 360(octal) N/A Byte 

Output Relay Yn n: 0 ~ 360(octal) N/A Byte 

Timer PV Tn n: 0 ~ 255 N/A Word 

16-bit Counter PV Cn n: 0 ~ 199 N/A Word 

32-bit Counter PV Cn n: 200 ~ 255 N/A Double Word 

Data Register Dn n: 0 ~ 7999 N/A Word 

Special Data Register Dn n: 8000 ~ 8255 N/A Word 

 Auxiliary Relay/ Special Auxiliary Relay/ Status Relay/ Input Relay /Output Relay: Address must be the 

multiple of 8. 
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Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Auxiliary Relay Mn N/A n: 0 ~ 3071 

Special Auxiliary Relay Mn N/A n: 8000 ~ 8255 

Status Relay Sn N/A n: 0 ~ 999 

Input Relay Xn N/A n: 0 ~ 377(octal) 

Output Relay Yn N/A n: 0 ~ 377(octal) 

Timer Flag Tn N/A n: 0 ~ 255 

Counter Flag Cn N/A n: 0 ~ 255 

C. Connections (Connector Pinouts) 

RS-422 

DOP Series 
9 pin D-SUB male 

(RS-422) 

Controller 
8pin Mini DIN male 

(RS-422) 

Controller 
8pin Mini DIN male 

(RS-422) 

RXD+ (2) (7) TXD+

RXD- (1)

TXD+ (3)

(4) TXD-

(2) RXD+

TXD- (4) (1) RXD-

GND (5) (3) SG  

 1 
4 
7 

2 
3 

Top View  

RS-422 

DOP 
9 pin D-SUB male (RS-422) 

Controller 
25 pin D-SUB male (RS-422) 

Pin 2 (RXD+) Pin3 (TXD+)

Pin 1 (RXD-)

Pin 4 (TXD-)

Pin16 (TXD-)

Pin 15 (RXD-)

Pin 3 (TXD+) Pin 2 (RXD+)  
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Mitsubishi A Series AJ71UC24 Communication Module DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 

Controller Station number: 0. 

Control area/state area: D0 / D10. 

NOTE  

1) This driver use CheckSum. 

2) Please set “PLC Mode” switch to position 5. 

3) If some OUTPUT Replay (Y) and Special Data Relay (SM) are set to 1, PLC will stop communication 

and the communication will not recover automatically. At this time, it is needed to reset PLC. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Input Xn n: 0 ~ 7FF N/A Word (multiple of 16) 

Output Yn n: 0 ~ 7FF N/A Word (multiple of 16) 

Link Relay Bn n: 0 ~ FFF N/A Word (multiple of 16) 

Internal Relay Mn n: 0 ~ 8191 N/A Word (multiple of 16) 

Special Internal Relay SMn n: 9000 ~ 9255 N/A Word (9000 + multiple of 16) 

Latch Relay Ln n: 0 ~ 2047 N/A Word (multiple of 16) 

Annunciator Fn n: 0 ~ 2047 N/A Word (multiple of 16) 

Timer Value TNn n: 0 ~ 999 N/A Word 

Counter Value CNn n: 0 ~ 999 N/A Word 

Data Register Dn n: 0 ~ 8191 N/A Word 

Special Data Register SDn n: 9000 ~ 9255 N/A Word 

File Register Rn n: 0 ~ 8191 N/A Word 

Link Register Wn n: 0 ~ FFF N/A Word 
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Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Xn N/A n: 0 ~ 7FF 

Output Yn N/A n: 0 ~ 7FF 

Link Relay Bn N/A n: 0 ~ FFF 

Internal Relay Mn N/A n: 0 ~ 8191 

Special Internal Relay SMn N/A n: 9000 ~ 9255 

Latch Relay Ln N/A n: 0 ~ 2047 

Annunciator Fn N/A n: 0 ~ 2047 

Timer Contact TSn N/A n: 0 ~ 999 

Timer Coil TCn N/A n: 0 ~ 999 

Counter Contact CSn N/A n: 0 ~ 999 

Counter Coil CCn N/A n: 0 ~ 999 

C. Connections (Connector Pinouts) 

RS-422 

DOP 
9 pin D-SUB male (RS-422) 

Controller 
Cable Connector (RS-422) 

RXD+ (2) SDA

RXD- (1)

TXD+ (3)

SDB

RDA

TXD- (4) RDB 
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Mitsubishi A2A/A2AS/A2USH A1SH/A3N/A2ASH (CPU-S1) CPU Port DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 

Controller Station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: D0 / D10. 

NOTE  

1) This driver support all Mitsubishi A series CPU port. Mitsubishi A series CPU port can be divided into the 

following five categories according the used CPU code (used during communication): 

 A0J2… 

 A1N… 

 A1S ( / A2S / A2N …) 

 A3N ( / A1SH / A2SH …) 

 A2A ( / A2AS / A2USH …) 

Delta HMI can support A2USH CPU port (same as A2A, A2AS CPU port.) and A1SH CPU port (same as 

A3N, A2ASH CPU port.). 

2) L and M: The communication address of L is the same as communication address of M. 

3) PX and X: 

In Mitsubishi A2A PLC, the communication address of PX and X are the same. 

In other Mitsubishi A series PLCs, X is from odd address and PX is from even address. That is one place 

where PX and X differ. 

4) X, Y, B, M, SM, L, F, PX ----(Word), 

X, Y, B, M, SM, L, F, PX ----(Bit), 

When PLC station number is set to 255, only the value of even addresses will be read/written. 

When PLC station number is set to other number (not 255), all value of all addresses will be read/written. 

5) R address: R address will be different according to the size of File Register responded from PLC. 

For example, A2USH: 1K: 3800 ~ 4000H 

 2K: 3000 ~ 4000H 

 3K: 2800 ~ 4000H 

 4K: 2000 ~ 4000H 

 5K: 4000 ~ 6800H(cy) 

 6K: 4000 ~ 7000H(cy) 

File Register: PLC must be started correctly or the read / write value will be incorrect. 



Appendix B  Communication|ScrEdit Software User Manual 

B-64   Revision 05/30/2006, EH00 

 

6) Max. read/write registers & relays for communication once 

128 Words (256 bytes) Registers 

 64 Words (128 bytes) Relays 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Input Xn n: 0 ~ 7FF N/A Word (multiple of 16) 

Output Yn n: 0 ~ 7FF N/A Word (multiple of 16) 

Link Relay Bn n: 0 ~ FFF N/A Word (multiple of 16) 

Internal Relay Mn n: 0 ~ 8191 N/A Word (multiple of 16) 

Special Internal Relay SMn n: 9000 ~ 9255 N/A Word (9000 + multiple of 16) 

Latch Relay Ln n: 0 ~ 8191 N/A Word (multiple of 16) 

Annunciator Fn n: 0 ~ 2047 N/A Word (multiple of 16) 

Timer Value TNn n: 0 ~ 2047 N/A Word 

Counter Value CNn n: 0 ~ 1023 N/A Word 

Data Register Dn n: 0 ~ 8191 N/A Word 

Special Data Register SDn n: 9000 ~ 9255 N/A Word 

File Register Rn n: 0 ~ 8191 N/A Word 

Link Register Wn n: 0 ~ FFF N/A Word 

Input Card Register PXn n: 0 ~ 7FF N/A Word (multiple of 16) 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Xn N/A n: 0 ~ 7FF 

Output Yn N/A n: 0 ~ 7FF 

Link Relay Bn N/A n: 0 ~ FFF 

Internal Relay Mn N/A n: 0 ~ 8191 

Special Internal Relay SMn N/A n: 9000 ~ 9255 

Latch Relay Ln N/A n: 0 ~ 2047 

Annunciator Fn N/A n: 0 ~ 2047 

Timer Contact TSn N/A n: 0 ~ 2047 

Timer Coil TCn N/A n: 0 ~ 2047 

Counter Contact CSn N/A n: 0 ~ 1023 

Counter Coil CCn N/A n: 0 ~ 1023 

Input Card Register PXn N/A n: 0 ~ 7FF 
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C. Connections (Connector Pinouts) 

RS-422 

DOP Series 
9 pin D-SUB male (RS-422) 

Controller 
25 pin D-SUB male(RS-422) 

Controller 
25 pin D-SUB male(RS-422)

Pin 2 (RXD+) Pin 3 SDB (TXD+)

Pin1 (RXD-)

Pin 4 (TXD-)

Pin 16 SDA (TXD-)

Pin 15 RDA (RXD-)

Pin 3 (TXD+) Pin 2 RDB (RXD+)

Pin 7 (RTS+) Pin 4 CTS+

Pin 8 (CTS+) Pin 5 RTS+

Pin 6 (RTS-) Pin 17 CTS-

Pin 9 (CTS-) Pin 18 RTS-  

 2 3 4 5

15
16

17
18

 

Explanation 

How to set File Register (R) for Mitsubishi A serial PLC: 

1. Startup MELSOFT series GX Developer. 

2. Open “Project Data List” windows. (“View” Option) 

3. Double click Parameter \ PLC Parameter, and open “Setting” window. 

4. Set Memory Capacity \ File Register (0 ~8). 

5. Press “End” button on the bottom and complete the setting. 

6. Execute OnLine\Write to PLC. 

7. Enable the “Parameter \ PLC/Network” and “File register \ Main” option (check the check box next to 

“Parameter \ PLC/Network” and “File register \ Main”). 

8. Press “Execute” button. 

9. Complete 
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Mitsubishi Q Series CPU Port DELTA  

A. HMI factory settings 

Baud rate: 19200, 8, ODD, 1. 

Controller Station number: 0. (no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: D-0 / D-10. 

NOTE  

1) Please notice that no PLC station number in protocol, therefore, only 1(HMI) to 1 (PLC) communication 

is allowed. 

2) If communication baud rate is not correct, HMI will set PLC baud rate as HMI baud rate automatically. 

Therefore, do not worry if the baud rate is set incorrectly. 

3) This driver support Mitsubishi Q00 and Q00J series with password protection models. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Input X-n n: 0 ~ 1FFF N/A Word (multiple of 16) 

Output Y-n n: 0 ~ 1FFF N/A Word (multiple of 16) 

Direct Input DX-n n: 0 ~ 1FFF N/A Word (multiple of 16) 

Direct Output DY-n n: 0 ~ 15 N/A Word (multiple of 16) 

Latch Relay L-n n: 0 ~ 8191 N/A Word (multiple of 16) 

Annunciator F-n n: 0 ~ 2047 N/A Word (multiple of 16) 

Edge Relay V-n n: 0 ~ 2047 N/A Word (multiple of 16) 

Step Relay S-n n: 0 ~ 8191 N/A Word (multiple of 16) 

Link Relay B-n n: 0 ~ 1FFF N/A Word (multiple of 16) 

Special Link Relay SB-n n: 0 ~ 7FF N/A Word (multiple of 16) 

Internal Relay M-n n: 0 ~ 8191 N/A Word (multiple of 16) 

Special Internal Relay SM-n n: 0 ~ 2047 N/A Word (multiple of 16) 

Timer Value TN-n n: 0 ~ 2047 N/A Word 

Retentive Timer Value SN-n n: 0 ~ 2047 N/A Word 

Counter Value CN-n n: 0 ~ 1023 N/A Word 

Data Register D-n n: 0 ~ 12287 N/A Word 

Special Data Register SD-n n: 0 ~ 2047 N/A Word 

Index Register Z-n n: 0 ~ 15 N/A Word 

File Register R-n n: 0 ~ 32767 N/A Word 
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Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

File Register ZR-n n: 0 ~ 32767 N/A Word 

Link Register W-n n: 0 ~ 1FFF N/A Word 

Special Link Register SW-n n: 0 ~ 7FF N/A Word 

 Xn, Yn, DXn, Bn, SBn, Wn, SWn : n is in hexadecimal. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input X-n N/A n: 0 ~ 1FFF 

Output Y-n N/A n: 0 ~ 1FFF 

Direct input DX-n N/A n: 0 ~ 1FFF 

Direct output DY-n N/A n: 0 ~ 15 

Latch Relay L-n N/A n: 0 ~ 8191 

Annunciator F-n N/A n: 0 ~ 2047 

Edge Relay V-n N/A n: 0 ~ 2047 

Step Relay S-n N/A n: 0 ~ 8191 

Link Relay B-n N/A n: 0 ~ 1FFF 

Special Link Relay SB-n N/A n: 0 ~ 7FF 

Internal Relay M-n N/A n: 0 ~ 8191 

Special Internal Relay SM-n N/A n: 0 ~ 2047 

Timer Contact TS-n N/A n: 0 ~ 2047 

Timer Coil TC-n N/A n: 0 ~ 2047 

Retentive timer Contact SS-n N/A n: 0 ~ 2047 

Retentive timer Coil SC-n N/A n: 0 ~ 2047 

Counter Contact CS-n N/A n: 0 ~ 1023 

Counter Coil CC-n N/A n: 0 ~ 1023 

 Xn, Yn, DXn, Bn, SBn : n is in hexadecimal. 
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C. Connections (Connector Pinouts) 

RS-232 

DOP 
9 pin D-SUB male 

(RS-232) 

Controller 
6 pin Mini DIN male 

(RS-232) 

Controller 
6 pin Mini DIN male 

(RS-232) 

RXD (2) (2) SD (TXD)

TXD (3)

GND (5)

(1) RD (RXD)

(3) GND

(5) DSR (DR)

(6) DTR (ER)  

 
 

2 1
3

56

 
Top View 
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MKS CT150 DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, E, 1. (RS-232) 

Controller Station number: 11. 

Control area/state area: None / None. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 

Data In Register Cn n: 0 ~ 25 N/A 

Setup Register Cn n: 40 ~ 43 N/A 

  45 ~ 50  

  90 ~ 97  

Error Count Err_CNT 0 N/A 

LV Value LV_VAL 0 N/A 

Printmark Error PRTMARK_ERR 0 N/A 

Batch Counter BAT_CNT 0 N/A 

Waste Counter WASTE_CNT 0 N/A 

Line Speed LINE_SPD 0 N/A 

Actual Cutting Length ACT_CUT_LEN 0 N/A 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

 Cn.b n: 0 ~ 50 B: 0 ~ 15 

Reset RST N/A 0 

Jog Trim+ JOGTRIM_INC N/A 0 

Jog Trim- JOGTRIM_DEC N/A 0 

Read PI READ_PI N/A 0 

Activate Data ACT_DATA N/A 0 

Store Eeprom STR_EEPROM N/A 0 

Start/Stop START_STOP N/A 0 

Reset Mark Counter RSTMARK_CNT N/A 0 
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C. Connections (Connector Pinouts) 

RS-232 

DOP 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB male (RS-232)

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  

 

 
Top View 
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Modbus(Master) --- 984 RTU / ASCII mode DELTA 

A. HMI factory settings  

Baud rate: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Controller station number: 0. 

Control area/state area: W40100 / W40200. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Output Registers Wn n: 40001 ~ 50000 N/A Word 

Input Registers Wn n: 30001 ~ 40000 N/A Word 

 Input Registers is “read only”. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Discrete Outputs Bn N/A n: 1 ~ 10000 

Discrete Inputs Bn N/A n: 10001 ~ 20000 

 Discrete Inputs is “read only”. 

C. Connections (Connector Pinouts) 

Please refer to B-1 Pin Definition of Serial Communication for detail. 
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Modbus Hexadecimal Address (Master) --- RTU / ASCII mode DELTA 

A. HMI factory settings  

Baud rate: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Controller station number: 0. 

Control area/state area: RW-0 / RW-10. 

NOTE  

1) The valid communication address starts from 0 and the format is hexadecimal system. So the settable 

range are 0 to 65535 (i.e. 0 ~ FFFF in hexadecimal format). 

2) The difference than “Standard Modbus” communication: (Protocol is the same) 

The usage of setting communication address is different. 

The range of communication address is different 

The “Standard Modbus” communication is in decimal format. The start addresses are 40001, 30001, 1, 

10001 and contains 10000 addresses respectively (40001 ~ 50000, 30001 ~ 40000, 1 ~ 10000, 10001 ~ 

20000). 

The Modbus Hexadecimal Address (Master) is in hexadecimal format. The starting addresses are all 

from 0 and there is 65536 addressing space (from 0 to FFFF) in each PDU (protocol data unit). 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Output Registers RW-n n: 0 ~ FFFF N/A Word 

Input Registers R-n n: 0 ~ FFFF N/A Word 

 RW- : can Read and Write.  

Converting the address to decimal format and plus 40001, it will immediately become the corresponding 

“Standard Modbus” communication address. 

 R- (Input Registers) : Read only.  

Converting the address to decimal format and plus 30001, it will immediately become the corresponding 

“Standard Modbus” communication address. 

 

 

 

Contacts 
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Read/Write Range 
Contact type Format 

Word No. Bit No. 

Discrete Outputs RWB-n N/A n: 0 ~ FFFF 

Discrete Inputs RB-n N/A n: 0 ~ FFFF 

 RWB- : can Read and Write.  

Converting the address to decimal format and plus 1, it will immediately become the corresponding 

“Standard Modbus” communication address. 

 RB- (Discrete Inputs) : Read only.  

Converting the address to decimal format and plus 10001, it will immediately become the corresponding 

“Standard Modbus” communication address. 

NOTE  

1) Only first 10000 addresses can be converted to ”Standard Modbus” communication address. 
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Modbus nW (Master) --- RTU / ASCII mode DELTA  

A. HMI factory settings  

Baud rate: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Controller station number: 1. 

Control area/state area: W40100 / W40200. 

NOTE  

1) This driver can read consecutive communication address on the screen via one Modbus command. For 

example, if there are 6 devices on the screen, and read the data of the addresses W40140, W40141, 

W40142, W40145, W40146, W40150, it will read three times. It will read W40140 3 Words at the first 

time, read W40145 2 Words at the second time and read W40150 1 Word at the third time. 

2) Ensure to check the check box next to “Optimize” (Optimization for reading) selection in 

“Communication” tab in the “Configuration” dialog box in “Options” menu (Options  Configuration  

Communication). If “Optimize” selection is unchecked, do not select “Data Length Limit”. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Output Registers Wn n: 40001 ~ 50000 N/A Word 

Input Registers Wn n: 30001 ~ 40000 N/A Word 

 Input Registers is “read only”. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Discrete Outputs Bn N/A n: 1 ~ 10000 

Discrete Inputs Bn N/A n: 10001 ~ 20000 

 Discrete Inputs is “read only”. 

C. Connections (Connector Pinouts) 

Please refer to B-1 Pin Definition of Serial Communication for detail. 
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Modbus(Slave) --- 984 RTU / ASCII mode DELTA 

A. HMI factory settings  

Baud rate: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Controller station number: 0. (Station number is not used in the protocol.) 

Control area/state area: W40100 / 40200. 

NOTE  

1) HMI station number is Slave station number. (default setting is 0) 

2) The relation between Modbus address and HMI internal registers. 

Modbus address  Data definition in HMI 

W40001 ~ W41024  $0 ~ $1023 Internal register 

W42001 ~ W43024  $M0 ~ $M1023 Non-volatile internal register 

W44001  RCPNO Receipt number register 

W45001 ~ ...  RCP0 ~ RCPn Receipt register 

B00001 ~ B01024  $2000.0 ~ $2063.15 Internal register (Bit) 

B01025 ~ B02048  $M200.0 ~ $M263.15 Non-volatile internal register (Bit) 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Output Registers Wn n: 40001 ~ 50000 N/A Word 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Discrete Outputs Bn N/A n: 1 ~ 2048 

C. Connections (Connector Pinouts) 

Please refer to B-1 Pin Definition of Serial Communication for detail. 
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CrossReference Table (Inter Memoryof Delta HMI and Modbus Reference Address) 

Inter Memory 
of Delta HMI 

Modbus Reference 
Address 

Supporting Modbus 
Function Address of Function

$0 40001 03H, 06H, 10H 0000H 

$1 40002 03H, 06H, 10H 0001H 

. 

. 

. 

   

$1023 41024 03H, 06H, 10H 03FFH 

    

$M0 42001 03H, 06H, 10H 07D0H 

$M1 42002 03H, 06H, 10H 07D1H 

. 

. 

. 

   

$M1023 43024 03H, 06H, 10H 0BCFH 

    

RCPNO 44001 03H, 06H 0FA0H 

    

RCP0 45001 03H, 06H, 10H 1388H 

RCP1 45002 03H, 06H, 10H 1389H 

. 

. 

. 

   

    

$2000.0 00001 01H, 05H, 0FH 0000H 

$2000.1 00002 01H, 05H, 0FH 0001H 

. 

. 

. 

   

$2000.15 00016 01H, 05H, 0FH 000FH 

$2001.0 00017 01H, 05H, 0FH 0010H 

. 

. 

. 

   

$2063.0 01009 01H, 05H, 0FH 03F0H 

. 

. 

. 

   

$2063.15 01024 01H, 05H, 0FH 03FFH 

    

$M200.0 01025 01H, 05H, 0FH 0400H 
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Inter Memory 
of Delta HMI 

Modbus Reference 
Address 

Supporting Modbus 
Function Address of Function

$M200.1 01026 01H, 05H, 0FH 0401H 

. 

. 

. 

   

$M200.15 01040 01H, 05H, 0FH 040FH 

$M201.0 01041 01H, 05H, 0FH 0410H 

. 

. 

. 

   

$M263.0 02033 01H, 05H, 0FH 07F0H 

. 

. 

. 

   

$M263.15 02048 01H, 05H, 0FH 07FFH 

For example: 

1. Read internal memory $100 of Delta HMI (HMI station number: 1) 

: 01 03 00 64 00 01 97 CR LF 

Write the value of 1000 into internal memory $100 of Delta HMI (HMI station number: 1) 

: 01 06 00 64 03 E8 AA CR LF 

2. Read internal memory $M100 of Delta HMI (HMI station number: 1) 

: 01 03 08 34 00 01 BF CR LF 

Write the value of 888 into internal memory $M100 of Delta HMI (HMI station number: 1) 

: 01 06 08 34 03 78 42 CR LF 

3. Read internal memory $2000.15 of Delta HMI (HMI station number: 1) 

: 01 01 00 0F 00 01 EE CR LF 

Set internal memory $2000.15 of Delta HMI to ON (HMI station number: 1) 

: 01 05 00 0F FF 00 EC CR LF 

Set internal memory $2000.15 of Delta HMI to OFF (HMI station number: 1) 

: 01 05 00 0F 00 00 EB CR LF 

4. Read internal memory $M201.0 of Delta HMI (HMI station number: 1) 

: 01 01 04 10 00 01 E9 CR LF 

Set internal memory $M201.0 of Delta HMI to ON (HMI station number: 1) 

: 01 05 04 10 FF 00 E7 CR LF 

Set internal memory $M201.0 of Delta HMI to OFF (HMI station number: 1) 

: 01 05 04 10 00 00 E6 CR LF 
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Modicon TSX Micro (Uni-Telway) DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 

Controller station number: 2. 

Control area/state area: %MW0 / %MW10. 

NOTE  

1) HMI station needs to be adjusted to 1 ~ 8. 

2) PLC station and HMI station can be the same. 

3) The internal memory and relative parameters in PLC should be set properly first. Otherwise, it cannot 

communicate except %S. 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size

WORD_DEVICE_ Internal %MWn n: 0 ~ 65534 N/A Word 

WORD_DEVICE_ System %SWn n: 0 ~ 127 N/A Word 

WORD_DEVICE_ Input %KWn n: 0 ~ 65534 N/A Word 

 %KWn is “read only”. 

Contacts 

Contact type Format Word No. Bit No. 

BIT_DEVICE_ Internal %Mn:b n:0 ~ 65534 b:0 ~ 15 

BIT_DEVICE_ System %Sn - n:0 ~ 127 

BIT_DEVICE_ Internal1 %Mn - n:0 ~ 65534 

 %Mn: b is Bit address that corresponds to WORD_DEVICE_ Internal (%MWn). 

 %Mn is PLC internal relay address. 

 The read/write range of WORD_DEVICE_ Internal / BIT_DEVICE_ Internal depends on PLC used 

memory. 

C. Connections (Connector Pinouts) 

RS-232 

It needs to use specific cable of Modicon Uni-Telway. (RS-232) --- TSX PCX 1031 
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RS-485 

DOP 
9 pin D-SUB male (RS-485) 

Controller 
8 pin Mini DIN male (RS-485) 

Controller 
8 pin Mini DIN male 

(RS-485) 

RXD+ (2) (1) D+

TXD+ (3)

RXD- (1)

TXD- (4)

(2) D-

 

 2 1

 
Top View 
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Modicon TWIDO DELTA 

Its function is the same as Modbus (Master) --- 984 RTU on page B-71. 
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NIKKI DENSO NCS-FI/FS Series DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, ODD, 2. 

Controller station number: 1. (valid station number: 0 ~ 99) 

Control area/state area: None. 

NOTE  

1) The valid station number is in the range of 0 to 99. If the station number is out of this range, it will be 

subtracted 100 from itself automatically until the station number is in the valid range. 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Bit No. Data Size 

WORD_DEVICE_ RRegister RW-n n: 0 ~ 3999 N/A Word 

WORD_DEVICE_ RRegister RW-n n: 8000 ~ 9999 N/A Word 

WORD_DEVICE_ DStatus XW-n n: 0 ~ 8 N/A Word 

WORD_DEVICE_ DStatus DW-n n: 0 ~ 129 N/A Word 

WORD_DEVICE_ RRegister RD-n n: 0-3999 N/A Double Word

WORD_DEVICE_ RRegister RD-n n: 8000-9999 N/A Double Word

WORD_DEVICE_ DStatus DD-n n: 0-129 N/A Double Word

NOTE  

In order to let DOP series HMI be compatible with this controller, DOP series HMI provides various types of 

data. Please refer to the following description: 

1) RW-n, RD-n, RB-nb all have corresponding relation (just the data format is different). They all refer to the 

same address n.  

DW-n, DD-n both have corresponding relation (just the data format is different). They all refer to the 

same address n. 

XW-n, XB-nb both have corresponding relation (just the data format is different). They all refer to the 

same address n. 

(In the above format name, the second alphabet represents the data format, W represents Word, D 

represents Double Word and B represents Bit) 

2) The data size of RW-n, DW-n is defined as Word in DOP series HMI and each data address is regarded 

as an individual Word address. The data order use "Little Endian" architecture which means that the low 

word of the number is stored in memory at the lowest address, and the high word at the highest address. 

(such as Intel processors (those used in PC's) use "Little Endian" byte order) 
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For example, if set the starting address as RW900 and the data size is Double Word, the read/write 

value will be a Double Word which contains RW900(low word) and RW901(high word). 

In actual application case, if the users set the data size of RW-n, DW-n as Word, there is no data order 

reverse problem. However, if the users set the data size of RW-n, DW-n as Double Word, as this 

controller use "Big Endian" architecture which means that the high word of the number is stored in 

memory at the lowest address, and the low word at the highest address (such as Motorola processors 

(those used in Mac's) use "Big Endian" byte order), a data order reverse problem will occur. 

3) The data size of RD-n, DD-n is defined as Double Word in DOP series HMI and every two data 

addresses is regarded as an individual Double Word address. The data order use "Big Endian" 

architecture (see the meaning above). 

For example, if set the starting address as RD900 and the data size is Double Word, the read/write value 

will be a Double Word which contains RW900(high word) and RW901(low word). 

In actual application case, if the users set the data size of RD-n, DD-n as Double Word, there is no data 

order reverse problem and the data display on HMI and the controller will be the same. However, if the 

users set the data size of RD-n, DD-n as Word, only the low word will display and the high word will be 

set to 0 automatically. For example, if set the starting address as RD900 and the data size is Word, only 

the value of RD901(low word) will display. If the write value is 100 at this time, DOP series HMI will set 

the value of RD901(high word) to 0 and write the value 100 into RD901(low word). 

4) X-nb and DW-n both have corresponding relation -------- Read DW-n, Write X-nb 

DW-0 — X-0b, (b=0~F) 
DW-1 — X-1b, (b=0~F) 
DW-2 — X-2b, (b=0~F) 
DW-4 — X-3b, (b=0~F) 
DW-104 — X-4b, (b=0~F) 
DW-105 — X-5b, (b=0~F) 
DW-106 — X-6b, (b=0~F) 
DW-107 — X-7b, (b=0~F) 
DW-108 — X-8b, (b=0~F) 

5) DW-n, DD-n  are “read only”. If the users write any value into them, HMI will show error message 

“Command Can Not be Executed…. ” on the screen. 

 

Contacts 

Contact type Format Word No. Bit No. 

BIT_DEVICE_ RRegister RB-nb n: 0 ~ 3999 b:0 ~ F  

BIT_DEVICE_ RRegister  RB-nb n: 8000 ~ 9999 b:0 ~ F 

BIT_DEVICE_ BitControl XB-nb n:0 ~ 8 b:0 ~ F 
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C. Connections (Connector Pinouts) 

RS-422 

DOP 
9 pin D-SUB male (RS-422) 

Controller 
14 pin special male (RS-422) 

Controller 
14 pin special male (RS-422) 

RXD- (1) (9) TXD (B)

RXD+ (2)

TXD+ (3)

(2) TXD (A)

(4) RXD (A)

TXD- (4) (11) RXD (B)

GND (5) (14) GND  
 

 
Cable (PLC side (J1), male). 

Top View 
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Omron C Series PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 2. 

Controller station number: 0. 

Control area/state area: DM0 / DM10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

IR area IRn n: 0 ~ 511 N/A Word 

HR area HRn n: 0 ~ 99 N/A Word 

AR area ARn n: 0 ~ 27 N/A Word 

LR area LRn n: 0 ~ 63 N/A Word 

TC area TCn n: 0 ~ 511 N/A Word 

DM area DMn n: 0 ~ 6655 N/A Word 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

IR area IRnb n: 0 ~ 511 b: 00 ~ 15 

HR area HRnb n: 0 ~ 99 b: 00 ~ 15 

AR area ARnb n: 0 ~ 27 b: 00 ~ 15 

LR area LRnb n: 0 ~ 63 b: 00 ~ 15 

TC area TCn N/A n: 0 ~ 511 

C. Connections (Connector Pinouts) 

RS-232 

1:1 Host Link via RS-232C converter 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB male (RS-232)

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(9) SG

(4) RS

(5) CS  
Top View



Appendix B  Communication|ScrEdit Software User Manual 

Revision 05/30/2006, EH00   B-85 

Omron CJ1/CS1 Series PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 2. (RS-232) 

Controller station number: 0. 

Control area/state area: D0 / D10. 

NOTE  

The meaning of Communication Error Message: 

1) Word Device: 

The Device Name and Address Value will display. For example, if using CIO, H, A, D, E, T, C, W, EM, IR, 

DR, TK, it will show CIOn, Hn, An, Dn, Em.n, Tn, Cn, Wn, EMn, IRn, DRn, TKn respectively. “n” is the 

Address Value. 

2) Bit Device: 

The Device Name and Word Address Value will display, but the Bit Address Value will not. For example, 

if using CIO, H, A, D, E, T, C, W, EM, IR, DR, TK, it will show CIOBn, HBn, ABn, DBn, EBm.n, TBn, CBn, 

WBn, EMBn, IRBn, DRBn, TKBn respectively. “n” is the Word Address Value. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

CIO area CIOn n: 0 ~ 9999 N/A Word 

Hold area Hn n: 0 ~ 999 N/A Word 

Auxiliary area An n: 0 ~ 999 N/A Word 

DM area Dn n: 0 ~ 65535 N/A Word 

EM area Em.n M: 0 ~ 12 (bank no.) 
n: 0 ~ 65535 

N/A Word 

Timer PVs Tn n: 0 ~ 9999 N/A Word 

Counter PVs Cn n: 0 ~ 9999 N/A Word 

Work area Wn n: 0 ~ 999 N/A Word 

EM Current Bank area EMn n: 0 ~ 65535 N/A Word 

Index Register IRn n: 0 ~ 99 N/A Double Word 

DR area DRn n: 0 ~ 99 N/A Word 

TK area TKn n: 0 ~ 1022 (Even 
No.) N/A Byte 

 CJ1M Models: An: A0-A477 is “read only”. 
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Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

CIO area CIOBnbb n: 0 ~ 9999 bb: 00 ~ 15 

Hold area HBnbb n: 0 ~ 999 bb: 00 ~ 15 

Auxiliary area ABnbb n: 0 ~ 999 bb: 00 ~ 15 

DM area DBnbb n: 0 ~ 65535 bb: 00 ~ 15 

EM area EBm.nbb n: 0 ~ 65535  

  m: 0 ~ 12 (bank no.) bb: 00 ~ 15 

Timer area TBn N/A n: 0 ~ 9999  

Counter area CBn N/A n: 0 ~ 9999 

Work area WBnbb n: 0 ~ 999 bb: 00 ~ 15 

EM Current Bank area EMBnbb n: 0 ~ 65535 bb: 00 ~ 15 

Index Register IRBnbb n: 0 ~ 99 bb: 00 ~ 31 

DR area DRBnbb n: 0 ~ 99 bb: 00 ~ 15 

TK area TKBnbb n: 0 ~ 1022 (Even 
No.) 

bb: 00 ~ 15 

NOTE  

1) The following address cannot be written: 

 IRn and DRn: It is not valid if the users write them. HMI will not show any error message if the write 

operation is done. 

 An and Abnbb: Some range of An and Abnbb (Auxiliary area) is “read only”. 

 TKn / TKBnbb / TBn / CBn / EMBnbb / IRBnbb / DRBnbb: Writing these address is not allowed. If 

the write operation is done, the error will occur and display the error message “Command Can Not 

be Executed…” on the screen of HMI. 

2) The unit of IR address  is “Double Word”. 

3) The unit of TK address is “Byte” and it should be even number. 
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C. Connections (Connector Pinouts) 

RS-232 

CJ1M CPU module 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB male (RS-232)

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(9) SG

(4) RS

(5) CS  
Top View
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Siemens S7 200 PLC DELTA 

A. HMI factory settings 

Baud rate: 9600, 8, EVEN, 1. 

Controller station number: 2. 

Control area/state area: VW0 / VW10. 

B. Definition of controller Read/Write address 

Register 

Read/Write Range 
Register Type Format 

Word No. Bit No. 

Timer Tn n: 0 ~ 255 N/A 

Analog Input Word AIWn n: 0 ~ 30 N/A 

Counter Cn n: 0 ~ 255 N/A 

Analog Output Word AQWn n: 0 ~ 30 N/A 

Input Image IWn n: 0 ~ 14 N/A 

Input Image IDn n: 0 ~ 12 N/A 

Output Image QWn n: 0 ~ 14 N/A 

Output Image QDn n: 0 ~ 12 N/A 

Special Bits SMWn n: 0 ~ 199 N/A 

Special Bits SMDn n: 0 ~ 197 N/A 

Internal Bits MWn n: 0 ~ 98 N/A 

Internal Bits MDn n: 0 ~ 96 N/A 

Data Area VWn n: 0 ~ 9998 N/A 

 (DBWn) (n: 0 ~ 9998)  

Data Area VDn n: 0 ~ 9996 N/A 

Special S SWn n: 0 ~ 99 N/A 

Special S SDn n: 0 ~ 97 N/A 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Timer Bit Tn N/A n: 0 ~ 255 

Counter Bit Cn N/A n: 0 ~ 255 

Input Image In.b n: 0 ~ 15 b: 0 ~ 7 

Output Image Qn.b n: 0 ~ 15 b: 0 ~ 7 

Special Bit SMn.b n: 0 ~ 200 b: 0 ~ 7 

Internal Bit Mn.b n: 0 ~ 99 b: 0 ~ 7 

Data Area Bit Vn.b n: 0 ~ 9999 b: 0 ~ 7 
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Read/Write Range 
Contact type Format 

Word No. Bit No. 

Special S Bit Sn.b n: 0 ~ 100 b: 0 ~ 7 

C. Connections (Connector Pinouts) 

RS-232 

via RS-232 / PPI Multi-Master Cable (Connecting DOP series HMI and PPI cable) 

DOP Series 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male 

(RS-232) 

Controller 
9 pin D-SUB male  

(RS-232) 

RXD (2) (2) RD

TXD (3)

GND (5)

(3) TD

(5) GND 
Top View  

RS-485 

via PLC Program Port (RS-485) 

DOP Series 
9 pin D-SUB male 

(RS-485) 

Controller 
9 pin D-SUB male 

(RS-485) 

Controller 
9 pin D-SUB male 

(RS-485) 

RXD+ (2) (3)TXD/RXD+

TXD+ (3)

RXD- (1)

TXD- (4)

GND (5) (5)SG

(8)TXD/RXD-

 Top View  
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Siemens S7 300 PLC (with PC Adapter) DELTA 

A. HMI factory settings 

Baud rate: 38400, 8, ODD, 1. (RS-232). 

Controller station number: 2. 

(As the communicate is via PC adapter, PLC station will not be used, therefore, only 1(HMI) to 1 (PLC) 

communication is allowed.) 

Control area/state area: DBW0 / DBW20. 

NOTE  

1) PLC DB memory (DBm.DBWn, DBm.DBDn, DBm.DBXn.b) must be open so that HMI can read/write. 

2) The reason for using PC adapter: 

When communicating via PC adapter, it is profibus with 187.5 K baudrate at PLC side. Therefore, the 

network structure is rapider and steadier. 

S7 300 S7 300 S7 300.....

HMI HMI HMI.....

RS485

RS232

Via PC adapter

 

When HMI communicates with PLC without PC adapter, the protocol will be complicated and it needs to 

lower PLC baud rate to 19200 due to HMI baudrate limit. Therefore, the efficiency of the network 

structure of S7 300 will be badly. 

3) Baud rate setting 

 It needs to set PLC baud rate to 187.5 K and higher. (it cannot use 19.2K) 

 It needs to set baud rate of two sides when using PC Adapter 

i) "PLC side": It needs to set same baudrate as PLC side (as previous item it needs to set 

PLC baud rate to 187.5 K and higher and cannot use 19.2K) 

ii) "HMI side": it can select 38.4K or 19.2K by using switch on the cable. (only these two 

choices) 

iii) HMI baud rate: it needs to set the baud rate of HMI side of PC adapter as previous item to 

38.4K or 19.2K) (protocol setting is still 8, ODD, 1) 

iv) There is no setting for PLC station and HMI station, so it won’t have the communication 

problem with error station setting. 
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v) PC Adapter : 

The power LED will be lit once connect to PLC. (power supply of PC adapter is from PLC) 

If communication is OK, the communication LED will be blink. Otherwise, it will be dark. 

B. Definition of controller Read/Write address 

Register 

Read/Write Range 
Register Type Format 

Word No. Bit No. 

Input Image IWn n: 0 ~ 65534 N/A 

Input Image IDn n: 0 ~ 65532 N/A 

Output Image QWn n: 0 ~ 65534 N/A 

Output Image QDn n: 0 ~ 65532 N/A 

Internal Bits MWn n: 0 ~ 65534 N/A 

Internal Bits MDn n: 0 ~ 65532 N/A 

Data Area DBm.DBWn n: 0 ~ 65534 m: 1 ~ 255 

 DBm.DBDn n: 0 ~ 65532 m: 1 ~ 255 

Data Area (DB10) DBWn n: 0 ~ 65534 N/A 

 DBDn n: 0 ~ 65532 N/A 

 VWn n: 0 ~ 65534 N/A 

 VDn n: 0 ~ 65532 N/A 
Timer Tn n: 0-65535 N/A 
Counter Cn n: 0-65535 N/A 

NOTE  

1) The valid digit number of the value for the T(Timer) and C(Counter) is 3-digit only. Therefore, please 

enter a 3-digit number. If entering a number that exceeds 3 digits, only the first 3 digits are valid (decimal 

format). The other digits of the value for the T(Timer) will be replaced as 0 and the other digits of the 

value for the C(Counter) will be abandoned. For example, assume that the users enter the value “12345”, 

the actual write value for the T(Timer) will be “12300” and the actual write value for the C(Counter) will be 

“123”. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Image In.b n: 0 ~ 65535 b: 0 ~ 7 

Output Image Qn.b n: 0 ~ 65535 b: 0 ~ 7 

Internal Bit Mn.b n: 0 ~ 65535 b: 0 ~ 7 

Data Area Bit DBm.DBXn.b n: 0 ~ 65535 b: 0 ~ 7 

   m = 1 ~ 255 
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Read/Write Range 
Contact type Format 

Word No. Bit No. 

Data Area Bit (10 DB) DBXn.b n: 0 ~ 65535 b: 0 ~ 7 

 Vn.b n: 0 ~ 65535 b: 0 ~ 7 

NOTE  

1) For all contacts when performing “Multiple Duplicate” function: 

 If it exceeds 65535 when increasing, it will be regarded as 0. 

 If it is less than 0, it will be regarded as 655XX. 

C. Connections (Connector Pinouts) 

RS-232 

HMI connects to PC Adaptor 

DOP 
9 pin D-SUB male 

Controller 
9 pin D-SUB female Controller 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND

(8) CTS

(7) RTS

RTS (7)

CTS (8)  

 
 
 
 

 
Top view 

 

 

 

Pin1
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Siemens S7 300 PLC (without PC Adaptor) DELTA 

A. HMI factory settings 

Baud rate: 19200, 8, EVEN, 1. (RS-485). 

Controller station number: 2. 

Control area/state area: DBW0 / DBW20. 

NOTE  

1) Please notice that only 1(HMI) to 1 (PLC) communication is allowed. 

2) PLC baud rate should be changed to 19200. (8, EVEN, 1.). 

3) DB need must be open, otherwise the related addresses can not be read and write. 

(The related addresses are: DB.DBW, DB.DBD, DBW, DBD, VW, VD, DB.DBX, DBX, V) 

4) HMI station must be set to 0 ~ 15. If it is out of this range, it will be changed to 15 automatically. PLC 

station number must be set to 0 ~ 15. 

5) The communication cable is the same as S7 200 series (RS-485). 

6) If not connecting to communication cable, after 5 seconds, HMI will show error message on the screen. If 

connecting to communication cable, it is needed to power on HMI again, and then the communication 

can be found. 

7) After power in connected to HMI, HMI must accept the notification from PLC and then connection will be 

established. The first time connection will take more time, but in normal condition, it should be connected 

in 5 seconds. 

8) This protocol is a multi-step and recurrent communication protocol (HMI needs to communicate with PLC 

for many times for completing 1 command.). The communication speed of S7 300 PLC (without PC 

Adaptor) is usually slower than the other controllers, but it is the same as the communication speed of 

S7 300 PLC (without PC Adaptor). 

B. Definition of controller Read/Write address 

Register 

Read/Write Range 
Register Type Format 

Word No. Bit No. 

Input Image IWn n: 0 ~ 65534 N/A 

Input Image IDn n: 0 ~ 65532 N/A 

Output Image QWn n: 0 ~ 65534 N/A 

Output Image QDn n: 0 ~ 65532 N/A 

Internal Bits MWn n: 0 ~ 65534 N/A 

Internal Bits MDn n: 0 ~ 65532 N/A 



Appendix B  Communication|ScrEdit Software User Manual 

B-94   Revision 05/30/2006, EH00 

Read/Write Range 
Register Type Format 

Word No. Bit No. 

Data Area DBm.DBWn n: 0 ~ 65534 m: 1 ~ 255 (Note 1) 

 DBm.DBDn n: 0 ~ 65532 m: 1 ~ 255 (Note 1) 

Data Area (DB10) DBWn n: 0 ~ 65534 N/A 

 DBDn n: 0 ~ 65532 N/A 

 VWn n: 0 ~ 65534 N/A 

 VDn n: 0 ~ 65532 N/A 

Timer Tn n: 0 ~ 65535 N/A 

Counter Cn n: 0 ~ 65535 N/A 

NOTE  

1) High Byte of Bit No. 

 The valid digit number of the value for the T(Timer) and C(Counter) is 3-digit only. Therefore, please 

enter a 3-digit number. If entering a number that exceeds 3 digits, only the first 3 digits are valid (decimal 

format). The other digits of the value for the T(Timer) will be replaced as 0 and the other digits of the 

value for the C(Counter) will be abandoned. For example, assume that the users enter the value “12345”, 

the actual write value for the T(Timer) will be “12300” and the actual write value for the C(Counter) will 

be “123”. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

Input Image In.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Output Image Qn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Internal Bit Mn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Data Area Bit DBm.DBXn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

   m = 1 ~ 255 (Note 3) 

Data Area Bit (DB 10) DBXn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

 Vn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

NOTE  

2) Low Byte of Bit No. 

3) High Byte of Bit No. 

4) For all timers, counters and contacts when performing “Multiple Duplicate” function: 

 If it exceeds 65535 when increasing, it will be regarded as 0. 

 If it is less than 0, it will be regarded as 655XX. 
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C. Connections (Connector Pinouts) 

The communication cable is the same as S7 200 series (RS-485). Please refer to the Connections of S7 200 

series (RS-485).  

C. Connections (Connector Pinouts) 

RS-485 

via PLC MPI Port (RS-485) 

DOP 
9 pin D-SUB male (RS-485) 

Controller 
9 pin D-SUB male (RS-485) 

Controller 
9 pin D-SUB male (RS-

485) 

RXD+ (2) (3)TXD/RXD+

TXD+ (3)

RXD- (1)

TXD- (4)

GND (5) (5)SG

(8)TXD/RXD-

 

 

 
Top view 
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Taian TP02 PLC DELTA 

A. HMI factory settings 

Baud rate: 19200, 7, None, 1. 

Controller station number: 1. 

Control area/state area: V1 / V10. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

WORD_DEVICE_X Xn n: 1 ~ 384 N/A Word 

WORD_DEVICE_Y Yn n: 1 ~ 384 N/A Word 

WORD_DEVICE_C Cn n: 1 ~ 2048 N/A Word 

WORD_DEVICE_V Vn n: 1 ~ 1024 N/A Word 

WORD_DEVICE_D Dn n: 1 ~ 2048 N/A Word 

WORD_DEVICE_WS WSn n: 1 ~ 128 N/A Word 

WORD_DEVICE_WC WCn n: 1 ~ 912 N/A Word 

 WORD_DEVICE_X / WORD_DEVICE_Y / WORD_DEVICE_C: Address must be 1 or the multiple of 

16+1. 

Contacts 

Read/Write Range 
Contact type Format 

Word No. Bit No. 

BIT_DEVICE_X Xn N/A n: 1 ~ 384 

BIT_DEVICE_Y Yn N/A n: 1 ~ 384 

BIT_DEVICE_C Cn N/A n: 1 ~ 2048 

BIT_DEVICE_SC SCn N/A n: 1 ~ 128 

 BIT_DEVICE_SC: Only 1 Bit can be transferred for each read command. 
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C. Connections (Connector Pinouts) 

RS-422 

DOP 
9 pin D-SUB male (RS-422) 

Controller 
9 pin D-SUB male (RS-422) 

Controller 
9 pin D-SUB male (RS-422)

RXD+ (2) (3) TXD+

RXD- (1)

TXD+ (3)

(8) TXD-

(2) RXD+

(7) RXD-TXD- (4)  

 

 
Top View 

RS-485 

DOP 
9 pin D-SUB male (RS-232) 

Controller 
RS-485 (T/R+, T/R-) 

RXD+ (2) T/R+

TXD+ (3)

RXD- (1)

TXD- (4) T/R-  
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Vigor M Series DELTA  

A. HMI factory settings 

Baud rate: 19200, 7, EVEN, 1. 

Controller station number: 0. 

Control area/state area: D0 / D10. 

NOTE  

1) Controller station number: 0 for PROGRAMMER PORT; 1 for COM PORT 

2) VB series also can use this driver. 

B. Definition of controller Read/Write address 

Registers 

Read/Write Range 
Register Type Format 

Word No. Bit No. 
Data length 

Input Relay Xn n: 0 ~ 770 (Octal) N/A Word (multiple of 8) 

Output Relay Yn n: 0 ~ 770 (Octal) N/A Word (multiple of 8) 

Auxiliary Relay Mn n: 0 ~ 5112 N/A Word (multiple of 8) 

Special Relay Mn n: 9000 ~ 9248 N/A Word (9000 + multiple 
of 8) 

Step Relay Sn n: 0 ~ 992 N/A Word (multiple of 8) 

Timer Present Value Tn n: 0 ~ 255 N/A Word 

16-bit Counter Present Value Cn n: 0 ~ 199 N/A Word 

32-bit Counter Present Value Cn n: 200 ~ 255 N/A Word 

Data Register Dn n: 0 ~ 8191 N/A Word 

Special Data Register Dn n: 9000 ~ 9248 N/A Word 

Contacts 

Read/Write range 
Contact type Format 

Word No. Bit No. 

Input Relay Xn N/A n: 0 ~ 777(Octal) 

Output Relay Yn N/A n: 0 ~ 777(Octal) 

Auxiliary Relay Mn N/A n: 0 ~ 5119 

Special Relay Mn N/A n: 9000 ~ 9255 

Step Relay Sn N/A n: 0 ~ 999 

Timer Contact Tn N/A n: 0 ~ 255 

Counter Contact Cn N/A n: 0 ~ 255 

Timer Coil TCn N/A n: 0 ~ 255 

Counter Coil CCn N/A n: 0 ~ 255 
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C. Connections (Connector Pinouts) 

RS-232 

 (PROGRAMMER PORT) 

DOP 
9 pin D-SUB male(RS-232) 

Controller 
USB TAPE A Connector 

Controller 
USB TAPE A Connector 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(4) GND 

 
 
 
 

 
Top View 

(COM PORT) 

DOP 
9 pin D-SUB male (RS-232) 

Controller 
9 pin D-SUB female (RS-232) 

Controller 
9 pin D-SUB female (RS-232)

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 

 
 
 
 
 

Top View 

 

 

2 
3 
4 

Pin1
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YOKOGAWA ACE PLC DELTA  

A. HMI factory settings 

Baud rate: 9600, 8, EVEN, 1. (ASCII code) 

Controller station number: 1. 

CPU NO. : 1. 

Control area/state area: D1 / D10. 

NOTE  

1) CheckSum and End character (CR, LF) are not used during communication. Therefore, the controller 

should be set to “Not using CheckSum and End character” also. 

2) CPU number is used during communication, however, Screen Editor software do not have this selection. 

Therefore, if the user desire to set CPU number, please set HMI station number in “General” tab in 

the ”Configuration” dialog box in “Options” menu (Options  ”Configuration”  General). (HMI station 

number is regarded as CPU number here. The default setting of HMI station number is 0, but 0 is an 

illegal number, the user must set it as a legal value. 

B. Definition of controller Read/Write address 

Registers 

Register Type Format Word No. Data Size 

WORD_DEVICE_X Xn n: 201 ~ 65464 Word 

WORD_DEVICE_Y Yn n: 201 ~ 65464 Word 

WORD_DEVICE_I In n: 1 ~ 16384 Word 

WORD_DEVICE_E En n: 1 ~ 4096 Word 

WORD_DEVICE_L Ln n: 1 ~ 65488 Word 

WORD_DEVICE_M Mn n: 1 ~ 9984 Word 

WORD_DEVICE_TP TPn n: 1 ~ 3072 Word 

WORD_DEVICE_CP CPn n: 1 ~ 3072 Word 

WORD_DEVICE_D Dn n: 1 ~ 8192 Word 

WORD_DEVICE_B Bn n: 1 ~ 32768 Word 

WORD_DEVICE_W Wn n: 1 ~ 65499 Word 

WORD_DEVICE_Z Zn n: 1 ~ 512 Word 

WORD_DEVICE_V Vn n: 1 ~ 64 Word 

WORD_DEVICE_R Rn n: 1 ~ 4096 Word 

WORD_DEVICE_TS TSn n: 1 ~ 3072 Word 

WORD_DEVICE_CS CSn n: 1 ~ 3072 Word 

 WORD_DEVICE_X / WORD_DEVICE_Y: The last two digits of address must be 1 or the multiple of 

16+1 and less than 65. 
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 WORD_DEVICE_I / WORD_DEVICE_E / WORD_DEVICE_L / WORD_DEVICE_M: Address must be 1 

or the multiple of 16+1. 

 WORD_DEVICE_X / WORD_DEVICE_Y / WORD_DEVICE_L / WORD_DEVICE_W: Valid address is 

inconsecutive. 

Contacts 

Contact type Format Bit No. 

BIT_DEVICE_X Xn n: 201 ~ 65464 

BIT_DEVICE_Y Yn n: 201 ~ 65464 

BIT_DEVICE_I In n: 1 ~ 16384 

BIT_DEVICE_E En n: 1 ~ 4096 

BIT_DEVICE_L Ln n: 1 ~ 65488 

BIT_DEVICE_M Mn n: 1 ~ 9984 

BIT_DEVICE_TU TUn n: 1 ~ 3072 

BIT_DEVICE_CU CUn n: 1 ~ 3072 

 BIT_DEVICE_X / BIT_DEVICE_Y : the last two digits of address must be less than 65 (1 ~ 64). 

 BIT_DEVICE_X / BIT _DEVICE_Y / BIT _DEVICE_L : valid address is inconsecutive. 

 Multiple Duplicate: 

The next Bit address of X264 is X301 (invalid addresses X265 ~ X300 are skipped) 

The next Bit address of X364 is X401. 

The address of Y is the same as X. 

(The Word addresses of X and Y are also auto skip invalid addresses) 

C. Connections (Connector Pinouts) 

It needs to use specific cable of YOKOGAWA ACE PLC. 

RS-232 

DOP 
9 pin D-SUB male (RS-232) 

Controller (6 pin) 
(RS-232 for YOKOGAWA) 

Controller (6 pin) (RS-232 for 
YOKOGAWA) 

RXD (2) (1) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND  
Top View 
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